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G5404B Microplate Labeler
User Guide



Preface 

This guide describes how to use the G5404B Microplate Labeler to 
print and apply labels automatically to your labware. The 
Microplate Labeler can print linear and two- dimensional barcodes 
and human- readable text fields.

This preface contains the following topics:

• “About this guide” on page viii

• “Accessing Automation Solutions user guides” on page x
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About this guide

Who should read this guide

This user guide is for people with the following job roles:

 

What this guide covers

This guide provides descriptions of the Microplate Labeler and procedures for 
installation, setup, operation, and maintenance of the device. 

This guide also describes how to use the following software:

• Microplate Labeler Diagnostics. You use the Diagnostics software to set up 
the device, create label formats, and troubleshoot the device. You can 
access Microplate Labeler Diagnostics via VWorks Automation Control, 
BenchWorks, or PlateTag software, or via the Microplate Labeler ActiveX 
controls.

• PlateTag software. For a standalone Microplate Labeler, you use PlateTag 
to run batch labeling jobs.

What this guide does not cover

This guide does not provide instructions for third- party software, ActiveX 
control, or for running protocols using the VWorks Automation Control 
software or the BenchWorks Automation Control software. For more 
information about these topics, see “Related guides” on page ix.

Job role Responsibilities

Installer Unpacks, installs, and tests the Microplate Labeler before it 
is used.

Integrator Configures hardware and writes software.

Lab manager, 
administrator, 
or technician

• Manages the automation system that contains the 
Microplate Labeler

• Develops the applications that are run on the system

• Develops training materials and standard operating 
procedures for operators

Operator Performs the daily production work on the Microplate 
Labeler and solves routine problems.
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What is new in this revision

Software version

This guide documents the following:

• Microplate Labeler Diagnostics version 15.0.50 or later

• PlateTag software version 7.0.24 or later

Related guides

If your Microplate Labeler is part of a lab automation system of workstation, 
use the relevant software and device guides in conjunction with this guide.

Description See

ActiveX control. The updated 
documentation is now provided as a 
separate guide.

Microplate Labeler ActiveX User 
Guide

Type of system See also these guides …

VWorks software and 
BioCel System 

• VWorks Automation Control Setup Guide. 
Explains how to set up the software and 
define labware.

• VWorks Automation Control User Guide. 
Explains how to create protocols, set task 
parameters, and run protocols. Use this 
guide to set the parameters for the Print and 
Apply task when running a labeling protocol.

• BioCel System User Guide. Explains how to 
set up, operate, and maintain the system.

VWorks software and 
BenchCel Microplate 
Handler 

• VWorks Automation Control Setup Guide. 
Explains how to set up the software and 
define labware.

• VWorks Automation Control User Guide. 
Explains how to create protocols, set task 
parameters, and run protocols. Use this 
guide to set the parameters for the Print and 
Apply task when running a labeling protocol.

• BenchCel Microplate Handler User Guide. 
Explains how to install, set up, operate, and 
maintain the workstation.

BenchWorks software and 
BenchCel Microplate 
Handler 

• BenchWorks Automation Control User 
Guide. Explains how to define labware, 
create protocols, set task parameters, and 
run protocols. Use this guide to set the 
parameters for the Label and Apply task 
when running a labeling protocol.

• BenchCel Microplate Handler User Guide. 
Explains how to install, set up, operate, and 
maintain the workstation.

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Related topics

Accessing Automation Solutions user guides

About this topic

This topic describes the different formats of Automation Solutions user 
information and explains how to access the user information.

Where to find user information

The Automation Solutions user information is available in the following 
locations:

• Knowledge base. The help system that contains information about all of the 
Automation Solutions products is available from the Help menu within the 
VWorks software. 

• PDF files. The PDF files of the user guides are installed with the VWorks 
software and are on the software CD that is supplied with the product. A 
PDF viewer is required to open a user guide in PDF format. You can 
download a free PDF viewer from the internet. For information about using 
PDF documents, see the user documentation for the PDF viewer.

• Agilent Technologies website. You can search the online knowledge base or 
download the latest version of any PDF file from the Agilent Technologies 
website at www.agilent.com/lifesciences/automation. 

Accessing safety information

Safety information for the Agilent Technologies devices appears in the 
corresponding device safety guide or user guide.

You can also search the knowledge base or the PDF files for safety information.

ActiveX control Microplate Labeler ActiveX User Guide

Third- party system 
software

Relevant third- party system guides.

Type of system See also these guides …

For more information about... See...

Reporting problems “Reporting problems” on page 176

Other devices “Accessing Automation Solutions user 
guides” on page x

Microplate Labeler safety “Safety guidelines” on page 1

http://www.agilent.com/lifesciences/automation
http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Using the knowledge base

Knowledge base topics are displayed using web browser software such as 
Microsoft Internet Explorer and Mozilla Firefox.

Note: If you want to use Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). To 
do this, in Internet Explorer, open the Internet Options dialog box. Click the 
Advanced tab, locate the Security section, and select Allow active content to run in 
files on my computer.

To open the knowledge base, do one of the following:
• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows desktop, select Start > All Programs > Agilent Technologies > 
VWorks > User Guides > Knowledge Base.

Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . 

The pointer changes to . Notice that the different icons or areas are 
highlighted as you move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

                                                         

Item Feature

1 Navigation area. Consists of four tabs:

• Contents. Lists all the books and the table of contents of the 
books.

• Index. Displays the index entries of all of the books.

• Search. Allows you to search the Knowledge Base (all products) 
using keywords. You can narrow the search by product.

• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or 
previous topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
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Related topics

For more information about... See...

Who should read this guide 
and what this guide covers

“About this guide” on page viii

Reporting problems “Reporting problems” on page 176

Microplate Labeler safety “Safety guidelines” on page 1
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User Guide

Agilent Technologies

1
Safety guidelines

Before installing and using the Microplate Labeler, you must be 
familiar with the potential safety hazards and how to avoid them.

This chapter contains the following topics, which describe the 
safety information for the Microplate Labeler:

• “General safety information” on page 2

• “Safety and regulatory compliance” on page 4

• “Potential safety hazards” on page 5
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General safety information

Before installing and using the Microplate Labeler

Before installing and using the Microplate Labeler, make sure you are aware of 
the potential hazards and understand how to avoid being exposed to them. You 
must be properly trained in the correct and safe installation and operation of 
the device.

Intended product use

Agilent Technologies products must only be used in the manner described in 
the Agilent Technologies product user guides. Any other use may result in 
damage to the product or personal injury. Agilent Technologies is not 
responsible for any damages caused, in whole or in part, by improper use of 
the products, unauthorized alterations, adjustments or modifications to the 
products, failure to comply with procedures in Agilent Technologies product 
user guides, or use of the products in violation of applicable laws, rules or 
regulations. Except as otherwise expressly provided in Agilent Technologies 
product user guides, any alteration, adjustment or modification to the products 
will void the product warranty and may invalidate the safety compliance 
certification.

The Microplate Labeler is not intended or approved for diagnosis of disease in 
humans or animals. You assume full responsibility for obtaining any regulatory 
approvals required for such use and assume all liability in connection 
therewith.

Safety labels

Pay attention to any safety labels affixed to your device. A safety label consists 
of a warning symbol. A description of the warning and information that will 
help you to avoid the safety hazard are provided in this user guide.

 

Warnings in the user documentation or on the device must be observed during 
all phases of operation, service, and repair of this device. Failure to comply 
with these precautions violates safety standards of design and the intended use 
of the product. Agilent Technologies assumes no liability for the customer’s 
failure to comply with these requirements.

The following table lists the common symbols you might find on the device. 
The symbol on the label indicates the risk of danger. A description of the 
warning and information that will help you avoid the safety hazard are 
provided in this guide.

WARNING  Do not remove the Microplate Labeler exterior covers or otherwise 
disassemble the system or device. Doing so can expose you to hazards that could cause 
serious injury and damage the Microplate Labeler.

WARNING  Using controls, making adjustments, or performing procedures other than 
those specified in the user guide can expose you to hazardous voltage, high-pressure gas, 
and laser radiation.
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Related information

Symbol Description

 Indicates that you must read the accompanying 
instructions (for example, the safety guide) for more 
information before proceeding.

 Indicates hazardous voltages.

 

 

 

Indicates pinch, crush, and cut hazard.

 Indicates laser hazard.

 Indicates hot surface hazard.

 Indicates protective conductor terminal, which is bonded 
to conductive parts of an equipment for safety purposes.

 Indicates frame or chassis terminal, which is bonded to 
conductive parts of an equipment for safety purposes.

 Indicates that you must not discard this electrical/
electronic product in domestic household waste.

For more information about… See…

Compliance with regulations “Safety and regulatory compliance” on 
page 4

Safety hazards “Potential safety hazards” on page 5

Reporting problems with the 
Microplate Labeler

“Reporting problems” on page 176
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Safety and regulatory compliance

Compliance standards

The Microplate Labeler complies with the applicable EU Directives and bears 
the CE mark. See the Declaration of Conformity for details. The Microplate 
Labeler is designed to comply with the standards listed in the following table. 

Electromagnetic compatibility
If the Microplate Labeler causes interference with radio or television reception, 
which can be determined by turning the device off and on, try one or more of 
the following measures:

• Relocate the radio or television antenna.

• Move the device away from the radio or television.

• Plug the device into a different electrical outlet, so that the device and the 
radio or television are on separate electrical circuits.

• Make sure that all peripheral devices are also certified.

• Make sure that appropriate cables are used to connect the device to 
peripheral equipment.

• Consult your equipment dealer, Agilent Technologies, or an experienced 
technician for assistance.

Changes or modifications not expressly approved by Agilent Technologies could 
void the user's authority to operate the equipment.

Sound emission declaration
Sound pressure: Lp < 70 dB according to EN 27779:1991.

Schalldruckpegel: LP < 70 dB nach EN 27779:1991.
 

Regulatory Compliance Standard

EMC

European Union EMC Directive 2004/108/EC

IEC 61326- 1:2005 / EN 61326- 1:2006

Canada ICES/NMB- 001:2004

Australia/New Zealand AS/NZS CISPR 11:2004

Safety

European Union Machinery Directive 2006/42/EC

Low Voltage Directive 2006/95/EC

IEC 61010- 1:2001 / EN61010- 1:2001

Canada CAN/CSA- C22.2 No. 61010- 1- 04

USA ANSI/UL 61010- 1:2004
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Related information

Potential safety hazards

About this topic

This topic describes potential hazards that you can encounter when using the 
Microplate Labeler.

Mechanical hazards

The Microplate Labeler contains the following moving parts. 

Figure Microplate Labeler moving parts

For more information about… See…

Safety hazards “Potential safety hazards” on page 5

General safety “General safety information” on page 2

Reporting problems with the 
Microplate Labeler

“Reporting problems” on page 176
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Hazardous-voltage electronics

Hazardous- voltage electronics can be found within the Microplate Labeler. 
Under normal operating conditions, you are protected from exposure to the 
hazardous voltage. 

Hazardous- voltage electronics can also be found in the computer. See the 
computer manufacturer documentation for the hazard warnings. Make sure you 
follow the instructions on the safe operation of the computer.

 

Burn hazard

Item Description

1 Plate stage. Automatically rotates side to side during labeling to 
present the long and short sides of a microplate to the applicator 
head.

2 Applicator head. Automatically rotates between the printer and the 
plate stage to apply the barcode labels.

3 Printer. Contains various parts that move automatically during a 
print run. Keep the cover closed while the device is operating. 

WARNING  Pinch hazard. Do not reach between the plate stage and applicator head or 
between the applicator head and the printer while the device is on. 

WARNING Pinch hazard. Use care when closing the printer cover. Keep clear of the 
cover hinges and do not reach into the swivel range of the cover.

WARNING If you operate the printer with the cover open or with the cover removed, 
ensure that you keep clear of the exposed rotating parts.

WARNING  Do not try to gain access to the interior of the Microplate Labeler. Do not 
remove panels for any reason. Exposure to the interior electronics of a device can cause 
severe injury.

WARNING Ensure that the power cords are in good condition and are not frayed. Use of 
frayed or damaged power cords can cause injury. Use of incorrect power cords can cause 
damage to the device.

WARNING The printer can become hot while printing. Do not touch the printer 
components during operation. Allow the printer to cool down before changing the media or 
cleaning the printer components.
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High-pressure gas 

Compressed air is used to move components inside the Microplate Labeler.

Follow the local, state, and federal safety codes for the placement and 
mounting of gas cylinders. For example, you might have to attach a standard 
cylinder bracket to a solid permanent structure to meet or exceed all local 
seismic and safety requirements.

Always use good laboratory practices when handling high- pressure cylinders. 
Make sure you follow any instructions provided with the cylinders.

 

Laser hazard on barcode reader

If your Microplate Labeler is fitted with a barcode reader, make sure you 
understand the potential hazard. The barcode reader on the Microplate Labeler 
may contain a laser used to read barcodes. The laser beam will not harm your 
skin, so there is no danger in exposing your arms or hands to the beam. 
However, you could damage your eyes if you stare directly into the beam.

Barcode readers emit light for up to 0.5 seconds only when taking a reading. 
The potential hazard is present only during protocol runs. When a microplate 
is being read, the beam should not pass beyond the microplate.

Chemical hazards

General guidelines
Some chemicals used when working with the Microplate Labeler can be 
hazardous. Make sure you:

• Follow standard laboratory procedures and cautions when working with 
chemicals.

• Follow your local, state, and federal safety regulations when using and 
disposing of the chemicals.

WARNING  Working with open, charged air lines can result in injury. Turn off the 
compressed air line when disconnecting or reconnecting devices that use compressed air. 
Contact your facilities department or Automation Solutions Technical Support with 
questions about setting up the air line.

CAUTION Ensure that the air coming into the Microplate Labeler is properly filtered from 
moisture or aerosolized impurities. Significant moisture or impurities in the air line can 
adversely affect the performance and life of the device. Using oil compressors can cause oil to 
leak into the device and void your warranty.

WARNING  Class II laser hazard. Do not look directly at the laser beam. Looking 
directly at the laser beam can result in serious eye injury.

WARNING  Do not disassemble the barcode reader sensor heads. Laser emission from 
the reader is not automatically stopped if the sensor head is disassembled.

WARNING Unless following a procedure in a Agilent Technologies user guide, do not 
touch the white TEST button on the side of the barcode reader sensor head. This button 
turns on the laser creating the possibility of a long exposure to the light.
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Compatible chemicals
The Microplate Labeler surfaces are designed to be compatible with small 
volumes of aqueous solutions, common biological buffers, solvents, and 
common reducing agents.

The following chemicals were tested for brief exposures:

• Water (deionized, ultrapure type 1)

• Dimethyl sulfoxide (100%)

• Strong acid, such as hydrochloric acid (100 mM HCl) pH 2- 3

• Strong base (HPO4 or sodium hydroxide, 100 mM) pH 12- 13

• Ethanol (95% alcohol)

• Methanol (95% alcohol)

• Acetonitrile (100%)

• Chloroform (100%)

• Hydrogen peroxide (35%)                            

• Tetrahydrofuran

• Dichlormethan

• Toluene

• Acetone

Agilent Technologies recommends that you employ an Environmental Health 
and Safety professional on site to confirm the compatibility of other chemicals.
 

Related information

For more information about… See…

General safety “General safety information” on page 2

Locations of hardware components “Hardware overview” on page 12

Site laboratory requirements “Laboratory requirements” on page 33

Reporting problems with the 
Microplate Labeler

“Reporting problems” on page 176
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2
Introduction to the Microplate Labeler

This chapter provides the background information required to 
successfully operate the Microplate Labeler. 

The topics are:

• “About the Microplate Labeler” on page 10

• “Hardware overview” on page 12

• “Overview of the controlling software” on page 19

• “Labware considerations” on page 23

• “Introduction to microplate labels and barcodes” on page 24

• “How the Microplate Labeler applies a label” on page 26

• “Integrated Microplate Labeler—operation workflow” on page 27

• “Standalone Microplate Labeler—operation workflow” on 
page 29
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About the Microplate Labeler

About this topic

This topic provides an overview of the G5404B Microplate Labeler.

Microplate Labeler description

The Microplate Labeler prints labels and applies them to labware. 

Figure Microplate Labeler

You can create and apply the same or a different label on up to four sides of 
a microplate. Each label can include up to six fields, including a barcode field 
and human- readable text fields. 

Figure Microplate (side view) with barcode label

An optional barcode reader can verify that the barcode has been printed and 
applied correctly, and can be used to clone an existing barcode.

System configuration variations

A Microplate Labeler can be used in the following configurations:

• Integrated with an Agilent Technologies lab automation system, such as a 
BioCel Automation System or BenchCel Microplate Handler

• As a standalone device

• Integrated with a third- party lab automation system

label example
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Integrated in an Agilent Technologies lab automation system
When the Microplate Labeler is integrated with an Agilent Technologies BioCel 
Automation System or BenchCel Microplate Handler:

• The lab automation software (VWorks software or BenchWorks software) 
controls the device to perform labeling protocols automatically.

• The robot on the BioCel System or BenchCel Microplate Handler 
automatically moves the microplates to and from the Microplate Labeler 
plate stage.

Figure BenchCel Microplate Handler consisting of a BenchCel Microplate Handler (left) 
integrated with Microplate Labeler (right)

Standalone Microplate Labeler
When used as a standalone device:

• The PlateTag software controls the device to perform batch print jobs. 

• The operator places a microplate on the plate stage, presses the green 
button to perform the print- and- apply operation, and then replaces the 
labeled microplate with the next microplate to be labeled.

IMPORTANT The Microplate Labeler is designed to generate printed adhesive 
labels that are automatically applied to microplates. Although it is possible to 
print a single test label, manually peel the label off the backing, and place the 
label on a microplate by hand, printing of multiple labels for manual 
application is not supported for a standalone Microplate Labeler using the 
PlateTag software.
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Integrated in a third-party lab automation system
When the Microplate Labeler is integrated in a third- party lab automation 
system, the third- party software uses the Microplate Labeler ActiveX controls 
to perform labeling protocols.

Related topics

Hardware overview

About this topic

This topic describes the Microplate Labeler hardware features, including the 
optional barcode reader.

Microplate Labeler front view

The Microplate Labeler is comprised of a barcode applicator and label printer 
assembled on a baseplate.

For information about... See...

Instrument control software “Overview of the controlling software” 
on page 19

Workflows for setting up and using 
the device

• “Integrated Microplate Labeler—
operation workflow” on page 27

• “Standalone Microplate Labeler—
operation workflow” on page 29

ActiveX controls Microplate Labeler ActiveX User Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Figure Microplate Labeler components (front view)

Item Feature Description

1 Printer Prints a label (600 dpi) and pauses when the label 
reaches the peelbar to allow the applicator head to 
retrieve the printed label. The printer supports the 
printing of linear or two- dimensional (2D) barcodes.

2 Applicator Contains the plate stage, applicator head, green 
button, electronics, and the connection panel (back 
side) for the device.

3 Plate stage Provides a platform to support a plate delivered by a 
robot or a person. 

The plate stage rotates side to side to enable labeling 
on all four sides of a microplate. The plate stage 
rotation also allows the optional barcode reader to 
read any side of a microplate. 

The plate stage can move up and down to provide a 
choice of two vertical labeling positions to 
accommodate labware of varying heights.

IMPORTANT If you purchased a standalone 
Microplate Labeler and later decide to integrate the 
device with a BenchCel Microplate Handler or BioCel 
System, a different type of plate stage may be 
required. Contact Automation Solutions Technical 
Support for more information.

4 Green button Starts a print- and- apply operation for printing test 
labels, or starts a PlateTag batch print job. 

See “PlateTag print jobs and schemas” on page 116.
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Microplate Labeler connection panel (back view)

The Microplate Labeler connection panel is on the back of the applicator, next 
to the printer. 

Figure Microplate Labeler connection panel (back view)

5 Applicator 
head

Rotates between the printer and the plate stage. Uses 
vacuum pads (suction cups) to pick up a printed 
label from the printer and apply the label to a 
microplate on the plate stage.

6 Vacuum pads Uses vacuum to pick up a label from the printer and 
uses compressed air to apply the label to a 
microplate on the plate stage.

7 Printer peelbar Provides a platform for presenting each label to the 
applicator head vacuum pads. As the label strip 
travels over the peelbar, each label lifts off the label 
backing slightly to allow the applicator head to pick 
up the label.

Item Feature Description

Item Feature Description

1 Air supply port Connects to a compressed- air source. The device 
uses compressed air to:

• Move the plate stage up and down

• Rotate the applicator head side to side

• Extend and retract the applicator head

• Create a vacuum that the applicator head 
uses to pick up labels from the printer

• Apply labels to a microplate
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2 Ethernet port Connects an Ethernet cable from the controlling 
computer to the Microplate Labeler for 
communication.

You use one of the following cables from the 
Microplate Labeler utility kit: 

• Black Ethernet CAT5E RJ45 cable, 3.048- m 
(10- ft), for use with a network switch or hub.

• Red Ethernet CAT5E RJ45 crossover cable, 
3.048- m (10- ft), for connecting the device 
directly to the computer.

IMPORTANT Ethernet is the recommended 
mode of communication. If you connect to the 
Microplate Labeler using the Ethernet port, you 
do not use the serial port.

3 Barcode reader 
port

Connects the cable from the optional barcode 
reader to the Microplate Labeler for 
communication.

4 Serial port Connects a serial cable from the controlling 
computer to the Microplate Labeler to provide 
serial communication.

You can use the 1.8- m (6- ft) serial-
communications cable (beige) provided in the 
Microplate Labeler utility kit.

Note: If you connect to the Microplate Labeler 
using the serial port, you do not use the 
Ethernet port.

5 Power switch Turns on (|) or off (o) the power.

6 AC power port Connects the power cable.

7 Pressure gauge Indicates the regulated air pressure.

8 Air pressure 
regulator

Regulates the incoming air pressure to ensure 
that the device’s internal components are not 
exposed to air pressure that is too high. 

9 Fuse holder Houses the electrical fuse.

Item Feature Description
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Printer overview

Printer front view

Figure Printer front view with cover opened

Item Feature Description

1 Cover Removable transparent plastic cover that opens 
to provide access for cleaning the printer 
components and changing the media.

2 Printer service 
display

Displays the Ready message and various 
messages for service.

IMPORTANT The printer display must show the 
Ready indicator before you can initialize the 
device. During operation, the software displays 
operator messages and error messages on the 
computer screen. 

3 Service navigator 
pad

Used by the factory and field service personnel 
to set up the printer or change settings on the 
printer.

IMPORTANT Do not use the navigator pad to 
change the printer settings unless instructed to 
do so by Automation Solutions Technical 
Support.
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Printer side view

Figure Printer side view with cover removed

                                                        

6

7

1

2

3

4

5

Item Feature Description

1 Ribbon supply 
hub

Holds the unused printer ribbon roll.

The printer requires the G5404B Microplate 
Labeler Media Kit (not shown), which contains 
the thermal transfer ribbon and labels for the 
printer.

2 Ribbon take- up 
hub

Rewinds the used ribbon.

3 Printhead 
(hidden under 
the ribbon)

The narrow bar that presses the image through 
the ribbon and onto the label as the media move 
into position on to the print roller. 

4 Print roller and 
rewind assist 
roller

The rollers that assist in moving the label strip 
under the printhead (print roller) and to the 
internal rewinder.

5 Internal 
rewinder

Rewinds and holds the used label strip.

6 Roll retainer Holds the unused label roll.

7 Margin stop Locks the roll retainer and holds the ribbon roll 
securely in place.
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Barcode reader

The optional barcode reader is connected to the Microplate Labeler so that it 
can be used with the software to verify or clone barcodes.

IMPORTANT Successful integration of a barcode reader requires that the 
barcode reader have the correct pinouts, power, and is able to communicate 
the correct commands to the Microplate Labeler. 

Figure Microplate Labeler with barcode reader installed

Related information

For information about... See...

Barcodes • “Introduction to microplate labels 
and barcodes” on page 24

• “Barcodes and supported 
symbologies” on page 108

The labeling process “How the Microplate Labeler applies a 
label” on page 26

How to install and use the barcode 
reader

Automation Solutions Technical Support
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Overview of the controlling software

About this topic

This topic provides an overview of the following software:

• Automation control software. Used to set up and run the print jobs or 
labeling protocols.

• Microplate Labeler Diagnostics. Used to set up the device, create label 
formats, and troubleshoot problems.

Automation control software

You use the automation control software to set up the print- and- apply tasks 
and to run the labeling protocols. When you set up the print- and- apply tasks, 
you select a label format and specify the parameters for the label content.

The automation control software that you use depends on your configuration.

VWorks software and BenchWorks software overview

The VWorks software and BenchWorks software enable you to:

• Set up the system. During setup, you create device files for your specific 
set of devices. You can also create user accounts with different levels of 
privileges to enforce access policies.

• Define labware. Labware definitions describe the type and the geometry of 
the labware that the devices will be handling during the protocol runs. For 
the Microplate Labeler, the labware definition includes the plate stage 
height. 

• Create protocols. Protocols determine the sequence of tasks that you want 
to automate in a run. For example, you can use a protocol to apply 
barcode labels to 100 microplates automatically. 

• Run, pause, monitor, and stop protocols. You can start, pause, monitor, 
and stop a protocol run from the controlling computer. 

For more details on your automation control software, see the VWorks 
Automation Control User Guide or BenchWorks Automation Control User 
Guide.

Device configuration Controlling software

Microplate Labeler integrated with a 
BioCel System 

VWorks software

Microplate Labeler integrated with a 
BenchCel Microplate Handler

• VWorks software

• BenchWorks software

Standalone Microplate Labeler PlateTag software

Third- party lab automation system Microplate Labeler (VCode) ActiveX
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Microplate Labeler Diagnostics overview

Microplate Labeler Diagnostics is a component of the provided software. You 
can access Microplate Labeler Diagnostics through the VWorks software, 
BenchWorks software, PlateTag software, or the ActiveX controls. 

You use Microplate Labeler Diagnostics to set up and troubleshoot the device, 
including:

• Create and manage profiles. These are the communication settings that 
the automation control software uses to execute the print jobs or labeling 
protocols.

• Create and edit label formats. You can use the provided templates and 
customize them to create your own label formats.

• Perform test print- and- apply operations. You can print test labels when 
verifying a label format design, setting up the device, or troubleshooting 
problems.

• Set up the plate stage positions. If required, you can adjust the plate stage 
positions, for example the robot pickup angle for a device that is integrated 
in an automation control system. 

• Check the basic device functions. You can actuate the pneumatic controls 
to verify the device functioning and to check the alignment of the plate 
stage and applicator head.

PlateTag overview

You use the PlateTag software if you have a standalone Microplate Labeler. 
PlateTag has two tabbed pages: 

• Print Job tab. Provides controls for selecting the device profile to establish 
communication with the connected Microplate Labeler, configuring a print 
job, and starting and monitoring the print job.
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• Schemas tab. Enables you to create, copy, update, and delete schemas. A 
schema is a set of parameters used to define the contents and format of 
one label.

Figure PlateTag Print Job tab

Figure PlateTag Schemas page
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For information about... See...

Starting Microplate Labeler 
Diagnostics

• “Opening Microplate Labeler 
Diagnostics” on page 75

• “Quick reference to Diagnostics 
software” on page 179

VWorks software • “VWorks software—establishing 
communications with the device” on 
page 65

• VWorks Automation Control User 
Guide

BenchWorks software • “BenchWorks—establishing 
communications with the device” on 
page 70

• BenchWorks Automation Control 
User Guide

PlateTag software • “PlateTag software—establishing 
communications with the device” on 
page 73

• “PlateTag print job workflow” on 
page 114

ActiveX controls Microplate Labeler ActiveX User Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Labware considerations

About this topic

This topic provides guidelines for selecting automation- ready labware for use 
with the Microplate Labeler.

Acceptable microplates

The Microplate Labeler accommodates a wide range of microplates that meet 
American National Standards Institute (ANSI) Standards ANSI/SBS 1- 2004 
through ANSI/SBS 4- 2004. For the latest labware standards, go to 
www.sbsonline.org. You can also contact the labware manufacturer to inquire 
about ANSI- compliant labware. 

For use of nonconforming labware, please contact Automation Solutions 
Technical Support.

Figure Microplate (side view) with barcode label

Challenging microplate characteristics

Some microplates have special features specifically designed for particular 
instruments but are not optimized for the application of labels. If a label is 
applied to an uneven surface, for example overlapping the edge of a microplate 
skirt, the label is less likely to adhere to the labware.

The dimensions of the labels for the G5404B Microplate Labeler are 
0.635- cm by 5.08- cm (0.25- by 2- in). To attach these labels to a microplate 
successfully, the microplate side must have a flat, even surface that is slightly 
larger than the label. 

Attempting to apply a label to an uneven surface is not recommended. For 
example, the following features may prevent successful labeling of the 
microplate:

• Microplate with raised surfaces on the sides 

• Microplate with tall skirt

• Low profile microplates where the available height for label placement is 
very near or in some cases less than the height of the label itself

label example

label example

label example

http://www.sbsonline.org
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Related topics

Introduction to microplate labels and barcodes

About this topic

This topic provides an overview of the labels that you can create for the 
Microplate Labeler and a general description of barcode types.

Microplate labels

The labels that you create for the Microplate Labeler can contain up to six 
fields of data, including one barcode field and five human- readable text fields. 
The following figure shows an example of a typical label that contains two 
fields: one barcode field and one human- readable field. In the example, the 
barcode field has a blank margin (quiet zone) on each end to ensure that a 
barcode reader can read the barcode successfully.

Figure Example of a microplate barcode label

About barcodes

Barcodes contain information that can be read automatically, facilitating the 
fast and accurate tracking of microplates in lab automation systems. A barcode 
reader scans the line patterns, and software converts the encoded patterns 
into usable information. 

The method used for creating a barcode from text is called its symbology. Your 
choice of symbology depends on the barcode reader used for your application 
and your laboratory preferences.

For information about... See...

Label formats and content “About label formats and content” on 
page 92

How to design a label format “Creating and editing label formats” on 
page 94

Plate stage and applicator head 
positions

“About plate stage and applicator head 
positions” on page 81

Setting the height of the plate 
stage position

“Setting the plate stage vertical 
positions” on page 84

Blank margins (quiet zones)

5.08 cm (2 in)

0.635 cm (0.25 in)
Barcode

Human 
readable
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The Microplate Labeler can print either linear or two- dimensional (2D) 
barcodes.

Linear barcodes
A linear barcode is a sequence of parallel bars and spaces of variable widths 
that are arranged in groups. Each group represents an individual number, 
letter, or symbol. Within each group, the information is encoded by the relative 
thicknesses and relative positions of the bars and spaces. A linear barcode 
symbol contains a leading blank margin (quiet zone), a start character, one or 
more data characters, a stop character, and a trailing quiet zone.

Figure Example of a linear barcode using Code 128 symbology

Two-dimensional barcodes
2D barcodes are comprised of dots or small bars arranged as a matrix or in a 
stacked arrangement. The 2D barcodes typically can contain more information 
than linear barcodes because they encode data in both the vertical and 
horizontal directions. 

Figure Example of a 2D barcode using Data Matrix symbology

Related topics

For information about... See...

Label formats and content “About label formats and content” on 
page 92

How to design a label format “Creating and editing label formats” on 
page 94

Barcodes symbologies “Barcodes and supported symbologies” 
on page 108
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How the Microplate Labeler applies a label

About this topic

This topic describes what happens when you run a Microplate Labeler print-
and- apply task. 

Process

The following sequence of events occurs when you start a print- and- apply task:

1 The Microplate Labeler prints the label and moves the printed label 
forward to the peelbar on the printer. As the label strip reaches the 
peelbar, the printed label lifts off the backing.

2 The applicator head extends towards the printer until the vacuum pads 
touch the printed label.

3 A vacuum is created in the applicator head’s vacuum pads to grip the 
label.

4 After the vacuum is sensed, the applicator head retracts with the label 
held by the vacuum pads.

5 The plate stage rotates so that the selected side of the microplate is facing 
the applicator head. 

6 The applicator head rotates until it is perpendicular to the microplate on 
the plate stage, and then extends, pushing the label onto the microplate.

7 Air is pushed through the vacuum pads, breaking the vacuum seal.

8 The applicator head retracts and returns to face the printer.

9 The plate stage moves to the next selected position.

Related topics

For information about... See...

Locations of hardware components “Hardware overview” on page 12

Workflows for operating the 
Microplate Labeler

• “Integrated Microplate Labeler—
operation workflow” on page 27

• “Standalone Microplate Labeler—
operation workflow” on page 29

Label formats and content “About label formats and content” on 
page 92

Plate stage and applicator head “About plate stage and applicator head 
positions” on page 81

Testing the functions of the 
applicator

“Checking the basic applicator 
functions” on page 144
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Integrated Microplate Labeler—operation workflow 

About this topic

This topic describes the workflow for setting up and operating an integrated 
device using the VWorks software or BenchWorks software.

If you are using the PlateTag software to run a standalone Microplate Labeler, 
see “Standalone Microplate Labeler—operation workflow” on page 29.

Note: The steps for installing and operating the Microplate Labeler in a third-
party lab automation system might differ. For details, see the third- party user 
documentation provided with that system.

Microplate Labeler in an Agilent Technologies lab automation system or workstation

Step Procedure For more details, see…

1 Install the Microplate Labeler. 

Agilent Technologies performs this step for 
devices integrated in a BenchCel Microplate 
Handler or BioCel System.

“Installation workflow” on page 32

2 Set up the Microplate Labeler.

Agilent Technologies performs this step for 
devices integrated in a BenchCel Microplate 
Handler or BioCel System.

“VWorks or BenchWorks—setup workflow for 
integrated device” on page 63

3 Create label formats for printing.

The software includes a variety of templates 
that you can use or customize for your 
application.

“Creating and editing label formats” on 
page 94

4 To specify the plate stage height for your 
labware, open the Labware Editor and set 
the value in the labware definition (Plate 
Properties tab).

See the appropriate guide for your software:

• VWorks Automation Control Setup Guide 

• BenchWorks Automation Control User 
Guide

5 Perform a test print- and- apply test from 
Microplate Labeler Diagnostics to check the 
label format and label position on the 
microplate.

“Performing a print- and- apply test” on 
page 146

6 Create the protocols to run the labeling 
task. You set the labeling task parameters, 
including the label content, and select the 
label format for each labeling task.

See the appropriate guide for your software:

• VWorks Automation Control User Guide, 
Print and Apply task 

• BenchWorks Automation Control User 
Guide, Apply Label task
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Related topics

7 Start the protocol. See the applicable user guide for your 
software:

• VWorks Automation Control User Guide

• BenchWorks Automation Control User 
Guide

Step Procedure For more details, see…

For information about... See...

Locations of hardware components “Hardware overview” on page 12

Safety “Safety guidelines” on page 1

Reporting problems “Reporting problems” on page 176

Standalone device and the 
PlateTag workflow

“Standalone Microplate Labeler—
operation workflow” on page 29

ActiveX controls Microplate Labeler ActiveX User Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Standalone Microplate Labeler—operation workflow

About this topic

This topic describes the workflow for using the PlateTag software to run a 
standalone Microplate Labeler.

If you have a Microplate Labeler that is integrated in a BenchCel Microplate 
Handler or a BioCel System, see “Integrated Microplate Labeler—operation 
workflow” on page 27.

Workflow

Related topics

Step Procedure See…

1 Install the Microplate Labeler.

Agilent Technologies may perform this step 
for you.

“Installation workflow” on page 32

2 Set up the Microplate Labeler.

Agilent Technologies may perform this step 
for you.

“PlateTag—setup workflow for standalone 
device” on page 72

3 Create label formats for printing.

The software includes a variety of templates 
that you can use or customize for your 
application.

“Creating and editing label formats” on 
page 94

4 Perform a test print- and- apply test from 
Microplate Labeler Diagnostics to check the 
label format and label position on the 
microplate.

“Performing a print- and- apply test” on 
page 146

5 Create schemas and print jobs in the 
PlateTag software and run a print job.

“PlateTag—Running a print job” on page 113

For information about... See...

Locations of hardware components “Hardware overview” on page 12

Safety “Safety guidelines” on page 1

Reporting problems “Reporting problems” on page 176

Integrated device and the VWorks 
software or BenchWorks software 
workflow

“Integrated Microplate Labeler—
operation workflow” on page 27

ActiveX controls Microplate Labeler ActiveX User Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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3
Unpacking and installing the 
Microplate Labeler

This chapter describes how to unpack and install the Microplate 
Labeler. 

The topics are:

• “Installation workflow” on page 32

• “Laboratory requirements” on page 33

• “Unpacking and inspecting the Microplate Labeler” on page 36

• “Connecting the air tubing: non- metric” on page 38

• “Connecting the air tubing: metric” on page 40

• “Setting the air pressure” on page 42

• “Connecting the power cord” on page 43

• “Connecting the Microplate Labeler to the computer” on 
page 45

• “Installing the automation control software” on page 48

• “Loading labels and ribbon” on page 50



3   Unpacking and installing the Microplate Labeler
Installation workflow

32 G5404B Microplate Labeler User Guide

Installation workflow

About this topic

This topic provides the workflow for installing a Microplate Labeler. Typically, 
Agilent Technologies completes this initial installation for you.

Workflow

Related topics

Step For this task... See...

1 Ensure that your laboratory 
meets the site requirements.

“Laboratory requirements” on 
page 33

2 Unpack the Microplate Labeler. “Unpacking and inspecting the 
Microplate Labeler” on page 36

3 Connect the air tubing. • “Connecting the air tubing: 
non- metric” on page 38

• “Connecting the air tubing: 
metric” on page 40

4 Connect the Microplate Labeler 
to the power source.

“Connecting the power cord” on 
page 43

5 Connect the Microplate Labeler 
to the computer using either 
an Ethernet or serial 
connection.

 “Connecting the Microplate 
Labeler to the computer” on 
page 45

6 Install the automation control 
software.

“Installing the automation control 
software” on page 48.

7 Install the labels and ribbon in 
the printer.

“Loading labels and ribbon” on 
page 50

8 Install the barcode reader 
(Optional).

Automation Solutions Technical 
Support

For information about... See...

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 176
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Laboratory requirements

About this topic

This topic describes the requirements for the site where you plan to install the 
Microplate Labeler.

Laboratory space requirements

General bench requirements
Make sure the bench for the Microplate Labeler has the following:

• Sufficient space to accommodate the Microplate Labeler, computer, monitor, 
and accessories

• Sufficient clearance: 

– On the back of the device to access power, communication, and air 
tubing connections

– Above the printer to open the printer cover

– On the side of the printer to replace the label and ribbon rolls

Note: The snap- off cover can be removed from the printer if the device 
is operated within an enclosure where no corrosive chemicals or gases 
are present.

• A fixed bench (without wheels) that can support the weight of the 
Microplate Labeler without excessive shaking or movement

• Proper height for any operator to comfortably operate the Microplate 
Labeler

Microplate Labeler physical specifications

Note: Measurements do not include the cables or the computer.

Dimension Value

Width 28.7 cm (11.3 in) 

Height 35.1 cm (13.8 in)

Height with printer 
cover opened 

48.8 cm (19.2 in)

Depth 62.2 cm (24.5 in) 

Weight 21 kg (47 lbs) 
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Figure Microplate Labeler dimensions (front and side views)

Figure Microplate Labeler with printer cover open (front view)

Electrical requirements

The Microplate Labeler device has the following power requirements: 

Compressed air requirements

The Microplate Labeler requires the use of clean, dry, compressed air to move 
the pneumatic components. The compressed air can be from the following 
sources:

• Centralized source (laboratory)

• Compressed- air cylinders

• Portable pumps

Utility Requirement

Electrical 100–240~, 50/60 Hz, 2.75 A

Fuse Two 3 A, 0.25 x 1.25 in (6.35 x 31.75 mm), fast 
acting
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The Microplate Labeler has the following minimum compressed- air 
requirements:

Environmental requirements

The lab must meet the following environmental requirements:
 

Make sure the Microplate Labeler is located away from moisture (sprays of 
water or mists).

Computer requirements

The requirements of the controlling computer depend on the lab automation 
software you are using. 

• VWorks software computer requirements. See the VWorks software release 
notes or the Automation Solutions Knowledge Base at www.agilent.com/
lifesciences/automation. 

• Third- party automation software requirements. See the user 
documentation supplied with the product.

• PlateTag software requirements. Make sure the computer meets the 
following minimum requirements:

– Computer system

• Microsoft Windows XP with Service Pack 3

• 2 GHz or faster 32- bit (x86) processor (recommended)

• 2 GB system memory (recommended)

• 40 GB hard drive capacity with 10 GB free space (recommended)

• 1280 x 1024 pixel screen resolution

• Microsoft Internet Explorer 6.0 or Mozilla Firefox 1.0 with 
JavaScript enabled (required for using the context- sensitive help 
and knowledge base)

CAUTION Ensure that the air coming into the Microplate Labeler is properly filtered from 
moisture or aerosolized impurities. Significant moisture or impurities in the air line can 
adversely affect the performance and life of the Microplate Labeler. Using oil compressors can 
cause oil to leak into the Microplate Labeler and void your warranty.

Requirement Value

Quality Clean, dry, compressed

Flow rate and pressure 1.2 Lps at 0.59 MPa (2.5 cfm at 85 psi) 

Requirement Value

Ambient temperature 4- 40 °C

Humidity condition 10- 90% RH, non- condensing

Elevation 1–2000 m

http://www.agilent.com/lifesciences/automation
http://www.agilent.com/lifesciences/automation
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• A PDF viewer, such as Adobe Reader (required for opening the 
user guide PDF files)

– Communications interface using one of the following:

• Dedicated 10BaseT or faster Ethernet card (two network cards if 
connecting to your local area network)

• RS- 232 DB9 serial port, if you are controlling a device via a 
serial connection

Related topics

Unpacking and inspecting the Microplate Labeler

About this topic

This topic describes how to unpack and inspect the Microplate Labeler before 
installation.

Before you start

Verify the following:

• Ensure the installation site meets the requirements specified in 
“Laboratory requirements” on page 33.

• Inspect the shipping container and verify there is no obvious shipping 
damage. If damage has occurred, contact Automation Solutions Technical 
Support.

Inspection

IMPORTANT While unpacking your Microplate Labeler, inspect all items for 
shipping damage. If you encounter a problem, contact Automation Solutions 
Technical Support as soon as possible. Save the packaging materials in case 
you must move or ship the Microplate Labeler.

For information about... See...

How to install the device “Installation workflow” on page 32

How to install the software “Installing the automation control 
software” on page 48

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 176

WARNING  The Microplate Labeler weighs 18.7 kg (41.3 lb). Do not attempt to unpack 
or move the Microplate Labeler without assistance. Always use proper lifting techniques 
to avoid injury.
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Check to make sure the following items are included with your shipment:

• G5404B Microplate Labeler

• Air connection kit (non- metric or metric), including tubing and fittings

• G5404B Microplate Labeler Media Kit 

– Roll of labels (6,500)

– Thermal transfer ribbon 

– Empty ribbon core for winding the used ribbon

– Pen for cleaning the printhead and print roller

• G5404B Microplate Labeler software and documentation CD- ROM

• G5404B Microplate Labeler User Guide

• Serial communications cable 

• Red Ethernet CAT5E RJ45 crossover cable, 3.048- m (10- ft), for connecting 
the device directly to the computer.

• Black Ethernet CAT5E RJ45 cable, 3.048- m (10- ft), for use with a network 
switch or hub

• Hex wrench (2.5 mm)

• Power cord appropriate for your country

Air fittings

Depending on the configuration of your air supply system, one or more of the 
provided air fittings may be required. If your air system has a different 
configuration, you must supply your own fittings. 

Related topics

For information about... See...

How to install the device “Installation workflow” on page 32

Site requirements for installation “Laboratory requirements” on page 33

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 176
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Connecting the air tubing: non-metric 

About this topic

For non- metric- based installations, such as those in the U.S., this topic 
explains how to connect the air tubing to the Microplate Labeler.

Before you begin

Locate the air connection kit (non- metric), including tubing and fittings, 
provided with your device.

Connection procedure

To set up a direct connection, use the following procedure. If you have another 
device connected to the air supply, you can use the supplied quick- release 
T-connector to connect to the existing air tubing.

Figure Connection panel: orange air-supply port (left) and pressure gauge (right)

To install the air tubing:

1 Cut the supplied 1/4- inch tubing to the required length.

2 If your air supply uses a threaded connection at the supply end, attach the 
1/4- inch NPT fitting to the connection.

3 Plug one end of the tubing into your lab’s air supply.

4 Connect the tubing from the air source to the long end of the toggle switch 
assembly. Connect the short end of the toggle switch assembly to the 
tubing that connects to the Microplate Labeler.

5 Push the other end of the 1/4- inch tubing into the orange quick- release 
air- supply port at the back of the Microplate Labeler. 

6 Test the installation by gently tugging the air tubing.

WARNING  To avoid injury, turn off the air supply before installing your Microplate 
Labeler. When air is flowing, air tubing can injure you if it whips around and strikes you. If 
you have not been trained in the correct way to handle air tubing, contact your facilities 
department.

CAUTION Make sure that the air tubing coming into your Microplate Labeler is properly 
filtered for moisture. Moist air might shorten the life of your device. If the quality of your air 
supply is in question, contact Automation Solutions Technical Support.
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If you feel resistance, the line has been installed properly.

Related topics

For information about... See...

How to install the device “Installation workflow” on page 32

Site requirements for installation “Laboratory requirements” on page 33

How to connect air tubing for 
metric- based installations

“Connecting the air tubing: metric” on 
page 40

Setting the air pressure “Setting the air pressure” on page 42

Disconnecting air supply “Disconnecting the air tubing” on 
page 163

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 176
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Connecting the air tubing: metric 

About this topic

This topic explains how to connect the air tubing to the Microplate Labeler for 
metric- based installations. 

To make the Microplate Labeler compatible with your lab’s air system, you 
connect the supplied 6- mm air tubing to the Microplate Labeler air supply 
port. This topic describes how to make this connection.

Figure Connection panel: orange air-supply port (left) and pressure gauge (right)

Before you start

Locate the air connection kit (metric), including tubing and fittings, provided 
with your device.

Connection assembly

The metric fittings kit contains an adapter. 

Figure Connection to Microplate Labeler using adapter

WARNING  Turn off the air supply at the source before installing the Microplate 
Labeler. If you have not been trained in the correct way to handle air tubing, contact your 
facilities department or Automation Solutions Technical Support for assistance.

CAUTION Make sure that the air coming into the Microplate Labeler is dry and free of 
impurities, such as oil, which can damage the Microplate Labeler. If you have any questions 
about air quality, contact Automation Solutions Technical Support.
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Procedure

The following procedure is used to set up a direct connection. If you have 
another instrument connected to the house air supply, you can use the 
supplied T- connector to connect into the existing air tubing.

To connect the metric fittings adapter:

1 Push one end of the nipple (white plastic tube) into the 1/4- inch side (red 
side) of the adapter.

2 Push the other end of the nipple into the air input port on the Microplate 
Labeler.

3 Push the 6- mm tubing into the blue side of the adapter.

4 Gently pull on the air tubing to ensure that the assembly is connected 
properly.

 

Related topics

CAUTION Attempting to use tubing that has a different diameter can damage the 
adapter.

For information about... See...

How to install the device “Installation workflow” on page 32

Site requirements for installation “Laboratory requirements” on page 33

How to connect air tubing for 
North America

“Connecting the air tubing: non- metric” 
on page 38

Setting the air pressure “Setting the air pressure” on page 42

Disconnecting air supply “Disconnecting the air tubing” on 
page 163

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 176
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Setting the air pressure

About this topic

This topic describes how to set the air pressure after connecting the air tubing 
to the Microplate Labeler.

Procedure

To set the air pressure:

1 Turn on the air supply to the Microplate Labeler.

Depending on your lab configuration, the mechanism for turning on the air 
supply might be a pressure regulator located on the wall or on a 
compressed air cylinder, or a toggle switch on the air line. The air supply 
to the Microplate Labeler should be in the range of 0.55 MPa (80 psi) to 
0.58 MPa (85 psi).

2 To adjust the internal air- pressure regulator on the Microplate Labeler:

a On the back of the applicator, pull out the pressure regulator knob 
until you feel a click.

b While watching the pressure gauge, turn the knob to increase or 
decrease the pressure so that the gauge reads in the following range:

0.55 MPa (80 psi) to 0.58 MPa (85 psi)

c Push the knob back in.

Figure Connection panel: air pressure gauge (top) and pressure regulator knob (bottom)

IMPORTANT Check the air pressure after using the Microplate Labeler for the 
first time to make sure the air pressure setting is correct.



43

3   Unpacking and installing the Microplate Labeler
Connecting the power cord

G5404B Microplate Labeler User Guide

Related topics

Connecting the power cord

About this topic

This topic explains how to connect the Microplate Labeler to a power source.

Before you start

Procedure

To install the power cord:

1 On the back of the Microplate Labeler applicator, ensure that the power 
switch is set to off (o).

For information about... See...

How to install the device “Installation workflow” on page 32

Site requirements for installation “Laboratory requirements” on page 33

Connecting the air tubing “Connecting the air tubing: non- metric” 
on page 38

“Connecting the air tubing: metric” on 
page 40

Disconnecting air supply “Disconnecting the air tubing” on 
page 163

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 176

WARNING  The Microplate Labeler has moving parts. Keep clothing, hair and jewelry 
away from it at all times.
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Figure Connection panel: AC power port and power switch

2 Plug one end of the power cord into the AC power port on the connection 
panel. 

3 Plug the other end of the power cord into an appropriate, grounded 
electrical socket.

Later, after you connect the computer, you will start up the device.

Related topics

For information about... See...

Connecting the computer “Connecting the Microplate Labeler to 
the computer” on page 45

Turning on the device “Starting up and shutting down” on 
page 60

How to install the device “Installation workflow” on page 32

Site requirements for installation “Laboratory requirements” on page 33

Connection panel “Microplate Labeler connection panel 
(back view)” on page 14

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 176
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Connecting the Microplate Labeler to the computer

About this topic

This topic describes how to connect the computer to the Microplate Labeler 
using either of the following:

• Ethernet connection (recommended)

• Serial connection 

Using an Ethernet connection

You can use Ethernet to connect a Microplate Labeler to the computer:

• Directly

• Through an Ethernet switch

If you are setting up a standalone Microplate Labeler, you can use either 
method. If you are setting up a local area network (LAN) that has other 
devices on it, use an Ethernet switch.

The Automation Solutions configured computer has two Ethernet ports: 

• Port for the add- on Ethernet card. Configured for a static address. You 
connect the Microplate Labeler to the port configured for a static address. 

• Port for the computer’s built- in Ethernet card. Configured for a dynamic 
address. You can use this port to connect to your company network. 

Connecting directly to the computer
A red crossover Ethernet cable is provided for connecting the computer 
directly to the Microplate Labeler (without a switch or hub.) This 
communication cable is used when a single Microplate Labeler is directly 
connected to a single host computer, where no other robots or devices must 
interact or communicate.

To connect directly to the computer using Ethernet:

1 On the Microplate Labeler connection panel, connect one end of the red 
crossover Ethernet cable to the Ethernet port.

2 Connect the other end of the cable to the Ethernet port of the computer.
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Figure Connection panel: Ethernet connection

Connecting through an Ethernet switch
An Ethernet switch connects the single cable from the computer to one or 
more cables that lead to one or more devices.

IMPORTANT Do not use the red crossover cable with an Ethernet switch. The 
switch performs the crossover function.

If you are adding the Microplate Labeler to an existing LAN, step 1 of the 
following procedure should already be done.

To connect through an Ethernet switch:

1 Connect the switch to the computer as follows:

a Connect the power cord to the switch.

b Connect one end of the Ethernet cable (black) into any Ethernet port 
on the switch, and connect the other end of the cable to an Ethernet 
port on the computer.

2 Connect the Microplate Labeler to the switch as follows:

a Connect one end of a second Ethernet cable to a port on the Ethernet 
switch.

b Connect the other end of the cable to the Ethernet port on the 
Microplate Labeler.

Connecting additional devices
You can connect additional Microplate Labelers to the network through the 
switch.

Each Microplate Labeler requires an additional profile.

IMPORTANT Before connecting multiple Microplate Labeler devices on the 
same network, contact Automation Solutions Technical Support for guidance on 
setting the IP addresses.
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About configuring the computer’s network card (Ethernet only)
The Automation Solutions configured computer is already set up to 
communicate with the Microplate Labeler. No change to the network card 
IP address is required.

If you are using a computer other than an Automation Solutions configured 
computer, make sure the value of the network card IP address and subnet 
mask are as follows:

• IP address: 192.168.0.1

• Subnet mask: 255.255.255.0

If your computer will be connected to your LAN, make sure the computer has 
a second network card. The second network card can have a dynamic 
IP address.

Using a serial connection

If you are connecting a single Microplate Labeler to a computer, you can use 
a serial connection.

To use a serial connection:

1 Connect one end of the supplied RS- 232 DB- 9 serial cable (beige) to a 
COM port on the computer.

 IMPORTANT The serial cable is a straight- through, pin- to- pin cable. 
Make sure you are not using a serial null- modem cable, which may look 
identical but will prevent proper communication with the Microplate 
Labeler.

2 Connect the other end of the cable to the serial port on the Microplate 
Labeler connection panel.

CAUTION Using serial connections to connect more than one Microplate Labeler to the 
same computer can cause problems with the barcode label formats.
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Figure Connection panel: serial connection

Related topics

Installing the automation control software

About this topic

The Microplate Labeler ships with one of the following software CDs: 

• VWorks software. For details on installing and setting up the VWorks 
software, see the VWorks Automation Control Setup Guide.

For information about... See...

Changing the IP settings on a 
computer and on the Microplate 
Labeler

Automation Solutions Technical Support

How to install the device “Installation workflow” on page 32

Site requirements for installation “Laboratory requirements” on page 33

Connection panel “Microplate Labeler connection panel 
(back view)” on page 14

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 176
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Note: If you use the computer provided with your lab automation system or 
workstation, the VWorks software is already installed.

• BenchWorks software. For details on the BenchWorks software, see the 
BenchWorks Automation Control User Guide.

Note: If you use the computer provided with the workstation, the 
BenchWorks software is already installed.

• PlateTag software. If you are setting up a standalone device or as a device 
integrated with a third- party lab automation system, install the PlateTag 
software as described in the following procedure.

This topic describes how to install the PlateTag software. 

Before you begin

Ensure the computer meets the specified requirements. See “Computer 
requirements” on page 35.

Procedure for installing PlateTag software

To install the PlateTag software:

1 Insert the Microplate Labeler CD into the computer CD- ROM drive. The 
software installer should start automatically. 

If installer does not start, in Microsoft Windows, navigate to the CD- ROM 
drive, and then double- click setup.exe.

2 Follow the instructions that appear on the screen.

Unless you select a different location, the PlateTag software and a PDF of 
the user guide install in the following folder:

C:\Program Files\Agilent Technologies\Microplate Labeler

Related topics

For information about... See...

How to install the device “Installation workflow” on page 32

Computer requirements “Computer requirements” on page 35

VWorks software • VWorks Automation Control Setup 
Guide

• VWorks Automation Control User 
Guide

BenchWorks software BenchWorks Automation Control User 
Guide

How to report a problem “Reporting problems” on page 176
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Loading labels and ribbon

About this topic

This topic describes how to load labels and ribbon in the Microplate Labeler 
printer. 

After you load the labels and ribbon, perform several print- and- apply tests to 
ensure that the labels are printing correctly and that the vacuum pads on the 
applicator head can pick the labels off of the label backing.

Before you begin

Ensure that you have the G5404B Microplate Labeler Media Kit from Agilent 
Technologies. The kit contains a one- to- one quantity of ribbon and labels so 
that you can replace them at the same time. The kit contents are:

• Roll of labels (6,500)

• Thermal transfer ribbon 

• Empty ribbon core (functions as a spool to rewind the used ribbon)

• Cleaning pen

For ordering information, go to the following web site: 
www.agilent.com/lifesciences/automation

Open the printer cover to gain access for loading the labels and ribbon.

Figure Printer (side view) showing the feed paths of the ribbon (red) and labels (blue) 

WARNING The printhead can be hot after use. Allow the printhead to cool before 
changing the ribbon. 

http://www.agilent.com/lifesciences/automation
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Removing the used ribbon

See the following figure for the component locations referenced in the 
procedure.

To remove the used ribbon:

1 While firmly grasping the ribbon supply hub (1), turn the green knob 
clockwise  to contract the hub and loosen the empty roll. Slide the 

roll off of the hub.

2 Lift the printhead lever (2) counterclockwise to lift the printhead.

3 While firmly grasping the take- up hub (3), turn the green take- up knob 
clockwise  to contract the hub and loosen the used roll of ribbon. 

Slide the used roll off of the take- up hub.

4 Lift the remaining ribbon out of the printer.

IMPORTANT Clean the printhead before loading the new ribbon. See 
“Cleaning the printer components” on page 155.

                                                        

2

1

3
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Loading the new ribbon

See the following figure for the component locations referenced in the 
procedure.

To load new ribbon:

1 Install the new ribbon roll on the supply hub (1) as follows:

a While firmly holding the supply hub, turn the green knob clockwise 
 to contract the hub. Slide the new ribbon roll onto the hub until 

it is flush against the printer. Ensure the ribbon feeds clockwise with 
the coating facing downward when being unwound.

b While firmly holding the hub, turn the green knob counterclockwise 
 to expand the hub and secure the ribbon roll.

2 Ensure the printhead lever (2) is up to lift the printhead, and then guide 
the ribbon under and around the printhead.

3 Feed the ribbon onto an empty core on the take- up hub (3) as follows:

a While firmly holding the take- up hub, turn the green knob clockwise 
 to contract the hub. Slide an empty ribbon core onto the hub 

until it is flush against the printer. 

2

1

3

WARNING The printhead can be hot after use. Allow the printhead to cool before 
changing the ribbon. The printhead is the narrow bar that presses the image through 
the ribbon and onto the label as the media move onto the print roller.

CAUTION Do not touch the protective glass layer of the printhead with your fingers. 
A dirty printhead will result in a poor print image.
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b While firmly holding the hub, turn the green knob counterclockwise 
 to expand the hub and secure the ribbon core.

c Guide the ribbon under and then over the take- up hub so that it winds 
counterclockwise. Use adhesive tape to secure the end of the ribbon to 
the ribbon core. Make sure the edge of the ribbon is flush with the 
core against the printer.

4 Turn the ribbon take- up hub (3) counterclockwise to smooth out the ribbon 
slack.

If you are also loading labels, continue to the next procedure. If you are 
finished loading all media, turn the printhead lever (2) clockwise to lower the 
printhead.

Removing a used label roll

See the following figure for the component locations referenced in the 
procedure.

To remove a used label roll:

1 If the printhead is not already in the up position, lift the printhead lever 
(1) counterclockwise to lift the printhead.

2 Push down on the pinch- roller lever (2) to release the label strip.

3 Cut the used label strip, and wind it fully around the rewinder (3).

4 While firmly holding the rewinder (3), turn the green knob clockwise  

to contract the rewinder and release the wound roll. 

5 Remove the wound roll. 

Note: You will remove the empty label core when you install the new 
label roll in the following procedure.

                                                        

1

2

3



3   Unpacking and installing the Microplate Labeler
Loading labels and ribbon

54 G5404B Microplate Labeler User Guide

Loading the new labels

You install the labels in three basic steps:

Step 1. Installing the label roll on the roll retainer

To install the label roll on the roll retainer:

1 Turn the green locking ring (1) counterclockwise, so that the arrow points 

to .

2 Remove the margin stop (2).

3 On the roll retainer (3), load the new label roll so that it feeds 
counterclockwise with the label side up.

4 Reposition the margin stop (2) on the roll retainer (3).

5 While firmly pushing the margin stop against the label roll (4), turn the 

green locking ring (1) clockwise, so that the arrow points to , securing 
the label roll in position.

 IMPORTANT To ensure the roll feeds properly and label presentation is 
repeatable, the margin stop must be firmly in place against the label 
roll.

Step For this task...

1 Install the label roll on the roll retainer.

2 Feed the label strip under the printhead.

3 Secure the label strip to the rewinder.

1

3

2

4
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Step 2. Feeding the label strip under the printhead

To feed the label strip through the printhead:

1 Turn the printhead lever (5) counterclockwise to lift the printhead.

2 Slide the red guide ring (8) to the end of the axis bar.

3 Guide the label strip below the axis bar and through the label sensor (7) so 
that the label strip exits the print unit between the printhead and the 
print roller (6).

4 Push the guide ring (8) on the axis bar against the outer edge of the label 
strip.

5

7

6

8
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Step 3. Securing the label strip to the rewinder

To secure the label strip to the rewinder:

1 Push down on the pinch- roller lever (9) to lift the pinch roller off the 
rewind assist roller.

2 Guide the label strip down and under the rewind assist roller (10) toward 
the rewinder (11).

3 While holding the rewinder (11) firmly, turn the green knob clockwise 
 until it stops.

4 Insert the label strip under the three brackets on the rewinder (11), and 
turn the green knob counterclockwise  until it stops. The rewinder is 

fully expanded, gripping the label strip firmly. 

The inside edge of the label strip should be flush against the printer. 

5 Turn the rewinder (11) counterclockwise to tighten the label strip.

6 Push up on the pinch- roller lever (9) to position the pinch roller into 
position on the rewind assist roller.

7 Turn the printhead lever (12) clockwise to lower the printhead into 
position.

After you finish loading new ribbon and labels

Use Microplate Labeler Diagnostics to run a print- and- apply test and verify 
that the labels print correctly and the applicator head can pick up the labels 
from the printer. 

Optionally, you can reset the label counter in the I/O Functions tab to track 
the number of labels used.

12

10

9

11
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Related topics

For information about... See...

Performing a print- and- apply test “Performing a print- and- apply test” on 
page 146

Resetting the label counter “Resetting the label counter in the 
Diagnostics software” on page 157

Cleaning the printhead and print 
roller using the cleaning pen

“Cleaning the printer components” on 
page 155

Routine printer maintenance “Routine maintenance” on page 142

Reporting problems “Reporting problems” on page 176
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4
Setting up the Microplate Labeler

This chapter describes how to perform the initial set up of the 
Microplate Labeler.

The topics are:

• “Starting up and shutting down” on page 60

• “VWorks or BenchWorks—setup workflow for integrated device” 
on page 63

• “VWorks software—establishing communications with the device” 
on page 65

• “PlateTag—setup workflow for standalone device” on page 72

• “PlateTag software—establishing communications with the 
device” on page 73

• “Opening Microplate Labeler Diagnostics” on page 75

• “Creating and managing profiles” on page 77

• “Placing a microplate on the plate stage” on page 80

• “About plate stage and applicator head positions” on page 81

• “Setting the plate stage vertical positions” on page 84

• “Setting the robot pickup angle teachpoint” on page 88
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Starting up and shutting down

About this topic

This topic describes how to start up and shut down the Microplate Labeler.

Starting up the Microplate Labeler

IMPORTANT Follow the steps in the order shown to establish communication 
with the Microplate Labeler.

To start up a Microplate Labeler

1 Turn on the air supply. 

2 On the Microplate Labeler connection panel, check the air pressure gauge 
(see figure, 1). Verify the air pressure is set within the following range: 

0.55 MPa (80 psi) to 0.58 MPa (85 psi)

Figure Connection panel showing Ethernet connection

3 Verify that the communication cable (2) and power cord (3) are connected, 
but do not turn on the power yet. 

Note: The figure shows an Ethernet connection. If you are using serial 
communication, the serial cable connects to the serial port. For more 
details, see “Connecting the Microplate Labeler to the computer” on 
page 45.

4 If you are using an Ethernet switch, turn on the power to the Ethernet 
switch.

5 Turn on the computer and the monitor, and wait for the computer to boot 
up.

6 On the connection panel, press the power switch (4) to the on (|) position.

1

2

3

4
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 IMPORTANT Ensure that the power switch on the printer remains in 
the on (|) position.

7 To start the automation control software, click the shortcut icon for the 
software on the Microsoft Windows desktop. 

Alternatively, choose Start > All Programs > Agilent Technologies > software 
name.

To establish communication with the Microplate Labeler, see the topic for 
your software:

• For the VWorks software, see “VWorks software—establishing 
communications with the device” on page 65.

• For the BenchWorks software, see “BenchWorks—establishing 
communications with the device” on page 70.

• For the PlateTag software, see “PlateTag software—establishing 
communications with the device” on page 73.

Shutting down the Microplate Labeler

Shut down the Microplate Labeler before you:

• Install a barcode reader

• Perform maintenance on or clean the Microplate Labeler

• Move the Microplate Labeler

To shut down the Microplate Labeler:

1 Exit the automation control software.

2 Shut down the computer and turn off the monitor.

3 On the Microplate Labeler connector panel, press the power switch to the 
off (o) position. 

4 Turn off the air supply.

Related topics

WARNING  The device components can move when you turn on the power and the 
air. Keep fingers, hair, clothing, and jewelry away from the Microplate Labeler while it 
is in motion. Never touch any of the moving parts or attempt to move labware while 
the Microplate Labeler is in operation. The device could pinch, pierce, or bruise you.

For information about... See...

Hardware components “Hardware overview” on page 12

Establishing communication with 
the Microplate Labeler

• “VWorks software—establishing 
communications with the device” on 
page 65

• “BenchWorks—establishing 
communications with the device” on 
page 70

• “PlateTag software—establishing 
communications with the device” on 
page 73
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Designing the label formats “Creating label formats” on page 91

Setting up and running a labeling 
protocol in the VWorks software

VWorks Automation Control User 
Guide

Setting up and running a labeling 
protocol in the BenchWorks 
software

BenchWorks Automation Control User 
Guide

Setting up a PlateTag print job “PlateTag—Running a print job” on 
page 113

Troubleshooting problems “Troubleshooting hardware problems” 
on page 167

Reporting problems “Reporting problems” on page 176

For information about... See...
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VWorks or BenchWorks—setup workflow for integrated device

About this topic

This topic provides an overview of the procedures required to set up the 
Microplate Labeler after the device has been installed. If the Microplate Labeler 
is being set up for the first time, use the workflows described below. If the 
device is part of an integrated Agilent Technologies laboratory automation 
system, the setup has already been performed, and additional setup should not 
be required. 

Setup workflow for integrated device

The following workflow describes the steps for initial setup of a Microplate 
Labeler when it is integrated in a lab automation system. 

Note: If the Microplate Labeler is integrated in a third- party lab automation 
system, the third- party software controls the device via the Microplate Labeler 
ActiveX interface. See the Microplate Labeler ActiveX User Guide. For 
additional information, see the third- party system documentation. For 
assistance, contact Automation Solutions Technical Support.

Step For this task... See...

1 Establish communication with the 
Microplate Labeler:

a In the software, add the 
Microplate Labeler device and 
select the profile.

b Initialize the device. 

The related topic for your software:

• “VWorks software—establishing 
communications with the device” on 
page 65

• “BenchWorks—establishing communications 
with the device” on page 70

2 Start Microplate Labeler Diagnostics. “Opening Microplate Labeler Diagnostics” on 
page 75

3 If necessary, edit the profile or create a 
new one.

“Creating and managing profiles” on page 77

4 Perform a print and apply test. “Performing a print- and- apply test” on 
page 146

5 If necessary, adjust the vertical plate 
stage height.

“Setting the plate stage vertical positions” on 
page 84 

6 Verify the teachpoint for the robot pickup 
angle. If required, edit the teachpoint and 
update the profile.

“Setting the robot pickup angle teachpoint” on 
page 88

7 Perform a print and apply test. “Performing a print- and- apply test” on 
page 146

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf


4   Setting up the Microplate Labeler
VWorks or BenchWorks—setup workflow for integrated device

64 G5404B Microplate Labeler User Guide

After the device setup is completed, you are ready to:

• Design your label formats

• Set up the a labeling protocol in VWorks (Print and Apply task) or 
BenchWorks (Apply Label task).

Related topics

8 To set up additional Microplate Labeler 
devices, perform steps 2 through 8 for 
each additional device.

Note: You must create a profile with an 
appropriate Ethernet or serial setting for 
each device.

–

Step For this task... See...

For information about... See...

Designing label formats “Creating label formats” on page 91

Creating and running a labeling 
protocol in the VWorks software

VWorks Automation Control User 
Guide

Creating and running a labeling 
protocol in the BenchWorks 
software

BenchWorks Automation Control User 
Guide

Setup workflow for a standalone 
device

“PlateTag—setup workflow for 
standalone device” on page 72

Starting up the device “Starting up and shutting down” on 
page 60

Reporting problems “Reporting problems” on page 176
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VWorks software—establishing communications with the device

About this topic

Read this topic if you are an administrator responsible for managing Agilent 
Technologies devices that are running the VWorks software. This topic 
describes how to add and delete new Microplate Labeler devices in the VWorks 
software. 

The VWorks software uses the information in a device file to communicate 
with and operate devices within the lab automation system. 

• If your computer was configured by Automation Solutions. The correct 
device configuration is already set up for communication with the 
Microplate Labeler. You are not required to create a new Microplate 
Labeler device in the software unless you want to reference different 
profiles. To establish communication, you must initialize the device.

• If you configured your own computer. You must add a device in the 
VWorks software for each Microplate Labeler in the system.

For detailed information about device files and associations with profiles, 
teachpoints, and labware definitions, see the VWorks Automation Control User 
Guide. 

Devices and device files defined

A device is an item in your lab automation system that has an entry in a 
VWorks software device file. A device can be a robot, an instrument, or a 
location in a lab automation system that can hold a piece of labware.

The device file (*.dev) stores information for all the devices in an integrated 
system, including:

• Type of device (for example, Microplate Labeler device)

• Device configuration information (for example, approach height, allowed or 
prohibited labware, and so on)

• Profile to use

Creating a device file

If you are setting up the Microplate Labeler for the first time, you will create 
a device file. You add the Microplate Labeler device and the external devices to 
the device file.

To create a device file:

1 Log in to the VWorks software as an Administrator.

2 In the VWorks window, choose File > New > Device. 

A Device File tab appears in the VWorks window.

3 Choose File > Save. In the Save As dialog box, type a file name (*.dev), 
select the following storage location, and click Save:

…\VWorks Workspace\Device Files
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Adding the Microplate Labeler to a device file

Before you begin:

• Ensure that any devices are physically networked to the computer.

• Turn on the devices.

To add devices to a device file:

1 In the VWorks window, verify that the correct device file is open.

To open a device file, choose File > Open. In the Open dialog box, select 
your device file (*.dev), and then click Open. The device files should be 
stored in the following location:

…\VWorks Workspace\Device Files

2 In the Available Devices area, double- click the Microplate Labeler icon. Or, drag 
the Microplate Labeler icon to the Device File tab.

Note: To show or hide the list of available devices, choose View > Available 
Devices.
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3 In the Device File tab, select the Microplate Labeler-n icon.

4 Under Microplate Labeler Properties, type a Name for the device. By default, 
the software assigns Microplate Labeler- n, and increments the number for 
each Microplate Labeler device that you add.

To identify the specific Microplate Labeler, the device name should include 
the device serial number.

5 In the Profile list, select a profile for the device.

If the Profile list is empty, open Diagnostics and create a profile. Then 
return to the Profile list under Microplate Labeler Properties and select the new 
profile.

 IMPORTANT To use different configurations of the same device in 
different protocols, you can save time by creating a different device file 
for each configuration. For example, if you change a pipette head on a 
pipettor, you can simply open the device file that contains the device 
with the appropriate profile instead of editing the profile selection in 
the device file.

6 On the Device File tab, under the Microplate Labeler device icon, click the 
location icon. The corresponding properties appear.
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Set the desired values for the following properties. Use the default values 
for the remaining properties.

7 Select File > Save.

If you are creating a new device file, the Save As dialog box appears so 
that you can specify a name and location for your device file. Ensure the 
file type is *.dev.

Alternatively, you can select File > Save All to save the device file and the 
current protocol file at the same time.

 

Initializing the Microplate Labeler in the VWorks software

To initialize the Microplate Labeler in the VWorks software:

1 In the VWorks window, ensure that the device file is open and the 
Microplate Labeler device icon appears in the Devices area.

2 In the Devices area, select the Microplate Labeler device, and then click 
Initialize selected devices.

When communication is established, the plate stage of the Microplate Labeler 
homes. If communication is not established, select another profile or open 
Microplate Labeler Diagnostics and modify the profile if necessary. See 
“Creating and managing profiles” on page 77.

Property Description

 
Allowed/prohibited 
labware

Optional. Click  if you want to specify labware 
restrictions for this location. The Allowed/prohibited 
labware dialog box appears. For details on the 
labware classes, see the VWorks Automation 
Control Setup Guide.

Note: If the  button is not visible, click the 
empty field. 
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Related topics

For information about... See...

Setup workflow “VWorks or BenchWorks—setup 
workflow for integrated device” on 
page 63

Profiles “Creating and managing profiles” on 
page 77

Designing label formats “Creating label formats” on page 91

Running a labeling protocol VWorks Automation Control User 
Guide

Troubleshooting communications 
problems

“Troubleshooting hardware problems” 
on page 167

Reporting problems “Reporting problems” on page 176
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BenchWorks—establishing communications with the device

About this topic

Read this topic if you are an administrator in charge of managing a Microplate 
Labeler integrated with a BenchCel Microplate Handler that is running the 
BenchWorks software.

The BenchWorks software uses the information in a device file to communicate 
with and operate all the devices in the BenchCel Microplate Handler. If you 
are adding a new Microplate Labeler to a workstation, you must add a new 
Microplate Labeler device to the device file.

For detailed information about device files and associations with profiles, 
teachpoints, and labware definitions, see the BenchWorks Automation Control 
User Guide.

Adding the Microplate Labeler device to a BenchWorks device file

To add the Microplate Labeler to a device file:

1 Ensure that the Microplate Labeler is physically networked to the computer 
and turned on.

2 Start the BenchWorks software and login as an Administrator.

3 In the BenchWorks window, do one of the following:

• If you have an existing device file that you want to add to, select 
File > Device File, click Open, and select your device file.

• If you are creating a new device file, File > Device File, and click New.

4 Click the Device Manager tab.

5 In the Device List area, click New device, and enter a name for the device 
you are adding.

6 In the Device Properties area, click Device type, and then select the Microplate 
Labeler. 

7 In the Device Properties area, click Profile name, and then select the profile 
you want to use.

8 Select File > Device File > Save.

If you are creating a new device file, you are prompted to enter a name for 
your device file.

Initializing the Microplate Labeler in the BenchWorks software

To initialize the Microplate Labeler in the BenchWorks software:

1 In the BenchWorks window, ensure that the device file is open and the 
Microplate Labeler device icon appears in the Device List area.

2 In the Device List area, click Initialize all devices.

When communication is established, the plate stage of the Microplate Labeler 
homes. If communication is not established, select another profile or open 
Microplate Labeler Diagnostics and modify the profile if necessary. See 
“Creating and managing profiles” on page 77.
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Related topics

For information about... See...

Setup workflow “VWorks or BenchWorks—setup 
workflow for integrated device” on 
page 63

Profiles “Creating and managing profiles” on 
page 77

Designing label formats “Creating label formats” on page 91

Running a labeling protocol BenchWorks Automation Control User 
Guide

Troubleshooting communications 
problems

“Troubleshooting hardware problems” 
on page 167

Reporting problems “Reporting problems” on page 176
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PlateTag—setup workflow for standalone device

About this topic

This topic provides an overview of the procedures required to set up the 
Microplate Labeler after the device has been installed. 

Setup workflow for a standalone device using PlateTag

The following workflow describes the steps for initial setup of the Microplate 
Labeler when it is used as a standalone device. 

After the device setup is completed, you are ready to:

• Design your label formats

• Set up the a print job in PlateTag.

Related topics

Step For this task... See...

1 Establish communications with the 
Microplate Labeler.

“PlateTag software—establishing communications 
with the device” on page 73

2 Manually place a microplate on the plate 
stage.

“Placing a microplate on the plate stage” on 
page 80

3 Perform a print and apply test. “Performing a print- and- apply test” on 
page 146

4 If necessary, adjust the vertical plate 
stage height.

“Setting the plate stage vertical positions” on 
page 84 

5 If you have adjusted the vertical plate 
stage height, perform a print and apply 
test.

“Performing a print- and- apply test” on 
page 146

For information about... See...

Designing label formats “Creating label formats” on page 91

Running a print job “PlateTag—Running a print job” on 
page 113

ActiveX control Microplate Labeler ActiveX User Guide

Setup workflow for an integrated 
device

“VWorks or BenchWorks—setup 
workflow for integrated device” on 
page 63

Starting up the device “Starting up and shutting down” on 
page 60

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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PlateTag software—establishing communications with the device

About this topic

This topic explains how to establish communication with the Microplate 
Labeler by selecting a profile from PlateTag. 

Connecting to the Microplate Labeler

To connect to the Microplate Labeler:

1 Start the PlateTag software.

On the Windows desktop, click the PlateTag shortcut icon, or choose Start > 
Programs or All Programs > Agilent Technologies > Microplate Labeler > PlateTag. 

2 In the Print Job page, under Device Selection, select the profile that 
corresponds to the Microplate Labeler you want to use. 

If this is the first time you are connecting to the Microplate Labeler, select 
one of the profiles (Ethernet or serial) that matches how you have 
connected your Microplate Labeler to the controlling computer.

                                                        

Reporting problems “Reporting problems” on page 176

For information about... See...
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Communications is established when you do one of the following:

• Open Microplate Labeler Diagnostics 

• Start a print job

When communication is established, the plate stage of the Microplate Labeler 
homes. If communication is not established, select another profile or open 
Microplate Labeler Diagnostics and modify the profile, if necessary. See 
“Creating and managing profiles” on page 77.

Related topics

For information about... See...

Setup workflow “PlateTag—setup workflow for 
standalone device” on page 72

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Changing an existing Microplate 
Labeler profile

“Creating and managing profiles” on 
page 77

Designing label formats “Creating label formats” on page 91

Starting a print job “PlateTag—Running a print job” on 
page 113

Troubleshooting communications 
problems

“Troubleshooting hardware problems” 
on page 167
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Opening Microplate Labeler Diagnostics

About this topic

You use Microplate Labeler Diagnostics to set up and troubleshoot the device. 
This topic describes how to open Microplate Labeler Diagnostics from the 
VWorks software, BenchWorks software, and PlateTag software. 

Note: For information on how to access Microplate Labeler Diagnostics using 
the ActiveX control, see the Microplate Labeler ActiveX User Guide.

Figure Microplate Labeler Diagnostics

VWorks procedure

To open Microplate Labeler Diagnostics from the VWorks software:

1 In the VWorks software window, ensure the correct device file is open. 

To open a device file, choose File > Open, and then select the appropriate 
device file (*.dev) in the Open dialog box.

2 In the Devices area of the opened device file tab, highlight the device icon, 
and then click Device diagnostics.

Alternatively, you can double- click the device icon.

The Microplate Labeler Diagnostics window appears.

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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BenchWorks procedure

To open Microplate Labeler Diagnostics from BenchWorks:

1 In the BenchWorks window, ensure the correct device file is open.

2 Click the Device Manager tab.

3 In the Device List area, select the Microplate Labeler. Expand the general 
name of the device, if necessary.

4 At the bottom of the Device List area, click Device diagnostics.

The Microplate Labeler Diagnostics window appears.

PlateTag procedure

To start Microplate Labeler Diagnostics from PlateTag software:

1 In the PlateTag window, choose View > Diagnostics.

The Microplate Labeler Diagnostics window appears.

Related topics

For information about... See...

Establishing communication with 
the device

• “VWorks software—establishing 
communications with the device” on 
page 65

• “BenchWorks—establishing 
communications with the device” on 
page 70

• “PlateTag software—establishing 
communications with the device” on 
page 73

Profiles “Creating and managing profiles” on 
page 77

Designing label formats “Creating label formats” on page 91

Setting up and running a VWorks 
labeling protocol

VWorks Automation Control User 
Guide

Setting up and running a 
BenchWorks labeling protocol

BenchWorks Automation Control User 
Guide

Setting up and running a PlateTag 
print job

“PlateTag—Running a print job” on 
page 113

ActiveX controls Microplate Labeler ActiveX User Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Creating and managing profiles

About this topic

A profile contains the initialization settings associated with a particular device 
that are required for communication. Every Microplate Labeler on a given 
network requires its own profile. You can use the provided Ethernet or serial 
profile for the first Microplate Labeler. However, for each additional Microplate 
Labeler you must create an additional profile. 

This topic describes the following procedures:

• “Creating a profile” on page 78

• “Initializing a profile” on page 78

Before you begin

Ensure that Microplate Labeler Diagnostics is open. If it is not yet open, see 
“Opening Microplate Labeler Diagnostics” on page 75.

Figure Microplate Labeler Diagnostics—Profiles tab 

CAUTION Each profile can be used by multiple protocols. Deleting, renaming, or changing 
the parameters for a profile based on one protocol can invalidate other protocols that use the 
profile.

CAUTION The plate stage teachpoints are associated with a specific device profile. If you 
delete the profile, the teachpoints are also deleted. 
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Creating a profile

To create a profile:

1 In the Profiles tab, do one of the following:

• Click Create a new profile. In the Create Profile dialog box, type the name 
for the new profile, and then click OK.

• Select a profile to use as a template, and then click Create a copy of this 
profile. To rename the copy, click Rename this profile. 

2 Select one of the following communication connections:

a Serial. Select Serial connection, and then select which computer COM 
port to use for the connection. Go to step 4.

b Ethernet. Select Ethernet connection, and then click Select Microplate 
Labeler. Proceed to step 3.

3 Ethernet connection only. In the Discovered BioNet Devices dialog box, do the 
following:

a Click the Select the Ethernet adapter to use from the list below, and select the 
correct adapter for the device connection.

b In the list of devices that appear, select the Microplate Labeler device. 
If multiple Microplate Labeler devices are on the network, use the MAC 
Address to identify the Microplate Labeler device for this profile. 

To successfully communicate with the Microplate Labeler device, the 
Status column must display New or Matched.

c Click OK.

4 In the Printer type list, ensure that the cab option is selected. The G5404B 
Microplate Labeler has a cab thermal printer.

5 If the optional barcode reader is installed, select Verify barcodes after 
PrintAndApply.

6 To save the profile, click Update this profile.

Note: You can use the default values for the remaining profile settings. 
For a description of each parameter, see “Profiles tab” on page 201.

Initializing a profile

If you want to control the device using Microplate Labeler Diagnostics, you 
must initialize the profile. 
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To initialize a profile in Microplate Labeler Diagnostics:

1 In the Profiles tab, select the profile from the Profile name list.

2 Click Initialize this profile.

Related topics

For information about... See...

Setup workflow • “VWorks or BenchWorks—setup 
workflow for integrated device” on 
page 63

• “PlateTag—setup workflow for 
standalone device” on page 72

Microplate Labeler Diagnostics • “Opening Microplate Labeler 
Diagnostics” on page 75

• “Quick reference to Diagnostics 
software” on page 179

Designing label formats “Creating label formats” on page 91

Setting up and running a VWorks 
labeling protocol

VWorks Automation Control User 
Guide

Setting up and running a 
BenchWorks labeling protocol

BenchWorks Automation Control User 
Guide

Setting up and running a PlateTag 
print job

“PlateTag—Running a print job” on 
page 113

Troubleshooting problems “Troubleshooting hardware problems” 
on page 167

Reporting problems “Reporting problems” on page 176
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Placing a microplate on the plate stage

About this topic

This topic explains how to place a microplate on the plate stage manually.

Procedure

To place a microplate on the plate stage:

1 Orient the microplate so that the A1 well is in the far left corner, matching 
the A1 label on the plate stage.

2 Carefully lower the microplate onto the stage, making sure that the 
microplate lies flat.

When the microplate is on the plate stage, the sides of the microplate are 
referred to as north, south, east, and west as the figure shows.

 IMPORTANT If you purchased a standalone Microplate Labeler and 
later decide to integrate the device with a BenchCel Microplate Handler 
or BioCel System, a different type of plate stage may be required. 
Contact Automation Solutions Technical Support for more information.

Related topics

00143
VCode
placing plate

EastWest

South

North

A1 well

A1

A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24
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For information about... See...

Next step in the setup workflow • “VWorks or BenchWorks—setup 
workflow for integrated device” on 
page 63

• “PlateTag—setup workflow for 
standalone device” on page 72
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About plate stage and applicator head positions

About this topic

During operation, both the plate stage and applicator head move to various 
positions. This topic summarizes those positions and gives the background 
information required for the following procedures:

• “Setting the plate stage vertical positions” on page 84

• “Setting the robot pickup angle teachpoint” on page 88

Plate stage teachpoints

The following plate stage positions are called teachpoints: 

• Robot pickup angle. Specifies the position that the plate stage returns to 
when a print- and- apply cycle is completed.

• Apply angle (east). Specifies the teachpoint position to which the plate 
stage rotates so that the east side faces the applicator head.

• Read angle (east). Specifies the teachpoint position to which the plate 
stage rotates so that the east side faces the optional barcode reader. 

Applicator head positions

The applicator head rotates to the printer to pick up a label, and rotates to 
the plate stage to apply a label. If the applicator head is out of alignment with 
either the printer or the plate stage, contact Automation Solutions Technical 
Support.

Positions summary

The following table summarizes the positions of the plate stage and applicator 
head at various points in a print- and- apply cycle.

Selecting labware “Labware considerations” on page 23

Plate stage and applicator head 
positions

“About plate stage and applicator head 
positions” on page 81

For information about... See...
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Related topics

Device Top View Point in Cycle Plate Stage 
Position

Applicator Head 
Position

Start Factory- set home 
position.

Factory- set 
position pointing 
towards the 
printer

During 
microplate 
placing and 
pickup 

At the robot 
pickup angle 
teachpoint.

The default robot 
pickup angle 
value is 0.

Factory- set 
position pointing 
towards the 
printer

As a label is 
applied

At the apply 
angle teachpoint 
(with east side of 
stage towards the 
applicator head) 
and at one of 
two heights 
defined by the 
drop stage value.

The default angle 
value is 349, 
approximately.

Pointing towards 
the plate

As a 
barcode is 
read

At the barcode 
angle teachpoint, 
with the east 
side oriented 
towards the 
optional barcode 
reader mounted 
to the side of the 
printer.

The default angle 
value is 259, 
approximately.

Pointing towards 
the printer
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For information about... See...

The general steps in the labeling 
process

“How the Microplate Labeler applies a 
label” on page 26
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Setup workflow • “VWorks or BenchWorks—setup 
workflow for integrated device” on 
page 63

• “PlateTag—setup workflow for 
standalone device” on page 72

Setting the top and bottom 
positions of the plate stage

“Setting the plate stage vertical 
positions” on page 84

Adjusting the robot pickup angle “Setting the robot pickup angle 
teachpoint” on page 88

Moving the plate stage “Using plate stage controls in 
Diagnostics” on page 149

Applicator head and plate stage “Checking the basic applicator 
functions” on page 144

For information about... See...
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Setting the plate stage vertical positions

About this topic

The Microplate Labeler accommodates a wide range of microplates, including 
deep- well microplates, full- skirt PCR microplates, and tube racks. For details 
on supported labware, see “Labware considerations” on page 23. 

The Microplate Labeler plate stage enables labeling at two vertical positions: 
top and bottom. You can adjust automatically to the top or bottom position to 
accommodate labware with special requirements, such as tall microplate skirts. 
The top and bottom positions are set at the factory for the most commonly 
used microplate sizes. This topic explains how to change the top and bottom 
positions if necessary.

When to change the vertical plate stage position

To accommodate different microplates sizes and skirt heights, you can adjust 
the top and bottom plate stage positions. Different types of microplates can 
have different skirt heights. A label positioned at the optimal height on one 
microplate will be either too high or too low on a microplate that has a 
significantly different skirt height.

Figure Examples of label positions of different sizes of labware

For shallow microplates, you might set the plate stage in the top position. For 
microplates with tall skirts, you might have to drop the plate stage to the 
bottom position. If you are using both types of microplates, you can use a 
different position for each.

You set the plate stage top and bottom positions mechanically. In the software, 
you specify whether the top or bottom position is used to label a specific 
microplate. Before labeling a microplate, the plate stage moves to the vertical 
position specified by the labware definition (VWorks or BenchWorks) or the 
schema (PlateTag).

Plate spacer

The Microplate Labeler is shipped with a plate spacer installed. If you are 
using a microplate that cannot be labeled properly through adjustment of the 
plate stage height, you can remove the plate spacer. When the plate spacer is 
removed, labels can be placed 0.635- cm (0.25- in) higher on the microplate, but 
the adjustment also affects how close to the bottom of the microplate a label 
can be placed. For more information, contact Automation Solutions Technical 
Support.
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Plate stage positions for microplates of the same height

If all of the microplates that use have the same skirt height, you can set the 
top and bottom positions to the same height. This enables you to determine if 
one of the stage height positions has drifted. If any vertical movement occurs 
in the plate stage when you use the drop stage command in Microplate Labeler 
Diagnostics, drift has occurred.

Before you start

• Open Microplate Labeler Diagnostics. For details, see “Opening Microplate 
Labeler Diagnostics” on page 75.

• Locate a 2.5- mm hex wrench.

Procedures

The top and bottom heights of the plate stage are determined by mechanical 
stops that you position by turning the following set screws located near the 
plate stage:

• UP sets the top position.

• DOWN sets the bottom position.

Figure Plate stage adjustment set screws (UP and DOWN)

The procedures for setting the top and bottom positions are given separately.

Setting the top position

To set the top position of the plate stage:

1 Place the microplate that you want to use at the top position on the plate 
stage.

2 In Microplate Labeler Diagnostics, click the Stage Setup tab.

3 Under Teachpoints, locate Apply angle (east side), and click Move here to move 
the plate stage to the apply angle teachpoint.

4 Click the I/O Functions tab, and click Raise stage, if necessary, to move the 
plate stage to the top position.

5 To check the top position: 

a In the I/O Functions tab, click Rotate to stage, and then click Extend head to 
extend the applicator head.

b Examine the alignment between the application head vacuum pads and 
the side of the microplate. 

UP        DOWN
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Your goal is to position the vacuum pads at the desired height of the 
label on the microplate. 

c Click Retract head, and then click Rotate to printer to move the applicator 
head out of the path of the plate stage.

If the height appears to be correct, go to step 8 to home the stage and run 
a print- and- apply test. If the position requires adjustment, go to step 6.

6 Select the Disable stage auto-repositioning check box, and then manually rotate 
the plate stage to gain access to the UP and DOWN set screws.

7 Insert the 2.5-mm hex wrench into the UP set screw. Turn 
counterclockwise to raise the plate stage, or turn clockwise to lower the 
plate stage.

Raise or lower the plate stage based on how much you want the label to 
move from where it has been placed.

8 In the Stage Setup tab, click Home stage.

9 To check the position:

a In Microplate Labeler Diagnostics, click the Testing tab.

b Select Print and apply, and then click Run test. 

10 Examine the vertical alignment of the label on the microplate. 

If necessary, repeat step 5 to step 8 until the adjustment is correct. After 
adjusting the top position, use the following procedure to check the bottom 
position.

Setting the bottom position

To set the bottom position of the plate stage:

1 Place the microplate that you want to use at the lower position on the 
plate stage.

2 In the Stage Setup tab, locate Apply angle (east side), and click Move here to 
move the plate stage to the apply angle teachpoint.

3 Click the I/O Functions tab, and click Drop stage, if necessary, to move the 
plate stage to the bottom position.

4 To check the bottom height position:

a Click Rotate to stage, and then click Extend head to extend the applicator 
head.

00173

UP        DOWN
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b Examine the alignment between the application head vacuum pads and 
the side of the microplate. 

Your goal is to position the vacuum pads at the desired height of the 
label. 

c Click Retract head, and then click Rotate to printer to move the applicator 
head out of the path of the plate stage.

If the position appears to be correct, go to step 7 to run a print- and- apply 
test. If the position requires adjustment, proceed to step 5.

5 Ensure the Disable stage auto-repositioning check box is selected. Manually 
rotate the plate stage to gain access to the UP and DOWN set screws.

6 Insert the 2.5-mm hex wrench into the DOWN set screw. Turn clockwise to 
raise the plate stage, and turn counter- clockwise to lower the plate stage. 

7 In the Stage Setup tab, click Home stage.

8 To check the position:

a In Microplate Labeler Diagnostics, click the Testing tab.

b Select Print and apply, and then click Run test. 

9 Examine the vertical alignment of the label on the microplate. 

If necessary, repeat step 4 to step 8 until the adjustment is correct.

10 Ensure that the Disable stage auto-repositioning check box is clear (not 
selected).

About automatically adjusting the stage height during a run
The procedure for setting the plate stage height parameter varies depending on 
which software you use to control the Microplate Labeler:

Automation control software See…

VWorks software. In the labware definition of 
a microplate that uses the plate stage bottom 
position, select the option to lower the plate at 
the Microplate Labeler. This parameter is in 
the Labware Editor—Plate Properties tab.

VWorks Automation 
Control Setup Guide

BenchWorks software. In the labware 
definition of a microplate that uses the plate 
stage bottom position, select the option to 
lower the plate at the Microplate Labeler 
(VCode). This parameter is in the Labware 
Editor—Plate Properties tab.

BenchWorks Automation 
Control User Guide

PlateTag. Specify Stage DOWN (bottom 
position) or Stage UP (top position) when 
configuring a print schema.

“PlateTag print jobs and 
schemas” on page 116

ActiveX. When setting up a print schema, set 
the dropStage parameter to TRUE (bottom 
position) or FALSE (top position).

Microplate Labeler ActiveX 
User Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Related topics

Setting the robot pickup angle teachpoint

About this topic

The robot pickup angle is the position that the plate stage returns to after a 
print- and- apply cycle is completed. The teachpoint for the robot pickup angle 
is set at the factory. 

If your Microplate Labeler is: 

• A standalone device, this teachpoint should not require adjustment. 

• Integrated in a BioCel System or BenchCel Microplate Handler, this 
teachpoint is already set for you. 

• Integrated in a third- party lab automation system, this teachpoint might 
require adjustment to accommodate your robot’s geometry.

This topic explains how to adjust the robot pickup angle and set the 
teachpoint so that a robot can deliver or pick up a microplate from the plate 
stage.

Viewing the robot pickup angle

The Stage Setup tab in Microplate Labeler Diagnostics displays the teachpoint 
settings.

For information about... See...

Starting Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Setup workflow • “VWorks or BenchWorks—setup 
workflow for integrated device” on 
page 63

• “PlateTag—setup workflow for 
standalone device” on page 72

Moving the plate stage “Using plate stage controls in 
Diagnostics” on page 149

How to resolve problems “Reporting problems” on page 176

CAUTION The Apply angle (east) and Read angle (east) teachpoints are set at the factory. 
Do not attempt to set these teachpoints. If you think either of these two teachpoints require 
adjustment, contact Automation Solutions Technical Support. 
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To view the robot pickup angle:

1 Ensure that the Microplate Labeler device is initialized:

• For the VWorks software, see “Initializing the Microplate Labeler in the 
VWorks software” on page 68.

• For the BenchWorks software, see “Initializing the Microplate Labeler in 
the BenchWorks software” on page 70.

• For the PlateTag software, see “Connecting to the Microplate Labeler” 
on page 73.

2 Open Microplate Labeler Diagnostics.

3 Click the Stage Setup tab.

4 Under Teachpoints, check the value for the Robot pickup angle.

Two methods for setting the robot pickup angle

You can use either of the following procedures for setting the robot pickup 
angle:

• Specify an angle in the Angle value box or the Angle increment box.

• Manually move the plate stage to a position and then set its position as the 
teachpoint.

Specifying a new angle

To set the robot pickup angle by specifying the angle:

1 Ensure the device is initialized, and Microplate Labeler Diagnostics is open.

2 Ensure that the applicator head is pointing towards the printer. 

If necessary, click the I/O Functions tab, and then click Rotate to printer. The 
applicator head rotates towards the printer, moving it out of the plate 
stage rotation path.
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3 Under Stage Controls, type a value in the Angle value box, and then click Move 
to.

Alternatively, type a value in the Angle increment box, and then click Rotate 
CCW or Rotate CW. 

4 If the position is correct, under Teachpoints, locate Robot pickup angle, and 
then click Teach.

5 In the Profiles tab, click Update this profile.

Manually moving the plate stage

To set the robot pickup angle by manually moving the plate stage:

1 Ensure the device is initialized, and Microplate Labeler Diagnostics is open.

2 Ensure that the applicator head is pointing towards the printer. 

If necessary, click the I/O Functions tab, and then click Rotate to printer. The 
applicator head rotates towards the printer, moving it out of the plate 
stage rotation path.

3 Click the Stage Setup tab, and select Disable stage auto-repositioning.

4 Manually rotate the plate stage to the desired position.

5 Under Teachpoints, locate Robot pickup angle, and then click Teach.

6 Clear the Disable stage auto-repositioning check box.

7 In the Profiles tab, click Update this profile.

Related topics

CAUTION Before moving the plate stage, make sure that the applicator head is not in 
the path of the plate stage.

For information about... See...

Microplate Labeler Diagnostics • “Opening Microplate Labeler 
Diagnostics” on page 75

• “Quick reference to Diagnostics 
software” on page 179

Plate stage positions “About plate stage and applicator head 
positions” on page 81

Designing label formats “Creating label formats” on page 91

Setting up and running a labeling 
protocol

• VWorks Automation Control User 
Guide

• BenchWorks Automation Control 
User Guide

Setting up and running a PlateTag 
print job 

“PlateTag—Running a print job” on 
page 113
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5
Creating label formats

The G5404B Microplate Labeler includes templates for label formats 
that are ready to use or that you can customize. For an overview 
of the templates, see “Label format templates” on page 190. This 
chapter describes the label formats and how to create them and 
customize the templates.

The topics are:

• “About label formats and content” on page 92

• “Creating and editing label formats” on page 94

• “Changing the field size and other attributes” on page 102

• “Removing unwanted label format data” on page 107

• “Barcodes and supported symbologies” on page 108
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About label formats and content

About this topic

This topic provides an overview of the Microplate Labeler label formats and 
label content.

Introduction to label formats and content

To create a label, the software requires the following:

• Label format. The number and arrangement of fields on a label, and the 
field type, size, and other attributes. 

Each label printed by the Microplate Labeler contains up to six fields of 
data. Only one field can be a barcode field. The remaining fields can be 
human- readable text.

• Label content. The data that the software substitutes for the text and 
barcode fields in the label format when the label is printed.

The following figure shows an example of a label with two fields: one barcode 
field and one human- readable text field. 

Figure Example label with Code 128 barcode field and human-readable text field

IMPORTANT To ensure that the barcode reader can read a barcode, the label 
should include a blank margin (quiet zone) on each end of the barcode field. 
In general, the quiet zone should be 10 times the width of the narrowest bar in 
the barcode or 0.635 cm (0.25 inch), whichever is greater.

When you run a labeling protocol (VWorks or BenchWorks software) or a print 
job (PlateTag software), the label format loads from the printer's memory. The 
software substitutes the data (label content) for the text and barcode fields in 
the label format, and then prints the label.

About label formats

The Microplate Labeler contains a set of template label formats that are ready 
to use or that you can customize for your lab. For an overview of the 
templates, see “Label format templates” on page 190. You use the Label Editor 
tab in Microplate Labeler Diagnostics to create and edit label formats, and to 
upload the label formats to the printer.

Label format fields and label field data
A label format is the label design definition, which can consist of up to six 
label fields. Associated with every label field is a set of label field data that 
defines the following:

Blank margins (quiet zones)

5.08 cm (2 in)

0.635 cm (0.25 in)
Barcode

Human 
readable
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• Field type: human- readable text or barcode 

• Font family used for printing the human- readable text fields

• Barcode symbology used for text encoding if it is a barcode field

• Position of the field on the label

• Attributes of the field such as field size 

• Contents of the field for a test print from the Label Editor tab

Label format storage and uploading
Label formats must be stored in the printer so that they are available for use. 
The printer can store up to 20 label formats. 

Label formats can also be saved in XML files. Before you can use a format that 
is stored in an XML file, you must first upload the label format to the printer.

To modify a label format, you load the format into the Microplate Labeler 
Diagnostics—Label Editor tab. 

About specifying the label content

When configuring a VWorks or BenchWorks labeling protocol or a PlateTag 
print job, you select a predefined label format that has been loaded in the 
printer, and then specify the content for the fields that have been configured 
in that particular label format. The method for specifying the label content 
varies depends on which automation control software you use.

Software that controls the device See...

VWorks software. You create a protocol that 
contains a Print and Apply task. You select the 
label format and field content when setting the 
task parameters.

Note: You set the plate stage height in the 
labware definition. You specify which sides of 
the microplate to label in the plate process 
parameters.

VWorks Automation 
Control User Guide 

BenchWorks software. You create a protocol 
that contains an Apply Label task. You select 
the label format and field content when setting 
the task parameters.

Note: You set the plate stage height in the 
labware definition. You specify which sides of 
the microplate to label in the plate process 
parameters.

BenchWorks Automation 
Control User Guide 

PlateTag software. You configure a PlateTag 
schema that specifies the label format, the label 
content, and the plate stage height.

You create a print job that specifies which side 
of the microplate to label and the schema to 
use for each side. You can use the same schema 
for multiple sides of a microplate, or designate 
a different schema for each side. 

“PlateTag print jobs and 
schemas” on page 116
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Related topics

Creating and editing label formats

About this topic

The Microplate Labeler contains a set of template label formats that are ready 
to use or that you can modify. For an overview of the templates, see “Label 
format templates” on page 190.

This topic describes how to load a label format and then customize it to meet 
the requirements of your lab. 

For a description of label formats and content, see “About label formats and 
content” on page 92.

Before you start

The following workflow assumes that:

• Microplate Labeler Diagnostics is open. For details, see “Opening Microplate 
Labeler Diagnostics” on page 75.

• The profile for your device is initialized. For details, see “Initializing a 
profile” on page 78.

ActiveX control. For a device integrated in a 
third- party lab automation system, you can use 
the ActiveX controls to define the label format 
and content.

Microplate Labeler 
ActiveX User Guide

For information about... See...

Workflow for running an 
integrated Microplate Labeler 
using the VWorks or BenchWorks 
software

“Integrated Microplate Labeler—
operation workflow” on page 27

Workflow for running a standalone 
Microplate Labeler using PlateTag

“Standalone Microplate Labeler—
operation workflow” on page 29

Barcode terminology and 
symbology

“Barcodes and supported symbologies” 
on page 108

Customizing a label format 
template

“Creating and editing label formats” on 
page 94

CAUTION Changes that you make to a label format are kept in memory only. To avoid 
losing changes to a label format, you must upload the revised format to the printer or save the 
changes to an XML file before selecting a different label format or closing Microplate Labeler 
Diagnostics.

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Workflow for creating or editing a label format

Loading a label format in the Label Editor

You can load the label format from the printer or from an XML file on the 
computer.

Note: The G5404B Microplate Labeler supports label formats developed for the 
cab A2+ printer only.

To load a label format from the printer:

1 In Microplate Labeler Diagnostics, click the Label Editor tab.

2 In the Current format list, select a format, and then click Load from printer. 

Step For this task... See...

1 Load a label format that you 
want to customize.

“Loading a label format in the 
Label Editor” on page 95

2 If desired, add additional 
fields to the label format by 
right- clicking the Label Editor 
preview box.

“Adding a field to a label format” 
on page 97

3 Edit the properties of a field. • “Editing the field properties” 
on page 97

• “Changing the field size and 
other attributes” on page 102

4 Repeat steps 2 and 3 for the 
other fields in the label.

5 Upload the edited label format 
to the printer.

Before a label format is 
available for printing, the 
format must be uploaded to 
the printer.

Optionally, save a backup copy 
to an XML file.

“Uploading and saving a format” on 
page 101.

6 Print a test label to check your 
changes.

“Printing a test label from the 
Label Editor tab” on page 102
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If the selected format has not been defined, the Label Field Data table and 
the Label Editor preview box are blank. Otherwise, data appear in the 
table, and a representation of the format appears in the Label Editor 
preview box. 

Alternatively, you can load a label format from an XML file on the computer. 

To load a label format from an XML file:

1 In the Label Editor tab, click Load format from disk.

2 In the Open dialog box, navigate to the file storage location, select the XML 
file, and then click Open. 

By default, the label format templates are installed in the following folder:

C:\VWorks Workspace\Microplate Labeler Label Formats

Renaming a label format

IMPORTANT If you are using PlateTag, you must use the format number in 
the schema for a print job.

To rename a label format:

1 In the Current format list, select the desired format and then click Rename 
format.

2 In the dialog box that appears, type the format name, and then click OK. 
The new name appears in the Current format list.
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Adding a field to a label format

You can add up to six fields in the label. Only one field can be a barcode. The 
remaining fields can be human- readable text.

To add a field to a label format:

1 Ensure that the format you want to edit is loaded.

2 Right- click in the Label Editor preview box, and then choose one of the 
following from the shortcut menu:

• Insert text. Available for any field.

• Insert barcode. Available for field 2 only. 

Note: If you want the label to contain a barcode only, you can add a 
text field, add a barcode field, and then delete the text field.

The default data fills a row in the Label Field Data, and a corresponding 
field appears in the preview box.

Editing the field properties

This section describes how to change the following field properties:

• Alias

• Value

• Format

• Position (x, y coordinates)

To change the field size and other attributes, see “Changing the field size and 
other attributes” on page 102.

To clear or remove data from the format, see “Removing unwanted label format 
data” on page 107.

For a quick reference to each column in the Label Field Data table, see “Label 
Editor tab” on page 184.

Assigning an alias to a field in the format

To assign an alias to a field in the label:

1 In the Label Field Data table, select the desired field (Index 1 to 6), and then 
click Rename field.

2 In the dialog box that appears, type a name, and click OK. The name 
appears in the Field Alias column for the selected field.
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Changing the value

The value property that you specify in the Label Editor tab is used only when 
performing a test print from the Label Editor tab. When you run a labeling 
protocol (VWorks or BenchWorks software) or a batch print job (PlateTag 
software), the value of each field comes from the data source that you select in 
the VWorks, BenchWorks, or PlateTag software.

A field’s value parameter determines:

• Human- readable field. The actual text that is printed during a test print.

• Barcode field. The actual data that is encoded into the barcode for a test 
print. The barcode text should follow the rules of the specified symbology, 
for example, limited to numbers only or uppercase letters and numbers.

To change the value:

1 In the Field Data Table, click the entry in the Value column for the field that 
you want to edit. The row is highlighted. 

2 Click the value once more to enable editing, and then type a new value 
that is about the same length as the text for the production labeling.
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 IMPORTANT Ensure that the characters you enter for a barcode field 
are supported by the selected format (symbology).

Note: The Label Editor preview provides an approximate representation 
of the label layout. To view the actual field sizes and positions on the 
label, print a test label. 

Changing the format

A field format determines the printed appearance of a field. For example, the 
font selection for a text field or the symbology selection for a barcode field.

To change the format of a field:

1 In the Label Field Data table, click the name in the Format column for the 
field that you want to edit. The row is highlighted.

2 Click the format name once more to display the list, and then select the 
desired text font or barcode symbology. 

The list changes based on the field type (text or barcode).

 IMPORTANT For barcode fields, make sure that the symbology you 
choose supports all of the characters in your field’s data. Also, if you are 
using a barcode reader, make sure that symbology you choose can be read 
by your barcode readers. For a description of the available symbologies for 
the Microplate Labeler, see “Barcodes and supported symbologies” on 
page 108.

Note: The G5404B Microplate Labeler supports label formats developed 
for the cab A2+ printer only. 

Positioning the fields on the label 

The Label Editor tab provides two methods for positioning the field on the 
label:

• Label Editor preview box. You can drag each field to an approximate 
position in the preview box. However, the preview is not precise, and you 
must test print the label to see the actual field sizes and positions, and 
then adjust as necessary. 
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Figure Example of format in the preview box and actual printed label

• X and Y columns. The X and Y values in the Label Field Data table 
correspond to the printer’s x-  and y- coordinates for the label, where the 
origin is at the top left corner of the label.

– x- coordinate. The horizontal start position, the distance between the 
label’s left edge and the field’s left edge.

– y- coordinate. The vertical start position, the distance between the 
label’s top edge and the text field (bottom left corner) or barcode field 
(upper left corner).

To position the field’s starting point using the X and Y values, you calculate 
the position based on the following:

• Label size: 0.25 by 2.0 in (0.0635 by 5.08 cm)

• X and Y unit of measure: 0.001 in (0.0254 mm)

Given the label size, the value ranges are Y: 0 to 250, and X: 0 to 2000.

For example, suppose you want to create a label similar to the one in the 
following figure. In this example, the upper edge of the barcode field is flush 
with the label’s top edge, the barcode field has a blank margin (quiet zone) on 
each end to allow readability, and a text field is aligned on the left under the 
barcode field. The following table provides the X and Y values for the label in 
the figure.
                                                        

Label Editor preview box

Printed label



101

5   Creating label formats
Creating and editing label formats

G5404B Microplate Labeler User Guide

Figure Example barcode and text field positions on label

To use the X and Y columns to position a field:

1 In the Label Field Data table, click the value in the X column for the field that 
you want to edit. Click the value again to enable editing, and type the new 
value.

2 Click the value in the Y column for the field that you want to edit. Click 
the value again to enable editing, and type the new value.

In addition to the field’s x, y coordinates, the field size attributes affect the 
field’s placement on the label. Initially, you can use the default values in the 
Attributes column. You can upload the label format to the printer, print a test 
label, and then evaluate whether to adjust the size or placements of the fields.

Uploading and saving a format

After you have created or edited a label format, you must upload it to the 
printer before it can be used. You might also want to save it in an XML file on 
the computer, especially as label formats can be accidently overwritten. 

To upload a format to the printer:

1 In the Label Editor tab, click Upload format to printer.

To save a format to an XML file:

1 In the Label Editor tab, click Save format to disk.

2 In the Save As dialog box, specify the XML file name and the file storage 
location, and click Save.

Note: The software saves one label format per XML file.

Blank margins (quiet zones)

5.08 cm (2 in)

0.635 cm (0.25 in)
Barcode

Human 
readable

Field type X, Y values Position on label

Barcode X = 150 The field left edge is 0.150 in (0.38 cm) from the label 
left edge.

Y = 0 The field top edge is 0.0 in from the label top edge.

Text X = 150 The field left edge is 0.150 in (0.38 cm) from the label 
left edge.

Y = 230 The field bottom edge is 0.230 in (0.58 cm) from the 
label top edge.
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Printing a test label from the Label Editor tab

After you upload a label format to the printer, you can check your changes by 
printing a test label.

To print a test label:

1 In the Label Editor tab, click Print test label, or press the green button on the 
device.

Alternatively, you can perform test print- and- apply cycles using the Testing 
tab. See “Performing a print- and- apply test” on page 146.

Related topics

Changing the field size and other attributes

About this topic

When designing a label format, you can change the size of the fields to make 
the label more readable or to fit more information on the label. This topic 
describes how to alter the size of a printed text or barcode field.

Before you start

If you have not already done so, already:

• Load the label format that you want to modify. See “Loading a label format 
in the Label Editor” on page 95.

• Make sure you understand how the fields are positioned on the label. See 
“Positioning the fields on the label” on page 99.

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Label format and label content “About label formats and content” on 
page 92

Performing a print and apply test “Performing a print- and- apply test” on 
page 146

Performing a test barcode read Documentation for your barcode reader

Setting the parameters for the 
label content

• VWorks Automation Control User 
Guide

• BenchWorks Automation Control 
User Guide

• “PlateTag print jobs and schemas” 
on page 116
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• Consider the label size when planning the format: 0.0635 by 5.08 cm 
(0.25 by 2.0 in)

 IMPORTANT If you increase the field size too much, the printed field 
may not fit on the label. If you decrease the field size too much, the 
printed field may not be readable. For example, barcode symbology that 
is too small may appear as a thin line of dots and dashes. 

Changing the size attributes of a text field

To change the size attributes of a text field:

1 In the Label Field Data table, click the entry in the Attributes column for the 
field that you want to edit. The row is highlighted.

2 Click the attribute entry once more. The Edit Values dialog box opens.

3 In the Edit Values dialog box, type the values for the relevant parameters in 
the Sizing area, and then click OK. 

The available parameters change depending on the format selection.
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Note: The Label Editor preview box does not reflect the size change. To 
see the effect, print a test label.

4 To check your changes, see “Checking the attribute changes” on page 106.

Changing the attributes of a barcode field

To change the attributes of a barcode field:

1 In the Label Field Data table, click the entry in the Attributes column for the 
field that you want to edit. The row is highlighted.

2 Click the attribute entry once more. The Edit Values dialog box opens.

Font type Parameter and description

Bitmap fonts: 
12x12, 16x16, 
16x32, OCR- A, 
OCR- B

• Horizontal magnification. Specifies the x- axis 
magnification of the text block.

• Vertical magnification. Specifies the y- axis 
magnification of the text block.

Range: 1–10

The magnification factors are multipliers, for 
example, a value of 2 is twice as big as 1.

The different bitmap fonts are different sizes at a 
magnification of 1. Therefore, the reasonable range of 
magnification values varies for each of the bitmap 
fonts. 

Vector fonts: 
Droid Mono, 
Droid Mono Bold, 
Swiss721, 
Swiss721Bold, 
Monospaced

• Point size. Specifies the height of the font in 
0.01 in (0.0254 mm). For example, a 6- point font 
will be 0.06- in (0.15 cm) tall. The width is scaled 
to match.

• Horizontal scaling (%). Allows you to make the 
font narrower or wider without changing the font 
height.
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3 In the Edit Values dialog box, type or select the values for the relevant 
parameters, and then click OK.

 IMPORTANT Make sure the barcode size allows for sufficient blank 
margins (quiet zones) on each end of the barcode to ensure readability 
by a barcode reader.

Parameter Description

Sizing Use the sizing parameters to change the barcode size. 

• Height Specifies the height of each bar in 0.001 in 
(0.0254 mm). The overall barcode width is scaled 
relative to this value. 

For example, if Height = 150, the barcode is 0.150- in 
(0.38- cm) tall.

• Narrow bar 
width

Defines the width of the narrowest bar in the barcode 
in 0.001 in (0.0254 mm). The overall barcode width is 
scaled relative to this value.

• Bar width 
ratio

Defines the ratio between the narrow and wide bars 
in the barcode. For example, a ratio of 3 means that 
the wide bar is three times the width of the narrow 
bar.

• Row height Defines the height of a single row in a 2D symbology.

• Symbol 
aspect ratio

Defines the ratio between the height and width of the 
barcode. 

• Dot size Data Matrix only. Defines the size of the dot in the 
2D code. The overall height and width of the barcode 
are scaled to this value.
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4 Click Upload format to printer, and then check your changes using the 
following procedure.

IMPORTANT Verify that your barcode reader can read the barcode in the 
label format before doing a production run.

Checking the attribute changes

To check the attribute changes:

1 In the Label Editor tab, click Print test label, or press the green button on the 
device.

If after increasing the size of the field, the field does not print, check 
where the field is positioned on the label. The field may now be positioned 
off the edge of the label.

 IMPORTANT The printer does not always scale barcodes and fonts 
consistently. If you change a text field’s magnification, always perform a 
test print to make sure that you can still read the text. If you change a 
barcode field’s magnification, perform a test read of the barcode using a 
barcode reader.

Saving the changes

You must upload the changed format to the printer before the revised or new 
label format is available for printing.

To upload the format changes to the printer:

1 In the Label Editor tab, click Upload format to printer. 

To save the format changes to an XML file:

1 In the Label Editor tab, click Save format to disk. 

2 In the Save As dialog box, specify the file name and the file storage 
location, and click Save.

                                                        

• Columns Micro PDF417 only. Defines how many columns are 
used (1- 4) to display the data. 

The column number combined with the narrow bar 
width sets the width of the symbol. The printer adds 
more rows of data (height to the symbol) as more 
characters are added.

Error level PDF417 only. Defines an error level.

Parameter Description
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Related topics

Removing unwanted label format data

About this topic

This topic describes how to delete one or more fields from a label format or 
clear the label format entirely.

Before you start

If you have not already done so, complete the following steps:

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Label format vs. content “About label formats and content” on 
page 92

Designing label formats “Creating and editing label formats” on 
page 94

Performing a test print and apply 
operation

“Performing a print- and- apply test” on 
page 146

Performing a test barcode read Documentation for your barcode reader

Setting the parameters for the 
label content

• VWorks Automation Control User 
Guide

• BenchWorks Automation Control 
User Guide

• “PlateTag print jobs and schemas” 
on page 116

Step Task See…

1 Open Microplate Labeler 
Diagnostics.

“Opening Microplate Labeler 
Diagnostics” on page 75

2 Ensure the profile for your 
device is initialized.

“Initializing a profile” on page 78

3 In the Label Editor tab, load the 
label format that you want to 
modify.

“Loading a label format in the 
Label Editor” on page 95
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Deleting a field

To delete a field:

1 In the Label Editor tab, right- click the field in the Label Editor preview box.

2 In the shortcut menu that appears, choose Delete field.

Clearing a label

To clear a label of its contents:

1 In the Label Editor tab, right- click in the Label Editor preview box.

2 In the shortcut menu that appears, choose Clear label.

All of the data in the Label Editor tab disappears.

Related topics

Barcodes and supported symbologies

About this topic

This topic presents basic barcode concepts and provides examples of the 
supported symbologies.

Symbologies

Barcode symbologies define the mapping between a barcode and the text that 
it represents. There are more than 50 barcode symbologies. Barcode 
symbologies that are typically used in labs are those that create compact 
barcodes, such as Code 128, Code 39, and Interleaved 2 of 5. The Microplate 
Labeler also supports printing of 2D barcode symbologies. For examples of the 
symbologies that are supported by the Microplate Labeler printer, see 
“Supported barcode symbologies” on page 110.

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Designing label formats “Creating and editing label formats” on 
page 94

HelloSymbology
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Encoding and decoding

The printer includes encoding software that converts the text that you provide 
in a field into a barcode pattern.

If your Microplate Labeler has a barcode reader, the decoder software in the 
reader converts the pattern of a barcode back into text.

Encoding examples

The following example shows how a label will print when the word Test is 
represented in two types of fields:

• Field 1 as human- readable text 

• Field 2 as a barcode that uses the Code 128 symbology 

The next example uses the same symbology, but the words Test label are used 
for both fields. Notice that the barcode is longer because the amount of text 
encoded is greater.

In the following example, the words Test label are printed as a text field and 
as a barcode field using the Code 39 symbology. If you compare this with the 
previous example, you can see that the different symbology makes a different 
barcode pattern.

The two- dimensional (2D) barcodes can contain more information than 
conventional linear barcodes because they encode data in both horizontal and 
vertical directions. 

Decode

Encode

HelloSymbology

2

1
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Supported barcode symbologies

The following table provides a summary of the symbologies supported on the 
Microplate Labeler. You can find complete descriptions of the symbologies on 
the web at various sites, for example, www.wikipedia.org.

Symbology name Summary description

Code 128 Variable- length, high- density, symbology that can 
encode all 128 ASCII characters. Has 106 different 
bar and space patterns and each pattern can have 
one of three different meanings, depending on 
which of three different character sets is 
employed.

Codabar Variable- length, can encode the characters: 
0123456789- $:/.+ABCD

Code 39 Full ASCII Variable- length symbology that can encode the 
complete 128 ASCII character set. 

Code 93 Variable- length symbology that can encode the 
complete 128 ASCII character set. 

HIBC Variable- length, modified version of Code 39.

Health industry barcode (HIBC)

Interleaved 2 of 5 High- density variable- length, numeric- only (0–9) 
symbology that encodes numbers in pairs in an 
interleaved manner. 

PDF417 High- density 2D symbology that essentially 
consists of a stacked set of smaller barcodes.

MicroPDF417 A 2D multi- row symbology based on PDF417, 
designed for applications requiring a greater area 
efficiency but lower data capacity than PDF417.

Data Matrix High- density 2D matrix- style symbology that can 
encode up to 3116 characters from the entire 256-
byte ASCII character set.
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Related topics

For information about... See...

Customizing a label format 
template

“Creating and editing label formats” on 
page 94

Label format and content “About label formats and content” on 
page 92

Setting up a VWorks labeling 
protocol

VWorks Automation Control User 
Guide, Print and Apply Task topic

Setting up a BenchWorks labeling 
protocol

BenchWorks Automation Control User 
Guide, Apply Label task topics

Setting up a PlateTag print job “PlateTag—Running a print job” on 
page 113
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6
PlateTag—Running a print job

This chapter explains how to use the PlateTag software to set up a 
print job and label a batch of microplates. If you have a standalone 
Microplate Labeler, you use the PlateTag software to run a print 
job.

When running a PlateTag batch print job you manually place each 
microplate on the plate stage for labeling. 

This chapter contains the following topics:

• “PlateTag print job workflow” on page 114

• “PlateTag—setting file locations” on page 115

• “PlateTag print jobs and schemas” on page 116

• “PlateTag—using data sources” on page 119

• “PlateTag—setting parameters for the label content” on page 122

• “PlateTag—creating a schema” on page 126

• “PlateTag—configuring a schema” on page 128

• “PlateTag—creating a new label format constant” on page 132

• “PlateTag—creating a print job” on page 134

• “PlateTag—test printing in sticky mode” on page 136

• “PlateTag—starting a print job” on page 137

• “PlateTag—labeling microplates with identical labels” on 
page 139

If you are preparing to run a labeling protocol using the VWorks 
software or BenchWorks software, refer to the VWorks Automation 
Control User Guide or the BenchWorks Automation Control User 
Guide. 

If you are preparing to run a labeling protocol using a third- party 
system, see “Microplate Labeler ActiveX control” on page 1.
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PlateTag print job workflow

About this topic

This topic describes the steps to follow when performing a batch print- and-
apply job using the PlateTag software. 

If you are using VWorks software or BenchWorks software to run the 
Microplate Labeler, see the VWorks Automation Control User Guide or the 
BenchWorks Automation Control User Guide for details on how to run a 
labeling protocol.

Workflow

Related topics

Step For this task... See...

1 Set the parameters for the 
label content.

• “PlateTag—using data sources” 
on page 119

• “PlateTag—setting parameters 
for the label content” on 
page 122

2 Create and configure a 
schema.

• “PlateTag—creating a schema” 
on page 126

• “PlateTag—configuring a 
schema” on page 128

3 Define and save a print job. “PlateTag—creating a print job” on 
page 134

4 Optional. Test print the 
schema using “sticky mode”.

“PlateTag—test printing in sticky 
mode” on page 136

5 Start the print job. “PlateTag—starting a print job” on 
page 137

For information about... See...

Installing the Microplate Labeler “Installation workflow” on page 32

Installing PlateTag software “Installing the automation control 
software” on page 48

Labels and formats “About label formats and content” on 
page 92

Print jobs and schemas “PlateTag print jobs and schemas” on 
page 116

Creating a print job “PlateTag—creating a print job” on 
page 134
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PlateTag—setting file locations

About this topic

PlateTag saves print job information such as schemas, constants, and counters 
in XML and text files. The default storage location for these files is in the 
Microplate Labeler installation folder. If you want to store the information on a 
networked file server or other storage disk, you can change the location. This 
topic describes how to change the location of stored files in PlateTag.

Note: Automation Solutions Technical Support may ask you to send one or 
more of these files when helping you to troubleshoot a problem.

Procedure

For each information type (schemas, constants, counters, barcode clones, and 
barcode log), PlateTag creates one XML or text file. Even if you define three 
schemas, all the information will be saved in one schema XML file.

To set the location of a stored file:

1 In the PlateTag window, choose Edit > Preferences.

The PlateTag Preferences dialog box opens.

2 Next to the box of the desired file type, click .

3 In the Open dialog box, select destination folder, and click Open.

4 Click OK.
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Related topics

PlateTag print jobs and schemas

About this topic

This topic describes the print jobs and schemas used in the PlateTag software. 

For details on performing labeling protocols using the VWorks software or 
BenchWorks software, see the VWorks Automation Control User Guide or the 
BenchWorks Automation Control User Guide.

Schemas

When you use PlateTag to print and apply labels, you can define a different 
label for each side of a microplate. 

In PlateTag, a schema is used to define how one side of a microplate is 
labeled. You can use the same schema for all sides of a microplate, or 
designate a different schema for each side. 

A schema includes the following:

• The label format to use

• A definition of the data to be printed for each field in the label

• The plate stage height during the labeling operation (drop stage attribute)

Each schema is given its own name. You use the Schemas tab in PlateTag to 
create and update schemas.

Print jobs

Setting up a PlateTag print job allows you to apply labels that are:

• Different from microplate to microplate

• Different from one side of a microplate to another

For information about... See...

Schemas “PlateTag print jobs and schemas” on 
page 116

PlateTag batch labeling workflow “PlateTag print job workflow” on 
page 114

Constants, counters, and barcode 
clones

“PlateTag—setting parameters for the 
label content” on page 122

Data sources “PlateTag—using data sources” on 
page 119

How to report problems “Reporting problems” on page 176
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A print job uses one schema for each side of the microplate that you want to 
label. You use the Print Job tab in PlateTag to set up and start print jobs.

Field definitions

In a schema, the general definition of each label field includes:

• The data type for the field

• The name of a variable that holds the actual data that goes into the field

Data type
A field’s data type is one of the following:

Variable names
A schema does not contain the actual data that is printed on a label. A 
schema contains the name of a variable that holds the actual data.

For example, to use a data type of Counters, the counter first has to be 
created and given a name. The counter’s name (variable name) is then 
referenced by the schema. 

Summary diagram and description

Information flow
The following figure summarizes these concepts and shows the flow of 
information from variables to schemas, to a print job and finally to barcode 
labels.

Data type Description

Data Source An external file from which PlateTag can import field 
data

Constants A constant, the value of which remains the same for 
each label

Counters A counter, the value of which changes in a regular way 
with each label

Clones A barcode copied from another side of the microplate

Note: An installed barcode reader is required in order 
to clone a barcode. Text fields cannot be cloned.
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Description
The figure shows how you can use a different schema for different sides of the 
plate. The Print Job box shows that labels printed on the north and east sides 
of the microplate are determined by Schema one, and that labels printed on 
the south side of the microplate are determined by Schema two.

For Schema two, the figure shows how the content is determined for fields 1 
and 3 on the south side of the microplate. In the Schema two box:

• Field 1 has the variable name My Counter. The variable My Counter is 
defined as:

– Starting at 0001 (Initial counter value)

– Incremented by one each time it is incremented (Increment)

– Prefixed by the word test (Prefix)

– Incremented each microplate (Interval)

– Incremented with the alphanumeric series 1–Z (Base)

The resulting barcode labels will read test0001, test0002, test0003, and so 
on.

• Field 3 is a constant that has the variable name Date. The value of the 
constant is Sept.09. 

• The label format attribute is specified by a constant as label format 4. You 
can examine the label format in the Label Editor tab of Microplate Labeler 
Diagnostics to see which fields are text fields and which field is a barcode 
field. 

• The Drop stage attribute is specified by a constant as Stage UP. The plate 
stage will be at the top position when these labels are applied.

Note: The plate stage position should be the same for all schemas in a print 
job because the position is dependent on the height of the microplate, which is 
the same for all sides.

Schema one

A

B

C

D

E

F

G

H

1 2 3 4 5 6 7 8 9 10 11 12

Print Job

N

E

S

W

Schema one

Schema one

Schema two

Print job defines:
• Compiles schemas
• Initiates print job

Schema defines:
• Barcode field contents
• Label format
• Vertical stage position

field 1  Data source Column1
field 2  Data source Column1
field 3  Data source - blank -
field 4  Data source - blank -
field 5  Data source  - blank -      
field 6  Data source - blank -
Label format Data source Column2
Drop stage  Data source Column3

Schema two

field 1  Counters My counter
field 2  Counters Another counter
field 3  Constants Date
field 4  Constants 
field 5      Constants
field 6  Constants
Label format Constants Label format 4
Drop stage  Constants Stage UP

Attribute          Data type Variable name

Attribute          Data type       Variable name

MyCounter

0001                  36         test         1                  1  

Initial counter value     Base     Prefix     Increment     Interval 

Date

      Sept.09 

Constant value 
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Label format and schema fields

It is important to understand the relationship between label format fields and 
schema fields. For a field to be printed on a label, it must be defined in both 
the schema and the label format.

Suppose, for example, that in a schema you have specified label format 4 and 
defined fields 1, 2, 3 and 4. If label format 4 has fields 1, 2, 3 and 4 defined 
in it, all four fields will print on the label. However, if label format 4 only 
defines fields 1, 2 and 3, only these first three fields will be printed.

IMPORTANT PlateTag does not issue an error message if a discrepancy occurs 
between the number of fields in your label format and the number of fields in 
your schema.

Related topics

PlateTag—using data sources

About this topic

This topic defines a PlateTag data source, describes the advantages of using a 
data source, and lists the available types. 

Data source defined

A data source is an external file that can be used in a PlateTag schema to 
define what is printed on each label. A data source can include data for text 
and barcode fields only. You can use constants for the label format and drop 
stage settings when creating the schema.

For information about... See...

Label formats “About label formats and content” on 
page 92

Schemas “PlateTag—creating a schema” on 
page 126

Constants, counters, and barcode 
clones

“PlateTag—setting parameters for the 
label content” on page 122

Data sources “PlateTag—using data sources” on 
page 119

PlateTag print job workflow “PlateTag print job workflow” on 
page 114

How to report problems “Reporting problems” on page 176
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Data source use

The use of a data source is optional. Instead, you can use counters, constants, 
and clones to define the data to print on a barcode. Either way, you set the 
source of the label data when creating a schema.

Some advantages of using a data source are that they:

• Can be stored permanently in a format that is easily edited.

• Can use values that have no sequence pattern.

• Are easily re- used or modified.

• Can be automatically generated by a LIMS (lab information management 
system).

Before creating a data source

You reference a data source in PlateTag at the time you create a schema. You 
must create the data source before creating the schema, but it will help you to 
understand data source creation if you understand schemas. See “PlateTag 
print jobs and schemas” on page 116 to review the information about schemas 
before you create a data source. 

Types of data sources

PlateTag can read data from:

• Comma- separated value (CSV) or tab- delimited text files

• Online databases using Open Database Connectivity (ODBC)

Note: Setting up an online database is not covered in this guide. For 
information about using PlateTag with an online database, contact 
Automation Solutions Technical Support.

Data source structure

A data source is a matrix of rows and columns. Each row contains data for 
one label to be printed. Each column holds the data for one field in the 
barcode label.

The top row of the matrix is reserved for the variable names.

Creating a data-source file

Creating a CSV or tab-delimited source file

To create a CSV or tab-delimited source file:

1 Open a text editor, for example, Windows Notepad.

2 In the first row of the file, type the names of the header fields as you 
want them defined in the schema, a name for the label format, and a name 
for the drop stage value, separated by commas (CSV). 

This row creates columns to hold the data. The name of each column is the 
name of the variable for that field.
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3 In the second and subsequent rows, type the data under the columns.

Make sure that you separate the data with commas but no spaces.

Using Excel to create a data source file
You can also save the data from Microsoft Excel as a comma- separated text or 
tab- delimited text file. Because the procedure for doing this varies depending 
on the version of Excel you are using, refer to the documentation provided 
with your copy of Excel for details.

Note: Although PlateTag only supports Excel 2002 .xls files, you can save a 
comma- separated file from any version of Excel.

Related topics

For information about... See...

Label formats “About label formats and content” on 
page 92

Schemas • “PlateTag print jobs and schemas” 
on page 116

• “PlateTag—creating a schema” on 
page 126

Selecting a data source file “Configuring a data source in a 
schema” on page 130

Constants, counters, and barcode 
clones

“PlateTag—setting parameters for the 
label content” on page 122

PlateTag batch labeling workflow “PlateTag print job workflow” on 
page 114

How to report problems “Reporting problems” on page 176
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PlateTag—setting parameters for the label content

About this topic

You can set the following parameters, which can be used in a PlateTag schema 
to define what is printed on each label:

• Constants. Optional data type that is used for a field when creating a 
PlateTag schema. The value of the constant is text or numbers (an 
alphanumeric text string) that is the same for each label that is printed. 
See “Creating a constant” on page 122.

• Counters. Optional data type that is used for a field when creating a 
PlateTag schema. The value of a counter changes in a regular way for the 
specified interval (microplates). See “Creating a counter” on page 123.

• Clones. See “Cloning a barcode” on page 125.

If you are using PlateTag and want to import the label content from a data 
source, see “PlateTag—using data sources” on page 119.

If you are using the VWorks software or BenchWorks software, see the VWorks 
Automation Control User Guide or BenchWorks Automation Control User 
Guide for details on how to set the parameters for the label content.

Creating a constant

About constants
You can use a constant to record information such as:

• Laboratory name

• Assay name

• Reaction name

• Label format number 

• Drop stage attribute

• Date

After creating a constant, you add it to a schema by selecting the variable 
name that you gave to the constant.

Procedure

To create a constant:

1 In the PlateTag window, click the Schemas tab at the bottom of the page.

2 Click the Constants tab. The following default definitions for constants 
appear in the tab: 

Variable name Constant value

Stage UP 0

Stage DOWN 1

Label format 1 1

Label format 2 2

Label format 3 3

Label format 4 4
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By default, the software provides four label format constants. If you plan 
to use more than four label formats, make sure you add a new constant for 
each additional label format.

3 To add a constant to the list of defaults, click Add new constant. A row for 
the new constant appears.

4 To edit the parameter values, click twice in the appropriate column, and 
then type the value:

5 Click in the white space outside the columns to apply the changes and 
create the constant.

Creating a counter

Counters defined
A counter is an optional data type that is used for a field when creating a 
schema. For the specified interval (microplates), the counter increases in value 
by the same amount. 

Example:

0001, 0002, 0003, 0004...

You can also add constant text before or after the counter.

Example:

Jan6- 0001, Jan6- 0002, Jan6- 0003, Jan6- 0004...

Parameter Description

Variable name A name for the constant that is easy to remember, 
for example, date.

This name becomes the variable name in the 
schema. It does not appear on the barcode label.

Constant value The information that controls the appearance of 
the label or appears on the label, either as text or 
encoded as a barcode.

For example, the variable name label format 1 has 
a constant value of 1, which specifies the format of 
the label. The variable name date could have a 
constant value of a specific date, 090930, that 
appears on the label as text.

IMPORTANT The constant value for a label 
format must be the format number not a format 
name.
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Creating counters

IMPORTANT Use 10 or fewer digits for the Initial counter value. If more than 
10 digits are entered, the number is returned as all zeroes. 

To create a counter:

1 In the PlateTag window, click the Schemas tab at the bottom of the page.

2 Click the Counters tab. A default sample counter row appears.

3 To add another counter, click Add new counter. A row for a new counter 
appears.

4 Click twice in the column for the counter that you are defining, and then 
enter a value for the parameter. The counter parameters are:

For example, to generate the following sequence, use a combination of 
Prefix (DDR- ), Initial counter value (0000151), and Suffix (- 01), Increment 
(1), and Base (10): 

DDR- 0000151- 01, DDR- 0000152- 01, DDR- 0000153- 01...

5 Click in the white space to apply these changes.

PlateTag immediately recognizes the addition of the new counter. 

Parameter Description

Variable name A name for the counter that is easy to 
remember.

Prefix Text preceding the number.

Suffix Text following the number.

Base The number base of the counting system.

The options are base 10 and base 36, which 
counts from 0–9 and then A–Z.

Initial counter value The number from which to start counting.

For example, if there is a constant with the 
value ABC followed by an initial counter value 
of 0001, the output is ABC0001, 
ABC0002...ABC0010.

If you enter 000001 for the initial counter 
value, the output is ABC000001, 
ABC000002...ABC000010.

Increment The amount by which the initial value increases 
according to the interval.

Interval (plates) The number of microplates that are processed 
before the initial counter value is increased.
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Cloning a barcode

IMPORTANT The optional barcode reader is required for cloning, and it must 
be set up to decode the barcode format that you want to read.

How the cloning process works
1 The barcode on the existing label is read by the barcode reader.

2 The barcode information in the label is decoded to text.

3 The text is copied to the barcode field that will be printed on the new 
label.

4 The text is encoded using the new symbology.

5 The new label is printed and applied, either on a different side of the 
microplate or the same side of the microplate over the top of the existing 
label.

Guidelines for barcode cloning
• You can clone barcodes only. Text fields cannot be read by the barcode 

reader.

• The side of the microplate that you select be cloned must contain a label 
with a barcode.

• If you want the label that contains the cloned barcode to also have text 
fields that match those on the label from which the clone was created, you 
must set up the schema to replicate those fields, using constants and 
counters.

Procedures
The software contains predefined clones that you can use to clone a barcode 
from any side of a microplate. When you configure a schema, you specify the 
variable name of the clone you want to use.

To view the predefined clones:

1 In the PlateTag window, click the Schemas tab at the bottom of the page.

2 Click the Clones tab. The predefined clones appear.

When you configure the schema, you select the clones data type, and then add 
the clone’s variable name.
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Related topics

PlateTag—creating a schema

About this topic

Before you can create a batch print job in PlateTag, you must create and 
configure one or more schemas. This topic describes how to create, update, 
copy, and delete a PlateTag schema.

Creating a schema

To create a schema:

1 In the PlateTag window, click the Schemas tab at the bottom of the page.

2 Click Create new schema.

3 In the Schema list, replace the text New Schema #n with a name of your 
choice.

For information about... See...

Label formats “About label formats and content” on 
page 92

Schemas • “PlateTag—creating a schema” on 
page 126

• “PlateTag—configuring a schema” on 
page 128

Data source definition and types “PlateTag—using data sources” on 
page 119

PlateTag batch labeling workflow “PlateTag print job workflow” on 
page 114

Checking which barcode formats 
the reader can currently decode

Automation Solutions Technical Support

How to report problems “Reporting problems” on page 176
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4 Click Rename schema.

The button label changes to Update schema and the schema is created.

When a new schema is created, the information in the Data source tab is 
cleared.

Saving changes to a schema

Updating a schema is the same as saving a changed schema.

To update a schema after making changes:

1 In the Schemas tab, click Update schema.

Copying and renaming a schema

To create a new schema that is similar to an existing one, you can copy the 
existing schema to use as a starting point for creating a new one.

To copy and rename a schema:

1 In the Schemas tab, click Create copy.

The schema is saved to the specified location. The schema name is prefixed 
by the text Copy of (for example, Copy of schema one). For details on 
schema file storage, see “PlateTag—setting file locations” on page 115.

2 In the Schema list, select the copy, and then type a new name.

3 Click Rename schema.
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Deleting a schema

You can delete schemas that you no longer want to use.

To delete a schema:

1 In the Schemas tab, select the schema from the Schema list.

2 Click Delete schema.

Related topics

PlateTag—configuring a schema

About this topic

When you configure a PlateTag schema, you specify the label format, the data 
content, and the vertical position of the plate stage. You must configure a 
schema before using the schema in a PlateTag print job. 

About defining fields

Define only the fields that you want to print on your barcode label. If you do 
not want to define a field, leave the default settings in the Data type column.

Before you start

Before configuring a schema, make sure you complete the following:

• If you plan to use a data source for the label data, create the data source. 
See “PlateTag—using data sources” on page 119.

• If you plan to use any constants, counters, and clones, set up the 
parameters for the label content. See “PlateTag—setting parameters for the 
label content” on page 122.

For information about... See...

Label formats “About label formats and content” on 
page 92

Defining the contents of a schema “PlateTag—configuring a schema” on 
page 128

The drive location of saved 
schemas

“PlateTag—setting file locations” on 
page 115

PlateTag batch labeling workflow “PlateTag print job workflow” on 
page 114

How to report problems “Reporting problems” on page 176
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• Determine which fields are used in the label format you intend to use in 
the schema.

IMPORTANT The information that is printed on a label depends on the fields 
that you configure in the schema as well as the fields used in the label format. 
If a field is not defined in the label format, it will not be printed even if you 
configure it in the schema.

Procedures

This section contains the following procedures:

• Configuring constants, counters, and clones in a schema

• Configuring a data source in a schema

Configuring constants, counters, and clones in a schema

To configure constants, counters, and clones in a schema:

1 In the PlateTag window, click the Schemas tab, and select a Schema from the 
list. 

Alternatively, to create a new schema, click Create new schema. In the 
Schema box, type a name for the new schema, and then click Rename schema.

2 Set the properties for the Field attributes that you want to use as follows: 

a Click twice in the Data type column. From the list, select the data type 
(constants, counters, or clones), and then click in the white space 
outside the list to accept the choice.

b Click twice in the Variable name column, and then select the variable 
name from the list. 

The variable name represents one of the variables defined in the 
constants, counters, or clones. The variable name points to the source 
of the actual data to be printed.
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3 For the Label format attribute, select one of the four predefined constants 
for label format:

If you are using more than four label formats, see “PlateTag—creating a 
new label format constant” on page 132 for details on setting properties for 
additional label formats in the schema.

 IMPORTANT The constant value for a label format must be the format 
number not a format name.

4 For the Drop stage attribute , select one of the predefined constants:

• Stage UP. Moves the plate stage to the top position at the time the 
microplate is labeled.

• Stage DOWN. Moves the plate stage to the bottom position at the time 
the microplate is labeled.

The height of the plate stage when a label is applied to a microplate is 
determined by both the mechanical height adjustment of the plate stage 
and the Drop stage attribute in the schema.

5 When you are finished configuring the schema, click Update schema to save 
the changes.

Configuring a data source in a schema
This procedure describes how to open a CSV file to use as a data source for 
the content of labels that you print using PlateTag. If you have not already set 
up the data source file, see “PlateTag—using data sources” on page 119 before 
continuing with the following procedure.

To configure a data source in a schema:

1 In the PlateTag window, click the Schemas tab, and select a Schema from the 
list. 

Alternatively, to create a new schema, click Create new schema. In the 
Schema box, type a name for the new schema, and then click Rename schema.

2 To specify the location of the CSV file:

a In the Data Source Selection area, select CSV.

b Click Browse, and then select the file in the Open dialog box.

The data from the CSV file appears in the Data source tab.

Note: If you want to specify ODBC instead of CSV, you would select 
ODBC, and then enter the Connection string and SQL Statement.

Variable name Constant value

Stage UP 0

Stage DOWN 1

Label format 1 1

Label format 2 2

Label format 3 3

Label format 4 4
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3 For each schema attribute that you want to use (Field, Label format, or 
Drop stage):

a Click twice in the Data type field. From the list, select data source.

b Click twice in the Variable name field, and then select the name from the 
list. The list contains the names of the column headings from the data 
source. 

4 Click Update schema to save the changes.



6   PlateTag—Running a print job
PlateTag—creating a new label format constant

132 G5404B Microplate Labeler User Guide

Related topics

PlateTag—creating a new label format constant

About this topic

PlateTag contains four label format constants for which the properties are 
predefined. If you are using more than the four label formats, read this topic 
to learn how to set properties for additional label formats using constants. 

Note: You do this when create a PlateTag schema.

Label format property

Before you can complete a schema, you define the Label format property by 
setting the constant value for the property.

Any data type can be used for the label format, but it is easiest to use a 
constant. 

To set the label format:

1 Create a constant for the format using the same number as the number of 
the label format that is stored in the printer. To do this:

a In the Constants tab, click Add new constant.

For information about... See...

Label formats “About label formats and content” on 
page 92

PlateTag batch labeling workflow “PlateTag print job workflow” on 
page 114

Schemas • “PlateTag print jobs and schemas” 
on page 116

• “PlateTag—creating a schema” on 
page 126

Setting up a data source “PlateTag—using data sources” on 
page 119

Constants, counters, and barcode 
clones

“PlateTag—setting parameters for the 
label content” on page 122

Defining a print job in PlateTag “PlateTag—creating a print job” on 
page 134

Setting the label format property 
in PlateTag

“PlateTag—creating a new label format 
constant” on page 132

How to report problems “Reporting problems” on page 176
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b In the Variable name column for the new constant, type a name. For 
example, type Label format 5.

c In the Constant value column for the new constant, click twice, and then 
type the new value. For example, type 5 for label format 5. 

 IMPORTANT The constant value for a label format must be the format 
number not a format name.

2 Select the constant for the Label format field as follows:

a In the Data type column for the Label format attribute, select Constants.

b In the Variable name column, select the Variable value that you used 
when creating the constant.

Related topics

For information about... See...

Label formats “About label formats and content” on 
page 92

PlateTag print job workflow “PlateTag print job workflow” on 
page 114

Schemas • “PlateTag—creating a schema” on 
page 126

• “PlateTag—configuring a schema” on 
page 128

Setting up a data source “PlateTag—using data sources” on 
page 119

Constants, counters, and barcode 
clones

“PlateTag—setting parameters for the 
label content” on page 122
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PlateTag—creating a print job

About this topic

This topic defines PlateTag print jobs, and describes how to create, save and 
open them.

About print jobs

A print job is used to designate a schema to be used for labeling each side of 
a microplate. You can use a different schema for each side of a microplate, or 
you can use the same schema for one or more sides of a microplate. 

You can label more than one type of labware in a print job, even if the 
labware is of varying heights. However, if the labware requires different plate 
stage heights, you must use a data source in the schema to control the drop 
stage attribute during the print job.

Before you start 

Before defining a print job in PlateTag, you must:

• Create one or more schemas

• Create the label format for the print job

Creating a print job

To create a print job:

1 In the PlateTag window, choose Jobs > New. 

Any existing schemas listed in the Data Schema Selection table are cleared.

Defining a print job in PlateTag “PlateTag—creating a print job” on 
page 134

How to report problems “Reporting problems” on page 176

For information about... See...
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2 Under Device Selection, select the profile for the Microplate Labeler.

3 Under Data Schema Selection, define the schema for each side of the 
microplate that you want to label as follows:

a Select the row corresponding to the first side of the microplate that 
you want to label.

b Click twice in the Schema column, and then select the schema to use 
from the list.

Repeat this step for any other sides of the microplate to be labeled. Select 
[no schema] for the sides that will not be labeled.

Saving a print job

To save a print job:

1 In the PlateTag window, choose Jobs > Save or press CTRL+S.

2 In the Save as dialog box, specify the storage location and name for the file, 
and then click Save.

Opening a print job

To open a print job:

1 In the PlateTag window, choose Jobs > Open or press CTRL+O.

Only one print job can be open at a time.

Related topics

For information about... See...

The label format for the print job • “About label formats and content” 
on page 92

• “PlateTag—creating a new label 
format constant” on page 132

Schemas • “PlateTag—creating a schema” on 
page 126

• “PlateTag—configuring a schema” on 
page 128

Constants, counters, and barcode 
clones

“PlateTag—setting parameters for the 
label content” on page 122

PlateTag batch labeling workflow “PlateTag print job workflow” on 
page 114

Defining a print job in PlateTag “PlateTag—creating a print job” on 
page 134

Starting the labeling operation for 
a production run

“PlateTag—starting a print job” on 
page 137

How to report problems “Reporting problems” on page 176
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PlateTag—test printing in sticky mode

About this topic

PlateTag includes a green button “sticky” mode that you can use for testing. 
When you push the green button in sticky mode, the button remains on until 
the test is completed or aborted. 

In sticky mode you can print multiple labels to preview the data stream that 
would be generated during a future production print job. The Microplate 
Labeler repeatedly labels the same microplate. For example, the data from the 
external data source, constants, counters, and clones can be printed and 
applied sequentially. 

This topic explains how to use the sticky mode.

Procedure

To test print using sticky mode:

1 In the PlateTag window, set up a print job that conforms to your test 
requirements.

2 Select Edit > Preferences. The PlateTag Preferences dialog box appears.

3 In the Jobs tab, select Enable sticky mode, and then click OK.

4 Place a test microplate on the plate stage.

5 In the Print Job tab of the PlateTag window, click Start job.

If the schema data type is a data source, go to step 7. Otherwise, continue 
to step 6.

6 In the dialog box that appears, type the number of microplates that will 
eventually be labeled in the actual print job.

7 Press the green button to start the test. The Microplate Labeler prints and 
applies labels to the test microplate the specified number of times.

To stop a sticky mode labeling test:

1 In the Print Job tab of the PlateTag window, click Abort job.

Related topics

For information about... See...

Performing a test print using 
Microplate Labeler Diagnostics

“Performing a print- and- apply test” on 
page 146

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

PlateTag print job workflow “PlateTag print job workflow” on 
page 114

How to report problems “Reporting problems” on page 176
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PlateTag—starting a print job

About this topic

After the Microplate Labeler is completely set up and a print job has been 
created, you can perform a production print job in which a batch of 
microplates is labeled on one or more sides. This topic describes how to open 
and start a print job using the PlateTag software.

Before you start

Before starting a production printing job, perform a test print to make sure 
that:

• The label is positioned correctly on the labware

• The data fits on a label

• The human- readable text can be read by a person

• The barcode can be read by a barcode reader

Starting a print job

To start a print job:

1 In the PlateTag window, choose Jobs > Open, and then select the print job.

You can have one print job open at a time.

2 In the Print Job tab, click Start job.

3 If your schemas do not use a data source, type the number of microplates 
for the run in the Job Size Request dialog box, and then click OK.

If your schemas use a data source, PlateTag assumes that the number of 
microplates that you want to label is the same as the number of data rows 
in the data source.

4 Place a microplate on the plate stage and press the green button.

One or more labels are printed and applied to the microplate.

In the Print Job tab, view the progress of batch labeling operation in the 
status bar.

Repeat this step for each microplate in the print job.
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Related topics

For information about... See...

The location of the green button  “Hardware overview” on page 12

Placing a microplate “Placing a microplate on the plate 
stage” on page 80

PlateTag print job workflow “PlateTag print job workflow” on 
page 114

Labeling microplates with identical 
labels

“PlateTag—labeling microplates with 
identical labels” on page 139

Using the PlateTag stick mode “PlateTag—test printing in sticky mode” 
on page 136

VWorks software VWorks Automation Control User 
Guide

BenchWorks software BenchWorks Automation Control User 
Guide

Performing a test print using 
Microplate Labeler Diagnostics

“Performing a print- and- apply test” on 
page 146
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PlateTag—labeling microplates with identical labels

About this topic

This topic explains how to set up a batch print job in PlateTag that uses a 
data source to print groups of microplates with the same labels.

If you are using the VWorks software or BenchWorks software, see the VWorks 
Automation Control User Guide or BenchWorks Automation Control User 
Guide for details on how to set up and run labeling protocols.

Example

You may want to label groups of microplates in a batch run, where each 
microplate in the group has the same label. The following example has groups 
of three identical microplates in an incrementing batch run:

AB123, AB123, AB123, CD324, CD324, CD324, JF942, JF942, JF942

Normally, each microplate is labeled with a unique label using data from a new 
row in the data source, such as:

AB123, CD324, JF942

If you run the same print job in the normal mode three times, the microplates 
will be labeled like this:

AB123, CD324, JF942, AB123, CD324, JF942, AB123, CD324, JF942.

This is inconvenient because you must shuffle the microplates to get them into 
the desired order.

The procedure in this topic shows you how to create subsets of identically 
labeled microplates.

Before you start

This procedure assumes that PlateTag software is already running and that one 
of the schemas used for the print job uses a data source. 

If you are using more than one external file (data source) to label multiple 
sides of the microplates, the data source files must contain the same number 
of rows.

Procedure

To print subsets of identically labeled microplates in a batch run:

1 In the PlateTag window, choose Edit > Preferences. The Edit Preferences 
dialog box appears.

2 Click the Jobs tab.

3 Under Data Sources, select Prompt for duplication of data source entries, and then 
click OK.

4 In the PlateTag window, click the Print Job tab.

5 Click Start job.

6 In the dialog box that appears, type the number of additional copies of 
each barcode that you want to print, and then click OK.
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For example, if you want to have three microplates in the group, as in the 
example earlier in this topic, type 2, where,

1 original + two duplicates = 3

Related topics

For information about... See...

The location of the green button  “Hardware overview” on page 12

Placing a microplate “Placing a microplate on the plate 
stage” on page 80

PlateTag print job workflow “PlateTag print job workflow” on 
page 114

Starting the print job “PlateTag—starting a print job” on 
page 137

Using the green button 
sticky mode

“PlateTag—test printing in sticky mode” 
on page 136

Performing a test print using 
Microplate Labeler Diagnostics

“Performing a print- and- apply test” on 
page 146
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7
Maintenance and troubleshooting

This chapter provides maintenance and troubleshooting information 
for the Microplate Labeler. 

The topics are:

• “Routine maintenance” on page 142

• “Checking the basic applicator functions” on page 144

• “Performing a print- and- apply test” on page 146

• “Using plate stage controls in Diagnostics” on page 149

• “Testing the barcode reader using Diagnostics” on page 152

• “Cleaning the Microplate Labeler exterior” on page 153

• “Cleaning the printer components” on page 155

• “Resetting the label counter in the Diagnostics software” on 
page 157

• “Adjusting the feed path of the ribbon” on page 159

• “Cleaning and replacing the vacuum pads” on page 160

• “Disconnecting the air tubing” on page 163

• “Replacing the fuse” on page 164

• “Troubleshooting hardware problems” on page 167

• “Resolving error messages” on page 171

• “Using the printer display and navigation pad” on page 174

• “Reporting problems” on page 176
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Routine maintenance

About this topic

Preventive maintenance is an important part of keeping the Microplate Labeler 
running smoothly and error free. This topic describes the periodic routine 
maintenance you should perform.

Contact Automation Solutions Technical Support if you are unable to resolve 
problems. 

Routine inspection and maintenance 

Your maintenance schedule can vary depending on the frequency of Microplate 
Labeler use. In general, you should perform routine maintenance tasks when 
you replace the printer ribbon and labels.

Maintenance task Schedule See…

Check the air- pressure level at 
the Microplate Labeler. 

Symptom. Insufficient air 
pressure or problems picking 
and placing the labels.

Daily “Checking the basic applicator 
functions” on page 144

Clean the Microplate Labeler.

Symptom. Dust, grime, or 
chemical deposits on exterior.

When 
replacing 
printer 
media

“Cleaning the Microplate 
Labeler exterior” on page 153

Clean the print roller.

Symptom. Impairment of label 
advancement or degradation of 
print quality.

When 
replacing 
printer 
media

“Cleaning the printer 
components” on page 155

Clean the printhead.

Symptom. Degradation of 
print quality, contrast, or 
vertical stripes.

When 
replacing 
printer 
media

“Cleaning the printer 
components” on page 155

Clean the applicator head. 

Symptom. Dust and grime on 
applicator head.

When 
replacing 
printer 
media

“Cleaning the Microplate 
Labeler exterior” on page 153

Clean and inspect the vacuum 
pads.

Symptom. Problems picking up 
labels from the printer or 
placing labels on labware.

Every 
three 
months

“Cleaning and replacing the 
vacuum pads” on page 160

Replace the vacuum pads.

Symptom. Cracked or worn 
pads.

Annually “Cleaning and replacing the 
vacuum pads” on page 160
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Related topics

Replace the labels and thermal 
transfer ribbon.

Symptom. End of media rolls.

As 
required

“Loading labels and ribbon” on 
page 50

Maintenance task Schedule See…

For information about... See...

Hardware overview “Hardware overview” on page 12

Safety “Safety guidelines” on page 1

Troubleshooting hardware 
problems

“Troubleshooting hardware problems” 
on page 167

Resolving error messages “Resolving error messages” on page 171

Reporting problems “Reporting problems” on page 176
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Checking the basic applicator functions

About this topic 

This topic describes how to use Microplate Labeler Diagnostics to verify the 
performance of basic applicator functions. You can perform this procedure at 
any time to double- check the applicator functions or to help troubleshoot 
problems.

Before you start

The following procedure assumes that:

• Microplate Labeler Diagnostics is open. For details, see “Opening Microplate 
Labeler Diagnostics” on page 75.

• The profile for your device is initialized. For details, see “Initializing a 
profile” on page 78.

Procedure

You can use the I/O Functions tab in Microplate Labeler Diagnostics to test 
basic applicator functions.

To test basic applicator functions:

1 In the Microplate Labeler Diagnostics window, click the I/O Functions tab.

2 Under Output Functions, click a toggle button to perform the corresponding 
task and verify that the corresponding indicator lights in the Sensors area. 

Click the toggle button again to return to the original position. 
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3 While observing the Green button press indicator in the Sensors area, press 
and hold the green button on top of the device. The Green button press 
light should turn on.

Note: If a print job has been created, pressing the green button will start 
the labeling operation.

4 Under Pressure (psi), verify that the air pressure readout is correct: 80 psi 
(0.55 MPa), minimum. 

• If the readout is <80 psi. Verify that the air source is supplying 80 psi 
(0.55 MPa), minimum. If the source is above 80 psi and the readout is 
below 80 psi, use the pressure regulator knob on the back of the 
applicator to increase the pressure.

• If the readout is >87 psi. Use the pressure regulator knob on the back 
of the applicator to lower the pressure to 85 psi (0.58 MPa), maximum.

                                                        

CAUTION Before rotating the head, make sure that it is retracted and that a short side 
of plate stage is facing you as you stand in front of the device. Otherwise, the applicator 
head will hit the plate stage.

Button Description

Extend head/Retract 
head

Extends or retracts the applicator head.

In the Sensors area, the Head retracted light turns 
on when the applicator head is retracted.

Rotate to stage/
Rotate to printer

The applicator head rotates to the plate stage or 
the printer. In the Sensors area, the Head rotated 
to printer or the Head rotated to stage light turns 
on to indicate the current position of the 
applicator head. 

Vacuum on/Vacuum 
off

Turns on or off the vacuum for the vacuum pads 
on the applicator head. 

If the vacuum is turned off when a label is 
attached to the vacuum pads, the label can drop.

If the vacuum pads are pressed against a surface, 
such as a label, while the vacuum is on, the 
Vacuum detected light turns on.

Drop stage/Raise 
stage

Raises or lowers the plate stage.

Blowoff on/Blowoff 
off

Starts or stops a stream of air through the 
vacuum pads on the applicator head.

If the air flow is on when a label is attached to 
the vacuum pads, the label is pushed off.



7   Maintenance and troubleshooting
Performing a print-and-apply test

146 G5404B Microplate Labeler User Guide

Related topics

Performing a print-and-apply test

About this topic

This topic describes how to perform a print and apply test using the Testing 
tab in Microplate Labeler Diagnostics.

When to do a test print

Perform a print- and- apply test when first setting up your Microplate Labeler, 
after creating a new label format, when loading new labels and ribbon, or 
when troubleshooting printing problems.

Testing helps you detect problems such as:

• Incorrect height settings for the plate stage

• Incorrectly loaded label or ribbon 

• Poorly designed label formats, for example, overlapping fields, barcodes 
that are too large for the label, missing barcodes, or text fields that are too 
small to read

Before you begin

The following procedure assumes that:

• Microplate Labeler Diagnostics is open. For details, see “Opening Microplate 
Labeler Diagnostics” on page 75.

• The profile for your device is initialized. For details, see “Initializing a 
profile” on page 78.

For information about... See...

Resetting the air pressure “Setting the air pressure” on page 42

Rotating the plate stage “Using plate stage controls in 
Diagnostics” on page 149

Plate stage and applicator head “About plate stage and applicator head 
positions” on page 81

Raising or lowering the plate stage “Setting the plate stage vertical 
positions” on page 84

Microplate Labeler Diagnostics 
controls and indicators

“Quick reference to Diagnostics 
software” on page 179

Troubleshooting problems “Troubleshooting hardware problems” 
on page 167

Reporting problems “Reporting problems” on page 176
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IMPORTANT Field data entered in the Testing tab of Microplate Labeler 
Diagnostics is stored temporarily in the computer and not the printer, so it can 
be used for testing purposes only. 

Procedure

To print a label from the Testing tab:

1 In the Testing tab, verify that the label format you want to use for this test 
is selected in the Format list. 

Note: You can display a preview of the label format in the Label Editor 
tab.

2 Under Label Data, type the text in the field box for the position that you 
want to test.

Note: Only the fields that are defined in the label format can be edited. 
Fields that are defined in the label format as barcode fields will be 
encoded into a barcode before printing.

3 In the Testing Options area, select Print and apply.

4 Select the compass points corresponding to one or more sides that you 
want to apply labels to, for example North and West.
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 IMPORTANT Make sure that the height of the plate stage is suitable 
for the type of microplate being labeled, and that there is a microplate 
on the plate stage.

5 In the Number of cycles list, set the value to the number of microplates that 
you want to test label.

6 Click Run test or press the green button on the top of the device.

The first label is printed and applied to the microplate.

7 If you are test labeling multiple microplates, quickly replace the microplate 
on the plate stage with a new one. 

Repeat this step until all the test cycles are completed.

Related topics

00143
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For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Placing a microplate “Placing a microplate on the plate 
stage” on page 80

Adjusting the height of the plate 
stage

“Setting the plate stage vertical 
positions” on page 84

The overall process of designing a 
label format

“Creating and editing label formats” on 
page 94

Running a labeling protocol • VWorks Automation Control User 
Guide

• BenchWorks Automation Control 
User Guide

Using PlateTag software to print 
and apply labels

“PlateTag print job workflow” on 
page 114
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Using plate stage controls in Diagnostics

About this topic

The plate stage controls in Microplate Labeler Diagnostics are useful when 
setting up the Microplate Labeler, troubleshooting, or performing maintenance 
on the Microplate Labeler. 

This topic describes how to use the Stage Setup tab to perform the following 
procedures:

• “Enabling and disabling plate stage auto- repositioning” on page 150

• “Rotating the plate stage using stage controls” on page 150

• “Moving the plate stage to a teachpoint” on page 151

Figure Stage Setup tab in Microplate Labeler Diagnostics

Microplate Labeler Diagnostics 
controls and indicators

“Quick reference to Diagnostics 
software” on page 179

Troubleshooting problems “Troubleshooting hardware problems” 
on page 167

For information about... See...
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Before you begin

The following procedure assumes that:

• Microplate Labeler Diagnostics is open. For details, see “Opening Microplate 
Labeler Diagnostics” on page 75.

• The profile for your device is initialized. For details, see “Initializing a 
profile” on page 78.

Enabling and disabling plate stage auto-repositioning

By default, plate stage auto- repositioning is enabled. If the plate stage is 
moved from a position by an outside force (for example, if someone rotates the 
stage by hand), the auto- repositioning feature automatically moves the plate 
stage back to the last angle.

When setting up the device, troubleshooting, or performing maintenance on the 
Microplate Labeler, you can disable the auto- repositioning feature.

To disable plate stage auto-repositioning:

1 In the Stage Setup tab under Stage Controls, select the Disable stage auto-
repositioning check box.

When auto- repositioning is disabled, any disturbances that cause the plate 
stage to rotate will not be corrected until another move is commanded.

To enable plate stage auto-repositioning:

1 In the Stage Setup tab under Stage Controls, clear the Disable stage auto-
repositioning check box.

Rotating the plate stage using stage controls

To rotate the plate stage:

1 Ensure that the applicator head is pointing towards the printer. 

If the applicator head is pointing towards the plate stage:

a In Microplate Labeler Diagnostics, click the I/O Functions tab.

b Click Rotate to printer.

The applicator head rotates towards the printer, moving it out of the plate 
stage rotation path.

2 Move the plate stage in one of the following ways:

CAUTION Before moving the plate stage, make sure that the applicator head is not in the 
rotation path of the plate stage.
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• To move relative to the current position. Under Stage Controls, type a 
value in the Angle increment box, and then click Rotate CCW 
(counterclockwise) or Rotate CW (clockwise).

• To move to a specific angle. Type a value in the Angle value box, and 
then click Move to.

• To rehome the plate stage. Click Home stage.

Moving the plate stage to a teachpoint

1 Ensure that the applicator head is pointing towards the printer. 

If the applicator head is pointing towards the plate stage:

a In Microplate Labeler Diagnostics, click the I/O Functions tab.

b Click Rotate to printer.

The applicator head rotates towards the printer, moving it out of the plate 
stage rotation path.

2 Click the Stage setup tab. 

3 Make sure that Disable stage auto-repositioning is not selected.

4 Click Move here on the same row as the teachpoint to which you want to 
move.

The plate stage moves to the position.

Related topics

For information about... See...

Plate stage and head positions “About plate stage and applicator head 
positions” on page 81

Changing the robot pickup angle “Setting the robot pickup angle 
teachpoint” on page 88

Microplate Labeler Diagnostics 
controls and indicators

“Quick reference to Diagnostics 
software” on page 179

Troubleshooting problems “Troubleshooting hardware problems” 
on page 167
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Testing the barcode reader using Diagnostics

About this topic

If you have installed the optional barcode reader on the Microplate Labeler, 
you can use the following procedure to test the reader.

Before you begin

The following procedure assumes that:

• Microplate Labeler Diagnostics is open. For details, see “Opening Microplate 
Labeler Diagnostics” on page 75.

• The profile for your device is initialized. For details, see “Initializing a 
profile” on page 78.

Procedure

To test the barcode reader using Microplate Labeler Diagnostics:

1 In the I/O Functions tab, under Barcode Reader, click Trigger BCR.

Note: If the button is unavailable, either the barcode reader was not 
detected during initialization, the Microplate Labeler was not previously 
initialized, or a microplate with a barcode label was on the plate stage 
during initialization.

2 In the Last value box, check the displayed result.

If you receive an error, make sure that the barcode reader’s laser lines are 
aligned with the label. For assistance, contact the Automation Solutions 
Technical Support.
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3 Move the plate stage so that another side of the microplate is exposed to 
the reader, and repeat the test.

Read angle information

The read angle is the position of the plate stage when a label is being read. 
This angle was set at the factory and should not require adjustment. You can 
view the setting for Read angle (east) teachpoint in the Stage Setup tab. This 
teachpoint specifies the angle to which the plate stage rotates so that the east 
side faces the optional barcode reader. To move the plate stage so that each of 
the other sides face the barcode reader, the software uses angles 90-  , 180-  , 
and 270- degrees from the teachpoint.

If barcodes cannot be read on all four sides of the microplate the read angle is 
not optimal. Contact the Automation Solutions Technical Support for 
assistance.

Related topics

Cleaning the Microplate Labeler exterior

About this topic

This topic provides guidelines for periodic routine cleaning of the Microplate 
Labeler applicator to remove dust, grime, or chemical deposits on the exterior. 

Before you begin

Safety warnings

For information about... See...

Microplate Labeler Diagnostics 
controls and indicators

“Quick reference to Diagnostics 
software” on page 179

Troubleshooting problems “Troubleshooting hardware problems” 
on page 167

Reporting problems “Reporting problems” on page 176

WARNING To avoid risk of electric shock, turn off the Microplate Labeler and 
disconnect the power cord before performing any maintenance or cleaning.

CAUTION Do not use harsh abrasives, corrosive cleaning agents, or metal brushes to 
clean any Microplate Labeler component or accessory. The printer can be damaged by 
aggressive cleansers. Do not use abrasive cleaners, ethanol, or other solvents for cleaning the 
external surfaces or modules of the printer.
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Required tools or equipment
• Standard laboratory wipes

• Mild soap- and- water solution 

• Soft brush or vacuum cleaner

Procedure

To clean the Microplate Labeler:

1 If you have not already done so, shut down the Microplate Labeler and 
disconnect the power cord.

2 Clean the printer exterior as follows:

a Use standard laboratory wipes and a mild soap- and- water solution to 
clean the printer cover.

b Remove dust and paper fluff from the print area with a soft brush or 
vacuum cleaner.

3 To clean the painted white surfaces and the aluminum surfaces of the 
device, use standard laboratory wipes and a mild soap- and- water solution.

Related topics

For information about... See...

Shutting down the Microplate 
Labeler

“Starting up and shutting down” on 
page 60.

Hardware overview “Hardware overview” on page 12

Troubleshooting hardware 
problems

“Troubleshooting hardware problems” 
on page 167

Cleaning the printhead and print 
roller

“Cleaning the printer components” on 
page 155

Cleaning the applicator head 
vacuum pads

“Cleaning and replacing the vacuum 
pads” on page 160

Reporting problems “Reporting problems” on page 176
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Cleaning the printer components

About this topic

This topic describes how to clean the following Microplate Labeler printer 
components:

• Print roller. Accumulations of dirt on the print roller can impair the 
forward movement of the labels and ribbon and the impair the print 
quality.

• Printhead. Substances can accumulate on the printhead leading to 
degradation of print quality. 

When to do this

Clean the printhead and print roller when you replace the rolls of ribbon and 
labels. Cleaning the printhead regularly helps to ensure a consistently good 
printed image and prevents premature wear of the printhead. 

If the printer components appear damaged, contact Automation Solutions 
Technical Support.

Before you begin

Remove the labels and ribbon before you attempt to clean the printer 
components. For details, see “Loading labels and ribbon” on page 50.

Safety warnings

Required tools
• Isopropyl alcohol and soft cloth to clean the print roller

• Cleaning pen from the G5404B Microplate Labeler Media Kit to clean the 
printhead

Alternatively, you can use a cotton swab dipped in isopropyl alcohol.

Procedure

The following figure shows the locations of the printer components referenced 
in this procedure.

WARNING To avoid risk of electric shock, turn off the Microplate Labeler and 
disconnect the power cord before performing any maintenance or cleaning.

WARNING The printhead is hot after use. To avoid risk of injury, ensure the printhead 
has cooled down before cleaning.

CAUTION To avoid damage to the printhead, do not use sharp or hard objects to clean 
printhead. Do not touch the protective glass layer of printhead with your fingers.
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Figure Printhead and print roller locations

To clean the printer components:

1 Ensure the printhead lever (1) is turned counterclockwise lifting the 
printhead (2). 

2 Use the special cleaning pen to clean the printhead surface (2). The 
printhead is the narrow bar that presses the image through the ribbon and 
onto the label as the media move into position on the print roller.

Alternatively, if you do not have the cleaning pen, use a cotton swab 
dipped in isopropyl alcohol.

3 Use isopropyl alcohol and a soft cloth to remove any deposits from the 
print roller (3).

IMPORTANT Allow the printhead to dry for 2–3 minutes before using the 
printer.

Related topics

1
2

3

For information about... See...

Shutting down the Microplate 
Labeler

“Starting up and shutting down” on 
page 60.

Removing and installing the labels 
and ribbon in the printer

“Loading labels and ribbon” on page 50

Resetting the label counter “Resetting the label counter in the 
Diagnostics software” on page 157
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Resetting the label counter in the Diagnostics software

About this topic

When you load a new roll of labels in the Microplate Labeler printer, you can 
reset the label counter Microplate Labeler Diagnostics to help you track the 
number of labels you use.

Before you begin

The following procedure assumes that:

• Microplate Labeler Diagnostics is open. For details, see “Opening Microplate 
Labeler Diagnostics” on page 75.

• The profile for your device is initialized. For details, see “Initializing a 
profile” on page 78.

Procedure

To reset the label counter:

1 In Microplate Labeler Diagnostics, click the I/O Functions tab.

Cleaning the Microplate Labeler 
exterior

“Cleaning the Microplate Labeler 
exterior” on page 153

Cleaning the applicator head 
vacuum pads

“Cleaning and replacing the vacuum 
pads” on page 160

Troubleshooting hardware 
problems

“Troubleshooting hardware problems” 
on page 167

Reporting problems “Reporting problems” on page 176

For information about... See...
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2 Under Label Count Tracking, click Reset counter.

3 In the Select label roll type list, select the size of the roll.

If you selected the Custom roll size, proceed to step 4.

4 Type the number of labels in the Labels per roll box, and then click Set 
custom roll size.

Related topics

For information about... See...

Loading new labels “Loading labels and ribbon” on page 50

Designing label formats “Creating and editing label formats” on 
page 94

Microplate Labeler Diagnostics 
controls and indicators

“Quick reference to Diagnostics 
software” on page 179

Performing a print- and- apply test “Performing a print- and- apply test” on 
page 146

Troubleshooting problems “Troubleshooting hardware problems” 
on page 167
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Adjusting the feed path of the ribbon

About this topic

Rarely, ribbon wrinkling can lead to print image errors. This topic describes 
how to make minor adjustments to the feed path of the ribbon.

Procedure

IMPORTANT This adjustment should be performed during printing.

Figure Setting the feed path of the ribbon

To set the feed path of the transfer ribbon:

1 Read the current setting on the scale (1) and record, if necessary.

2 Turn the screw (2) using a hex wrench and observe the behavior of the 
ribbon.

To tighten the inner edge of the ribbon turn in the + direction. To tighten 
the outer edge of the ribbon, turn in the -  direction. 

                                                        

1

2
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Related topics

Cleaning and replacing the vacuum pads

About this topic

The applicator head on the Microplate Labeler uses vacuum pads to pick up 
the printed labels from the printer and place the printed labels on the labware. 
This topic describes how to clean and, if necessary, replace the vacuum pads. 

When to do this procedure

To maintain proper function, the vacuum pads must be clean and undamaged. 
A sticky residue from the label adhesive can build up on the vacuum pads. 
You should routinely clean the vacuum pads when you change the printer 
ribbon and labels. 

If the Microplate Labeler is not picking up or placing the labels correctly and 
the air pressure setting is correct, try cleaning the vacuum pads. 

If the vacuum pads are cracked, replace the vacuum pads.

Before you begin

Make sure you have the following items:

• Cotton swabs

• Mild soap and water solution

• Replacement vacuum pads, if required

For information about... See...

Printer components “Printer overview” on page 16

Removing and installing the labels 
and ribbon in the printer

“Loading labels and ribbon” on page 50

Cleaning the printer components “Cleaning the printer components” on 
page 155

Troubleshooting hardware 
problems

“Troubleshooting hardware problems” 
on page 167

Reporting problems “Reporting problems” on page 176

CAUTION Do not use harsh abrasives, corrosive cleaning agents, or metal brushes to 
clean any Microplate Labeler component or accessory.
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Cleaning the vacuum pads

Figure Cleaning the vacuum pads on the applicator head

To clean the vacuum pads on the Microplate Labeler applicator head:

1 Open Microplate Labeler Diagnostics, click the Profile tab, and initialize the 
profile for the device.

2 To ensure the plate stage is out of the path of the applicator head:

a In the Stage Setup tab, select the Disable stage auto-repositioning check box.

b Gently rotate the plate stage manually so that it is out of the path of 
the applicator head.

3 To ensure that the applicator head is retracted and rotated away from the 
printer for easier access: 

a In the I/O Functions tab, click Retract head. 

b Click Rotate to stage.

4 Use soapy water and a cotton swab to wipe the surface of the vacuum 
pads that contacts the labels. Remove any dust and grease from each pad.

Note: The pads can develop a sticky residue from the label adhesive, 
which may require more effort to remove.

5 Wait for the vacuum pads to dry.

6 Run a print- and- apply test to verify that the vacuum pads are functioning 
properly. For details, see “Performing a print- and- apply test” on page 146.

If the vacuum pads are functioning properly, ensure that the applicator 
head is clear of the path of the plate stage. In the Stage Setup tab, clear the 
Disable stage auto-repositioning check box.

If problems persist, replace the vacuum pads using the following procedure 
or contact Automation Solutions Technical Support.

Inspecting and replacing the vacuum pads

Before removing the vacuum pads, try cleaning them, and then run a print-
and- apply test to see if the problem persists.

00386 clean vac pad
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Figure Replacing the vacuum pads on the applicator head

To inspect and replace the vacuum pads:

1 To gain access to the vacuum pads:

a Ensure that the plate stage is rotated out of the path of the applicator 
head.

b Rotate the applicator head towards the plate stage.

2 Grab the vacuum pad firmly with your fingers, and pull the pad off of the 
applicator head.

3 Roll the vacuum pad between your fingers and look for cracks or splits 
along the length of the pad.

If a vacuum pad seems worn or has cracks or splits, replace all six vacuum 
pads.

4 Install new vacuum pads by pressing them onto the applicator head with 
your fingers.

Related topics

00385 vac pad removal

For information about... See...

Shutting down the Microplate 
Labeler

“Starting up and shutting down” on 
page 60.

Hardware overview “Hardware overview” on page 12

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Cleaning the Microplate Labeler 
exterior

“Cleaning the Microplate Labeler 
exterior” on page 153

Cleaning the printhead and the 
print roller

“Cleaning the printer components” on 
page 155

Troubleshooting hardware 
problems

“Troubleshooting hardware problems” 
on page 167

Reporting problems “Reporting problems” on page 176
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Disconnecting the air tubing

About this topic

This topic explains how to disconnect the air tubing without damaging the air 
input connector. 

Before moving or shipping the Microplate Labeler you must disconnect the air 
tubing. You may also want to do this before performing maintenance or 
cleaning the device. 

Before you begin

 Procedure

To disconnect the air tubing:

1 Turn off the air source so that there is no air pressure to the Microplate 
Labeler.

2 Push in the orange locking collar on the quick- release fitting.

3 With your free hand, gently pull on the air tubing until it comes free.
 

WARNING  To avoid injury, turn off the air supply before disconnecting the air tubing. 
When air is flowing, air tubing can injure you if it whips around and strikes you. If you have 
not been trained in the correct way to handle air tubing, contact your facilities department.

CAUTION Follow the directions in this topic to correctly disconnect the air tubing from the 
Microplate Labeler air supply port in order to avoid damage to the device.

00080
VSpin
attach air hose

00080

Orange locking collar
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Related topics

Replacing the fuse

About this topic

This topic describes how to replace the main fuse in the Microplate Labeler.

Before you begin

Use only the specified fuse type:

3 A, 0.25 x 1.25 in (6.35  x 31.75 mm), fast acting

You can order replacement fuses from Agilent Technologies.

Procedure

To replace the fuse in the power switch:

1 Shut down the Microplate Labeler, and unplug the power cable from the 
rear panel connector.

2 At the rear panel power switch enclosure, use a small flat- head 
screwdriver (2.5 mm) to pry open the tab on the enclosure and open the 
enclosure cover.

For information about... See...

Connecting air supply • “Connecting the air tubing: non-
metric” on page 38

• “Connecting the air tubing: metric” 
on page 40

Troubleshooting hardware 
problems

“Troubleshooting hardware problems” 
on page 167

Reporting problems “Reporting problems” on page 176

CAUTION A blown fuse can indicate more serious problems. If the new fuse blows after 
replacement, contact Automation Solutions Technical Support.

CAUTION Using an incorrect fuse can damage the Microplate Labeler.
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Figure Fuse enclosure location

3  Slide the fuse cartridge all the way out of the enclosure.

Figure Opened fuse enclosure

4 Replace the fuse in the cartridge.

5 Slide the fuse cartridge back into the power switch enclosure.

6 Press the enclosure cover securely into the closed position.

7 Plug in the power cable at the rear panel connector, and then start up the 
Microplate Labeler.
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Related topics

For information about... See...

Connecting the power cable “Connecting the power cord” on 
page 43

Shutting down the Microplate 
Labeler

“Starting up and shutting down” on 
page 60

Reporting problems “Reporting problems” on page 176
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Troubleshooting hardware problems

About this topic

This topic describes some commonly- encountered hardware problems and 
provides suggestions for how to solve them.

If you encounter a problem, review the following tables first to see if you can 
solve the problem:

• “Communications or power problems” on page 167

• “Air pressure and label pick- and- place problems” on page 169

• “Printing problems” on page 169

If an error message appears, see “Resolving error messages” on page 171.

If your problem is not listed, or you are not able to resolve the problem, 
contact Automation Solutions Technical Support. See “Reporting problems” on 
page 176.

Communications or power problems

Problem Possible cause Possible solution

The Microplate 
Labeler does not 
turn on.

The power cord is not 
connected or is 
defective.

Ensure that the power cord is connected to the 
Microplate Labeler connection panel at the rear of 
the applicator. See “Connecting the power cord” on 
page 43.

Make sure the power cord is in good condition.

The fuse is bad. See “Replacing the fuse” on page 164.

IMPORTANT A blown fuse can indicate other 
problems. If the fuse blows again, contact 
Automation Solutions Technical Support.

The profile failed to 
initialize the device.

The communications 
cable is not properly 
connected, or the 
wrong cable is being 
used.

Verify that the correct cable is properly connected. 

Note: Ethernet is the recommended mode of 
communication.

See “Connecting the Microplate Labeler to the 
computer” on page 45.

The printer is not in 
a Ready state.

The Ready message must appear on the printer’s 
display before the Microplate Labeler can initialize. If 
the Ready message does not appear:

1 Open the printer cover, and verify that the 
printhead lever is down.

2 Turn off the power to the Microplate Labeler, 
wait a full 5 seconds, and then turn on the 
power.
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Communication is 
not established with 
an Ethernet 
connection.

The communications 
cable is not properly 
connected, or the 
wrong cable is being 
used.

Verify the computer was connected correctly to the 
Ethernet port on the Microplate Labeler connection 
panel (at the back of the applicator). See 
“Connecting the Microplate Labeler to the computer” 
on page 45.

The IP address setting 
is incorrect.

If you are connecting multiple Microplate Labeler 
devices on the same network, contact Automation 
Solutions Technical Support for guidance on setting 
the IP addresses.

For details on how to connect to the device via 
Ethernet, see “Connecting the Microplate Labeler to 
the computer” on page 45.

Communication is 
not established with 
a serial connection.

The communications 
cable is not properly 
connected, or the 
wrong cable is being 
used.

Verify that the computer was connected correctly to 
the serial port on the Microplate Labeler connection 
panel (at the back of the applicator). See 
“Connecting the Microplate Labeler to the computer” 
on page 45.

Wrong COM port 
selected

Verify that the selected profile specifies the correct 
COM port on the computer.

To verify the COM port in the profile:

1 In Microplate Labeler Diagnostics, click the 
Profiles tab.

2 Select the profile, and verify the selected COM 
port is correct for your connection.

For details on creating or editing profiles, see 
“Creating and managing profiles” on page 77.

The printer screen 
is blank.

The printer was not 
initialized properly or 
the power was cycled 
too quickly.

At the Microplate Labeler connection panel (on the 
back of the applicator), press the power switch to 
the off (o) position, wait a full 5 seconds, and then 
press the power switch to the on (|) position.

The printer power 
switch is in the 
off (o) position.

Ensure that the power switch on the back of the 
printer remains in the on (|) position at all times.

In Microplate 
Labeler Diagnostics, 
the Trigger BCR 
button and Verify 
barcodes buttons 
are unavailable. 

The barcode reader 
was not detected 
during initialization, 
or the Microplate 
Labeler was not 
initialized.

Make sure the barcode reader is installed properly.

For details, contact Automation Solutions Technical 
Support.

Problem Possible cause Possible solution
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Air pressure and label pick-and-place problems

Printing problems 

Problem Possible cause Possible solution

The applicator head 
does not retract, 
extend, or rotate on 
command and you 
can hear a hissing 
sound.

An air leak is 
present.

Inspect the air tubing and check the air connection 
on the Microplate Labeler connection panel and at 
the source for leaks.

For connection details, see “Connecting the air 
tubing: non- metric” on page 38 or “Connecting the 
air tubing: metric” on page 40.

The applicator head 
does not extend far 
enough to reach the 
labels at the printer, 
or is retracting too 
soon.

The air pressure is 
set incorrectly.

Check the air pressure and adjust the pressure as 
necessary.

See “Checking the basic applicator functions” on 
page 144.

The pneumatics flow 
control requires 
adjustment.

Contact Automation Solutions Technical Support.

Labels are not being 
picked up from the 
printer.

The air pressure is 
set incorrectly.

Check the air pressure and adjust the pressure as 
necessary.

See “Checking the basic applicator functions” on 
page 144.

The vacuum pads are 
dirty or worn.

See “Cleaning and replacing the vacuum pads” on 
page 160.

The applicator head 
height or internal 
pressure settings 
require adjustment.

Contact Automation Solutions Technical Support.

A label is “flipped 
over” when the 
applicator head is 
picking it up from 
the printer.

The vacuum pads are 
dirty or worn.

Remove the label and clean the vacuum pads. 

See “Cleaning and replacing the vacuum pads” on 
page 160.

If the problem persists, contact Automation Solutions 
Technical Support.

Problem Possible cause Possible solution

The printed image is 
not clear.

The wrong type of 
media is installed, or 
the media is installed 
incorrectly.

Make sure that you are using the ribbon and labels 
provided in the G5404B Microplate Labeler Media 
Kit. 

See “Loading labels and ribbon” on page 50.

The transfer ribbon is 
wrinkled.

See “Adjusting the feed path of the ribbon” on 
page 159.



7   Maintenance and troubleshooting
Troubleshooting hardware problems

170 G5404B Microplate Labeler User Guide

Related topics

The print image has 
smears or blanks, or 
one side is lighter 
than the other.

The printhead is 
dirty.

See “Cleaning the printer components” on page 155.

The labels feed 
through the printer, 
but the ribbon does 
not move.

The ribbon is 
installed incorrectly.

Make sure that you are using the ribbon and labels 
provided in the G5404B Microplate Labeler Media 
Kit, and that the media is installed correctly. 

See “Loading labels and ribbon” on page 50.

The labels are 
drifting at the 
peelbar.

Excess media backing 
up on the take- up 
reel.

Discard the excess labels and ribbon and re- install 
labels and ribbon.

See “Loading labels and ribbon” on page 50.

Problem Possible cause Possible solution

For information about... See...

Shutting down the Microplate 
Labeler

“Starting up and shutting down” on 
page 60.

Hardware overview “Hardware overview” on page 12

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Preventive maintenance schedule “Routine maintenance” on page 142

Resolving error messages “Resolving error messages” on page 171

Reporting problems “Reporting problems” on page 176
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Resolving error messages

About this topic

This topic describes commonly- encountered error messages for the Microplate 
Labeler and how to resolve them. 

If you encounter a problem, review the following tables first to see if you can 
solve the problem:

• “Air pressure messages” on page 171

• “Applicator head error messages” on page 172

• “Communication messages” on page 172

• “Printer error messages” on page 173

If you have a hardware problem, see “Troubleshooting hardware problems” on 
page 167.

If your problem is not listed, or you are not able to resolve the problem, 
contact Automation Solutions Technical Support. See “Reporting problems” on 
page 176.

Air pressure messages

Error message Possible cause Solution

Air pressure is out of 
range.

The air pressure is too high or 
too low.

In Microplate Labeler Diagnostics, 
check the air pressure reading on 
the I/O Functions tab.

See “Checking the basic applicator 
functions” on page 144.

An unknown error 
occurred when reading the 
air pressure before stage 
motion.

The air pressure is too high or 
too low.

In Microplate Labeler Diagnostics, 
check the air pressure reading on 
the I/O Functions tab.

See “Checking the basic applicator 
functions” on page 144.
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Applicator head error messages

Communication messages

Error message Possible cause Solution

An error occurred when 
picking the label.

Dirty vacuum pads or worn 
vacuum pads.

Clean and inspect the vacuum pads. 
Replace worn vacuum pads.

See “Cleaning and replacing the 
vacuum pads” on page 160.

The wrong type of media is 
installed, or the media is 
installed incorrectly.

Make sure that you are using the 
ribbon and labels provided in the 
G5404B Microplate Labeler Media 
Kit. 

See “Loading labels and ribbon” on 
page 50 for installation instructions.

An error occurred when 
extending the head.

The air pressure is too high or 
too low.

In Microplate Labeler Diagnostics, 
check the air pressure reading on 
the I/O Functions tab.

See “Checking the basic applicator 
functions” on page 144.

An error occurred when 
applying the label.

The plate stage does not 
contain a microplate.

Ensure that a microplate is on the 
plate stage and try again.

Error message Possible cause Solution

A serial error occurred. The communications cable is 
not connected properly, or the 
wrong cable is being used.

Verify that the computer was 
connected correctly to the serial port 
on the Microplate Labeler connection 
panel (at the back of the applicator).

See “Connecting the Microplate 
Labeler to the computer” on page 45.

The wrong COM port on the 
computer is specified in the 
profile. 

Verify that the selected profile 
specifies the correct COM port on 
the computer.

To verify the COM port in the profile:

1 In Microplate Labeler 
Diagnostics, click the Profiles 
tab.

2 Select the profile, and verify the 
selected COM port is correct for 
your connection.

See “Creating and managing profiles” 
on page 77.
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Printer error messages

An unknown error has 
occurred.

An unknown error has 
occurred.

At the Microplate Labeler connection 
panel (on the back of the 
applicator), press the power switch 
to the off (o) position, wait a full 
5 seconds, and then press the power 
switch to the on (|) position.

Error message Possible cause Solution

Error message Possible cause Solution

An error occurred when 
adjusting the printer 
format.

The label format contains 
errors.

Open Microplate Labeler Diagnostics 
and check label format.

See “Creating and editing label 
formats” on page 94.

An error occurred when 
form feeding the printer.

The wrong type of media is 
installed, or the media is 
installed incorrectly.

Make sure that you are using the 
ribbon and labels provided in the 
G5404B Microplate Labeler Media 
Kit. 

See “Loading labels and ribbon” on 
page 50 for installation instructions.

Either the printer 
command was malformed 
or the barcode size settings 
are too large.

The label format contains 
errors.

See “Creating and editing label 
formats” on page 94.

Empty input, please try 
again.

The label format name is 
missing.

Enter the label format name.

The printer is not ready. The printer was not initialized 
properly or the power was 
cycled too quickly.

At the Microplate Labeler connection 
panel (on the back of the 
applicator), press the power switch 
to the off (o) position, wait a full 
5 seconds, and then press the power 
switch to the on (|) position.

The display on the front of the 
printer indicates a state other 
than Ready.

Use the navigator pad controls on 
the front of the printer to return to 
the Ready state.

See “Using the printer display and 
navigation pad” on page 174.

The printer power switch is in 
the off (o) position.

Ensure that the power switch on the 
back of the printer remains in the 
on (|) position at all times.
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Related topics

Using the printer display and navigation pad

About this topic

This topic describes how to view the status information for the Microplate 
Labeler printer and how to return the printer to the Ready state. 

Automation Solutions Technical Support might request the device status 
information from you when troubleshooting the Microplate Labeler.

About the navigator pad and service display

The printer has a status menu that you can access using the printer service 
display (1) and the navigator pad (2) on the front of the printer. 

Figure Printer service display and navigator pad

                                                        

For information about... See...

Routine maintenance “Routine maintenance” on page 142

Troubleshooting the hardware “Troubleshooting hardware problems” 
on page 167

Reporting problems “Reporting problems” on page 176

1

2
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The navigator pad has the following buttons:

• menu (left arrow)

• feed (right arrow)

• pause (up arrow)

• cancel (down arrow)

•  (center)

Procedures

To view the status menu:

1 On the navigator pad (2), press the menu button.

2 Press the right arrow (feed) button to move to the Short status icon in the 

display, and then press the  button to select the Short status menu.

3 Click the up and down arrow (pause and cancel) buttons to scroll through 
the individual lines.

To return the printer display to the Ready state:

1 To exit the status menu press the  button.

2 Scroll to the left by pressing the menu button repeatedly until Ready appears 
on the printer display (1). 

IMPORTANT The printer display must show the Ready message before you 
can initialize the device. During operation, the software displays operator 
messages and error messages on the computer screen. 

Related topics

For information about... See...

Routine maintenance “Routine maintenance” on page 142

Troubleshooting the hardware “Troubleshooting hardware problems” 
on page 167

Reporting problems “Reporting problems” on page 176
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Reporting problems

Contacting Automation Solutions Technical Support 

Note: If you find a problem with the Microplate Labeler, contact Automation 
Solutions Technical Support. For contact information, see Notices on the back 
of the title page. 

Note: You can also send a software bug report from within the VWorks 
software.

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number 
of the device ready.

Reporting software problems

When you contact Automation Solutions Technical Support, make sure you 
provide the following:

• Short description of the problem

• Software version number

• Error message text (or screen capture of the error message dialog box)

• Screen capture of the About VWorks software dialog box

• Relevant software files

To find the VWorks software version number:
In the VWorks software, select Help > About VWorks.

To find the Diagnostics software version number:

1 Open Diagnostics.

2 Read the version number on the title bar of the diagnostics window.

To send compressed protocol and associated files in VZP format:

In the VWorks software, select File > Export to export and compress the 
following files:

• Protocol file

• Device file (includes the device profile and teachpoint file)

• Labware definitions

• Liquid classes

• Pipette techniques

• Hit- picking files

• Plate map files

• Barcode files

• Error library

• Log files

• Form file (*.VWForm)



177

7   Maintenance and troubleshooting
Reporting problems

G5404B Microplate Labeler User Guide

Reporting user guide problems

If you find a problem with this user guide or have suggestions for 
improvement, send your comments using one of the following methods:

• Click the feedback button ( ) in the online help.

• Send an email to documentation.automation@agilent.com.
 

Related topics

For information about... See...

Routine maintenance and 
troubleshooting

“Routine maintenance” on page 142

Hardware problems “Troubleshooting hardware problems” 
on page 167

Software problems “Resolving error messages” on page 171

mailto:documentation.automation@agilent.com
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

A

Quick reference to Diagnostics 
software

This appendix provides a quick reference to the Microplate Labeler 
Diagnostics software. The topics are:

• “Testing tab” on page 180

• “Label Editor tab” on page 184

• “I/O Functions tab” on page 192

• “Stage Setup tab” on page 197

• “Profiles tab” on page 201
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Testing tab

About this topic

This topic provides a quick reference to the controls and indicators in the 
Microplate Labeler Diagnostics—Testing tab. You can use the controls and 
indicators in the Testing tab to perform print or print- and- apply tests.

Figure Testing tab

Testing tab procedures

The Testing tab enables you to:

Testing tab contents

The Testing tab contains the following:

• Label Format Settings area

• Label Data area

• Testing Options area

• Cycle Options area

Procedure See...

Print or print and apply one or 
more test labels

“Performing a print- and- apply test” on 
page 146
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Label Format Settings area

Label Data area

Testing Options area

Controls and indicators Description

Format Allows you to select a label format that is currently 
loaded in the printer to use for a print or print-
and- apply test.

Controls and indicators Description

Field 1 to Field 6 Allows you to type text in the designated fields for 
the test label. Fields that are defined in the label 
format as barcode fields will be encoded into the 
specified barcode symbology before printing.

The field data entered into Microplate Labeler 
Diagnostics is temporarily stored in the computer 
and not the printer, so it can only be used for 
testing purposes. 

Note: Only the fields defined in the currently 
selected format are available.
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Controls and indicators Description

Print only Specifies a print operation, where one or more test 
labels are printed without applying them to 
microplates.

Print and apply Specifies a print- and- apply operation, where one or 
more test labels are printed and applied to 
microplates.

Verify barcodes Available for optional barcode reader only. Enables 
the barcode reader during a print- and- apply test. 
Use this feature to verify that the barcodes can be 
read by the barcode reader after the labels are 
printed and applied to a microplate.

Drop stage Moves the plate stage to the lower stage position.

Select sides Specifies the sides of the microplate to which to 
apply test labels.

When the microplate is on the plate stage, the 
sides of the microplate are referred to as north, 
south, east, and west as the figure shows.
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Cycle Options area

Related information

Controls and indicators Description

Number of cycles Specifies the number of test cycles to run using the 
specified label data and testing options.

For example, if you select format 1, and specify the 
Print and apply option, the North side, and 10 
cycles, the device would print and apply labels onto 
the North side of 10 microplates.

Run test Starts the test cycles.

Abort test Stops the test cycles.

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Other tabs in Microplate Labeler 
Diagnostics

“Quick reference to Diagnostics 
software” on page 179

Using the little green button to 
print a label

“PlateTag—starting a print job” on 
page 137

Label formats and fields “About label formats and content” on 
page 92
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Label Editor tab

About this topic

This topic provides a quick reference to the controls and indicators in the 
Microplate Labeler Diagnostics—Label Editor tab. You use the controls and 
indicators in the Label Editor tab to design label formats and save them.

The Microplate Labeler includes templates for the label formats that are ready 
to use or customize. For an overview of the templates, see “Label format 
templates” on page 190.

Figure Label Editor tab

Label Editor tab procedures

The Label Editor tab enables you to:

Procedure See...

Create or edit label formats “Creating and editing label formats” on 
page 94

Print a test label of a format that 
has been uploaded to the printer

“Printing a test label from the Label 
Editor tab” on page 102

Upload label formats to the printer “Uploading and saving a format” on 
page 101

Save label formats to XML files “Uploading and saving a format” on 
page 101
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Label Editor contents

The Label Editor tab contains the following:

• Format selection list and format buttons

• Label Field Data table

• Label Editor preview box

Format selection list and format buttons

Controls and indicators Description

Current format Specifies the format that you are loading into 
memory for editing, or that you are saving to disk 
or uploading to the printer. 

Label format templates are included with the 
Microplate Labeler. You can load the formats from 
the printer or from the computer. 

Only label formats that have been uploaded to the 
printer can be printed or printed and applied.

Rename format Opens a dialog box where you can enter a new 
name for the label format.

Rename field Opens a dialog box where you can enter an alias for 
the selected field (Index 1 to Index 6).

Load from printer Temporarily loads a label format selected in the 
Current format list from the printer into the Label 
Editor tab for editing or saving to disk.

Save format to disk Opens the Save As dialog box where you can save 
the displayed label format to an XML file. Each 
label format is saved as a separate XML file.

By default, the label formats are in the following 
folder:

C:\VWorks Workspace\Microplate Labeler Label 
Formats

Label formats can be accidently overwritten in the 
printer, so you should save backup copies of the 
label formats in XML files.

Load format from disk Displays the Open dialog box, where you can select 
a label format that was saved as an XML file, and 
load the label format into the Label Editor tab 
temporarily for editing or uploading to the printer.

By default, label format templates are installed in 
the following folder:

C:\VWorks Workspace\Microplate Labeler Label 
Formats

Note: Only the label formats created for the cab A2+ 
printer are supported on the G5404B Microplate 
Labeler.
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Label Field Data table
The Label Field Data table displays the data for the label format that is 
currently loaded in the Label Editor tab. 

Each row in the table represents a field in the currently selected label format. 
The Label Field Data table columns include the following:

Upload format to 
printer

Uploads the displayed label format to the printer.

Only the label formats stored in the printer are 
available for labeling protocols (VWorks or 
BenchWorks software, batch printing jobs (PlateTag 
software), or for print or print- and- apply tests 
(Microplate Labeler Diagnostics).

Print test label Performs a test print of a format stored in the 
printer that you have selected in the Current format 
list. 

Only the label formats stored in the printer are 
available for printing.

Controls and indicators Description

Column Description

Index Indicates the number of the field. Each field defined 
in the label format is given an index number from 1 
through 6.

Only field 2 can be a barcode field. All other fields 
can be human- readable text.

Field Alias Specifies a name for the field. The default alias is 
the index number. 

To change the alias to something more descriptive, 
select the field row in the table, click the Rename 
field button, and then type the new name in the 
dialog box that appears.
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Field Type Specifies whether the field is human- readable text 
or barcode.

• Field 1 must be human- readable text. 

• Field 2 can be a barcode or human- readable 
text. 

• Fields 3–6 can be human- readable text.

IMPORTANT To ensure that the barcode reader 
can read a barcode, the label should include a blank 
margin (quiet zone) on each end of the barcode 
field. In general, the quiet zone should be 10 times 
the dimension of the narrowest bar in the barcode 
or 0.25 inch (0.635 cm), whichever is greater.

Value Test purposes only. Specifies the contents of the 
field for a test print using the Print test label 
button in the Label Editor tab. 

Click the Value box for the given field, click the box 
again, and then type the new value:

• Text/numeric field. The value is the actual text 
that will be printed during a test print.

• Barcode field. The value is the actual data that 
is encoded into the barcode for a test print. The 
barcode text should follow the rules of the 
specified symbology, for example, limited to 
numbers only or uppercase letters and numbers.

These values are not used for production print jobs. 
When you run a labeling protocol or a print job, the 
value of each field comes from the data that you 
select in the VWorks, BenchWorks, or PlateTag 
software.

If you do print tests from the Testing tab, the values 
from the Label Editor tab are not used.

Format Specifies the printing format to be used when 
printing the field. Assigns the text font or barcode 
symbology, depending on whether the field is a text 
field or a barcode field.

Ensure that the characters you enter for a barcode 
field are supported by the selected format 
(symbology). For an overview of the supported 
barcode symbologies, see “Barcodes and supported 
symbologies” on page 108.

Column Description
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Label Editor preview box
The Label Editor preview box allows you to add and delete fields, drag fields 
to reposition them on the label, and view an approximation of how the printed 
label will appear. The preview is not precise, and you must test print the label 
to see the actual field positions, and then adjust as necessary. To specify the 
exact coordinates, you can type the values for the coordinates in the Label 
Field Data table X and Y columns.
                                                        

X, Y Specifies the printer coordinates on the label for the 
position of each field, where

• Text field. The X,Y values specify the bottom, 
left corner of the field.

• Barcode field. The X,Y values specify the top, 
left corner of the field.

The Label Editor preview box displays the x, y 
coordinates as the intersection of a pair of thin blue 
lines, either at the top left of a barcode field, or the 
bottom left of a text field.

To change the field position, you can type new 
values in the X and Y columns. The coordinates are 
measured in 0.001- in (0.0254- mm) increments. 
Given a label size of 0.25 by 2.0 in (0.0635 by 
5.08 cm), the range of possible values is as follows:

Y: 0 to 250

X: 0 to 2000

Note: Alternatively, you can drag the field to a new 
position in the Label Editor preview box. However, 
this is not as precise a method for positioning the 
field.

When the format is uploaded to the printer, the 
software transfers the x, y coordinates to the 
printer label coordinates.

Attributes Indicates the field size and other attributes. 

For details on changing the attributes, see 
“Changing the field size and other attributes” on 
page 102.

Column Description
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Figure Label format example in the preview box and the resulting printed label

If you load an undefined format, the Label Editor preview box is empty. To 
add new fields to format, right- click the preview box to display a shortcut 
menu.

The shortcut menu contains the following commands:

Label Editor preview box

Printed label

Command Description

Insert barcode Available for field 2 only. Inserts a barcode field in 
the Label Editor preview box and adds a barcode 
field to the Label Field Data table. 

A pair of thin blue lines with arrows appear on the 
top and left sides of the barcode field in the 
preview box. The intersection of the blue lines 
represents the printer x, y coordinates for the field 
position on the label.

Only one barcode field is allowed per label format. 

Insert text Inserts a text (human readable) field in the Label 
Editor preview box and adds a text field to the 
Label Field Data table.

A pair of thin blue lines with arrows appear on the 
bottom and left sides of the text field in the 
preview box. The intersection of the blue lines 
represents the printer x, y coordinates for the field 
position on the label.

Delete field Deletes the field that is highlighted in the Label 
Field Data table.
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Label format templates

Templates are loaded in the printer and installed in the following folder as 
XML files:

C:\VWorks Workspace\Microplate Labeler Label Formats

Clear label Clears all fields from the Label Editor preview box 
and the Label Field Data area.

Command Description

Label 
format 

Description

1

File name: Template 1 - Code 128 over single small text 
- 20090923.xml

Fields: 1 human- readable text, 1 barcode

Comments: Recommended for most microplate applications because 
the format provides an optimized blend of data density, machine 
readability, and human readability.

2

File name: Template 2 - Code 128 barcode only - 
20090923.xml

Fields: 1 barcode

Comments: Provides the best machine readability. You can pair this 
label with a second label to add human- readable text, for example, 
template 3 or 5.

3

File name: Template 3 - Single large text only - 
20090923.xml

Fields: 1 human- readable text

Comments: Provides the best legibility of human- readable text. You 
can pair this label with a barcode- only label, for example, 
template 2.
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4

File name: Template 4 - Big text left with Code 128 
right - 20090923.xml

Fields: 1 human- readable text, 1 barcode

Comments: Provides the best machine readability and human 
readability in a single label. This template is useful for smaller 
amounts of data consisting of a maximum of 10 numerals or 6 alpha 
characters.

5

File name: Template 5 - Four small text fields - 
20090923.xml

Fields: 4 human- readable text

Comments: Can be used as a second label to add more human-
readable information to a microplate that already has a barcode.

6

File name: Template 6 - Data Matrix with single large 
text - 20090923.xml

Fields: 1 human- readable text, 1 barcode

Comments: Provides a 2D (Data Matrix) version of template 1. The 
2D symbology allows space for a much larger text field than that in 
template 1.

7

File name: Template 7 - Data Matrix with two small text 
- 20090923.xml

Fields: 2 human- readable text, 1 barcode

Comments: Provides the data density of 2D (Data Matrix) symbology 
to encode a large amount of data.

8

File name: Template 8 - PDF 417 over single medium text 
- 20090923.xml

Fields: 1 human- readable text, 1 barcode

Comments: Provides 2D (PDF 417) symbology in a format similar to 
templates 1 and 6 but with slightly more data capacity.

Label 
format 

Description
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Related information

I/O Functions tab

About this topic

This topic provides a quick reference to the controls and indicators in the 
Microplate Labeler Diagnostics—I/O Functions tab. The controls and indicators 
in the I/O Functions tab are used primarily for verifying the correct 
functioning of the applicator and for troubleshooting problems.

9

File name: Template 9 - PDF417 over single small text - 
20090923.xml

Fields: 1 human- readable text, 1 barcode

Comments: Provides the data density and shape of 2D (PDF 417) 
symbology to encode the largest amount of data on a label size of 
0.0635 by 5.08 cm (0.25 by 2.0 in).

Label 
format 

Description

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Other tabs in Microplate Labeler 
Diagnostics

“Quick reference to Diagnostics 
software” on page 179

Label formats and content “About label formats and content” on 
page 92

Creating and editing label formats “Creating and editing label formats” on 
page 94

Printing test labels “Performing a print- and- apply test” on 
page 146
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Figure I/O Functions tab

I/O Functions tab procedures

The I/O Functions tab enables you to:

Procedure See...

Extend or retract the applicator 
head

“Checking the basic applicator 
functions” on page 144

Rotate the applicator head to the 
plate stage and back to the printer

“Checking the basic applicator 
functions” on page 144

Turn the vacuum on and off “Checking the basic applicator 
functions” on page 144

Move the plate stage from the top 
position to the bottom position and 
back 

“Checking the basic applicator 
functions” on page 144

Turn on and off the blowoff air “Checking the basic applicator 
functions” on page 144

Check the regulated air pressure “Checking the basic applicator 
functions” on page 144

Reset the labels printed counter to 
track the labels used per roll

“Resetting the label counter in the 
Diagnostics software” on page 157

Trigger the barcode reader “Testing the barcode reader using 
Diagnostics” on page 152
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I/O Functions tab contents

The I/O Functions tab contains the following:

• Output Functions area

• Sensors area

• Label Count Tracking area

• Barcode Reader area

Output Functions area

Sensors area

If a sensor indicator fails to light, the sensor might be faulty or require an 
adjustment. Contact Automation Solutions Technical Support for assistance.

Controls and indicators Description

Extend head/
Retract head

Extends or retracts the applicator head.

Rotate to stage/
Rotate to printer

Rotates the applicator head to the plate stage or to 
the printer.

Vacuum on/
Vacuum off

Turns on or off the vacuum to the vacuum pads on 
the applicator head.

Drop stage/Raise stage Moves the plate stage to the upper or lower stop 
position.

Blowoff on/Blowoff off Turns on or off the blowoff air to the applicator 
head.
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Controls and indicators Description

Head retracted Lights when the applicator head is in the retracted 
position (away from the printer).

Head rotated to the 
printer

Lights when the applicator head is rotated to the 
printer.

Head rotated to stage Lights when the applicator head is rotated toward 
the plate stage.

Vacuum detected Lights when the vacuum is turned on and the 
vacuum pads on the applicator head are holding a 
label.

Stage home flag 
detected

Lights when the plate stage rotation sensor detects 
the home flag. The light should be lit when the 
plate stage moves counterclockwise from the home 
position and extinguished when the plate stage 
moves clockwise from the home position. 

Note: If the plate stage rotates a full revolution and 
the light does not change state, the sensor might be 
faulty.

Green button press Lights when the green button on the top of the 
device is pressed and held. 

Note: If a print job is selected in the PlateTag 
software, pressing the green button starts the print 
job.

Pressure (psi) Indicates the current air pressure inside the 
Microplate Labeler after the pressure has been 
regulated by the internal pressure regulator.

The readout should be 80 psi (0.55 MPa), minimum.

• If the readout is <80 psi. Verify that the air 
source is supplying 80 psi (0.55 MPa), minimum. 
If the source is above 80 psi and the readout is 
below 80 psi, use the pressure regulator knob 
on the back of the applicator to increase the 
pressure.

• If the readout is >87 psi. Use the pressure 
regulator knob on the back of the applicator to 
lower the pressure to 85 psi (0.58 MPa), 
maximum.

For instructions on setting the air pressure, see 
“Setting the air pressure” on page 42. 
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Label Count Tracking area
The Label Count Tracking settings are saved to the printer.

Barcode Reader area

Controls and indicators Description

Select label roll type Specifies the number of labels on the label roll. 

Labels per roll Available only if you select Custom roll size from 
the Select label roll type list. Allows you to set a 
roll size other than the standard sizes available in 
the list.

Set custom roll size Available only if the Custom roll size option is 
selected. Applies the value entered in the Labels per 
roll box.

Labels remaining and 
Labels printed

Specifies labels remaining and the labels printed 
since the counter was reset. 

The labels remaining and labels printed typically 
equal the labels per roll.

Reset counter Resets the label counter so that the Labels printed 
field indicates 0.

Click Reset counter when you load a new roll of 
labels.

Controls and indicators Description

Last value Indicates the value read by the barcode reader. 

Trigger BCR Available only if barcode reader is installed and 
initialized. Causes the barcode reader to scan the 
label of the microplate on the plate stage, and then 
displays the reading in the Last value box.
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Related information

Stage Setup tab

About this topic

This topic provides a quick reference to the controls and indicators in the 
Microplate Labeler Diagnostics—Stage Setup tab. The controls in the Stage 
Setup tab enable you to rotate the plate stage and to reset the plate stage 
angles (teachpoints) when setting up the device.

Figure Stage Setup tab

                                                        

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Other tabs in Microplate Labeler 
Diagnostics

“Quick reference to Diagnostics 
software” on page 179

Plate stage positions “About plate stage and applicator head 
positions” on page 81
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Stage Setup tab procedures

The Stage Setup tab enables you to:

Stage Setup tab contents

The Stage Setup tab contains the following:

• Stage Controls area

• Teachpoints area

Stage Controls area

Procedure See...

Home the plate stage “Using plate stage controls in 
Diagnostics” on page 149

Rotate plate stage “Using plate stage controls in 
Diagnostics” on page 149

Enable or disable plate stage auto-
repositioning

“Using plate stage controls in 
Diagnostics” on page 149

Set teachpoints • “Using plate stage controls in 
Diagnostics” on page 149

• “Setting the robot pickup angle 
teachpoint” on page 88

CAUTION The plate stage teachpoints are associated with a specific device profile and 
stored in the Windows registry. If you delete a profile, the teachpoints are also deleted. 

Controls and indicators Description

Current stage angle Displays the current angle of the plate stage.

As you face the front of the device, 0 degrees is the 
left side of the plate stage. Rotating the plate stage 
clockwise increases the angle.

Home stage Initiates the homing sequence that searches for the 
plate stage home position and sets that position as 
0 degrees.
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Teachpoints area

Angle increment 
(degrees)

Specifies a relative value to use when rotating the 
plate stage using the Rotate CCW and Rotate CW 
buttons. Each time the Rotate CCW or Rotate CW 
button is pressed, the plate stage moves by the 
specified increment in the designated direction.

Rotate CCW Rotates the plate stage counterclockwise by the 
amount specified in the Angle increment box.

Rotate CW Rotates the plate stage clockwise by the amount 
specified in the Angle increment box.

Angle value (degrees) Specifies an absolute value to which the plate stage 
will move when the Move to button is pressed.

Move to Moves the plate stage to the absolute position 
specified in the Angle value box.

Disable stage auto-
repositioning

Enables or disables auto- repositioning for the plate 
stage. 

Default is not selected (auto- repositioning is 
enabled).

When enabled. If the plate stage is moved from a 
position by an outside force (for example, if 
someone rotates the stage by hand), the auto-
repositioning feature automatically moves the plate 
stage back to the last angle.

When disabled. If the plate stage is rotated 
manually it remains at the new position. This can 
be useful when setting up, troubleshooting, or 
performing maintenance on the Microplate Labeler.

Controls and indicators Description

Controls and indicators Description

Robot pickup angle Specifies the position that the plate stage returns to 
when a print- and- apply cycle is completed.

Default setting: 0

For devices that are integrated in a lab automation 
system or workstation, this is the position where an 
external robot picks up or places a microplate on 
the plate stage.

To set the value, use the controls in the Stage 
Controls area to move the plate stage to the desired 
position. Click Teach to set the position.
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Related information

Apply angle (east 
side)

Specifies the teachpoint position to which the plate 
stage rotates so that the east side faces the 
applicator head. 

Default setting: 349, approximate

To move the plate stage so that each of the other 
sides face the applicator head, the software uses 
angles 90-  , 180-  , and 270- degrees from the 
teachpoint.

Read angle (east side) Specifies the teachpoint position to which the plate 
stage rotates so that the east side faces the optional 
barcode reader. 

Default setting: 259, approximate

To move the plate stage so that each of the other 
sides face the barcode reader, the software uses 
angles 90-  , 180-  , and 270- degrees from the 
teachpoint.

Teach Resets the teachpoint coordinates for the 
corresponding angle.

Move here Moves the plate stage to the corresponding 
teachpoint.

Controls and indicators Description

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Other tabs in Microplate Labeler 
Diagnostics

“Quick reference to Diagnostics 
software” on page 179

Testing the Microplate Labeler 
functions

“Checking the basic applicator 
functions” on page 144

How the plate stage and applicator 
move

“About plate stage and applicator head 
positions” on page 81
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Profiles tab

About this topic

This topic provides a quick reference to the controls and indicators in the 
Microplate Labeler Diagnostics—Profiles tab. You use the controls in the 
Profiles tab to create or modify the device communication profiles and to 
initialize a profile to use while controlling the device from Microplate Labeler 
Diagnostics. 

Figure Profiles tab

                                                        

CAUTION Each profile can be used by multiple protocols. Deleting, renaming, or changing 
the parameters for a profile based on one protocol can invalidate other protocols that use the 
profile.

CAUTION The plate stage teachpoints are associated with a specific device profile and 
stored in the Windows registry. If you delete a profile, the teachpoints are also deleted. 
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Profiles tab procedures

The Profiles tab enables you to:

Profiles tab contents

The Profiles tab contains the following:

• Profile Management

• Profile Settings

Profile Management area

Procedure See...

Create and manage profiles “Creating and managing profiles” on 
page 77

Initialize a profile to use in 
Microplate Labeler Diagnostics

“Initializing a profile” on page 78

Controls and indicators Description

Profile name Displays the list of available profiles, and allows you 
to select a profile to manage. 

Create a new profile Opens the Create Profile dialog box so that you can 
create a new profile.

Create a copy of this 
profile

Creates a copy of the selected profile. 

By default the copy is named, Copy of nnn.

Rename this profile Opens the Rename Profile dialog box where you can 
give a new name to the selected profile.

Delete this profile Deletes the profile selected in the Profile name list. 

Update this profile Saves changes to the selected profile.

Initialize this profile, 
Reinitialize this 
profile, or Close this 
profile

Initializes or reinitializes the selected profile for 
controlling the device via Microplate Labeler 
Diagnostics, or closes the currently initialized 
profile.
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Profile Settings area

Controls and indicators Description

Current IP address Ethernet connection only. When communication is 
established with the device using the given profile, 
displays the current IP address of the device. 

Current MAC address Ethernet connection only. When communication is 
established with the device using the given profile, 
displays the current MAC address of the device. 

Firmware version When communication is established with the device 
using the given profile, displays the current 
firmware version of the device.

Serial connection Serial connection only. Specifies the serial port on 
the computer for serial communication with the 
Microplate Labeler.

Select the computer COM port for the serial 
connection from the list.

Ethernet connection Ethernet connection only. Specifies an Ethernet 
connection for the Microplate Labeler.

Device ID Displays the device ID for the Microplate Labeler 
after communication with the device is established.

Select Microplate 
Labeler

Opens the Discovered Bionet Devices dialog box 
where you can select the Microplate Labeler that 
you want to connect to using an Ethernet 
connection.

Printer type Specifies the printer model. For the G5404B 
Microplate Labeler, make sure you select the cab 
printer.
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Related information

Label size Specifies the label size.

Disable tracking of 
remaining labels

Disables the remaining value on the I/O Functions 
tab.

Verify barcodes after 
Print and Apply

Available for optional barcode reader only. Verifies 
that every barcode label that is printed and applied 
can be read by the barcode reader.

Max apply retries The number of times the device will attempt to 
apply a label if the applicator head fails to apply 
the label to a microplate on the plate stage.

Max pick retries The number of times the device will attempt to pick 
a label from the printer before giving up on that 
label and discarding it.

Max print/pick retries The number of times the device will print a new 
label and attempt to pick it before displaying an 
error. For each label that is printed, the device will 
attempt to pick the printed label based on the Max 
pick retries value.

Controls and indicators Description

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Microplate Labeler 
Diagnostics” on page 75

Other tabs in Microplate Labeler 
Diagnostics

“Quick reference to Diagnostics 
software” on page 179

Connection of the Microplate 
Labeler

“Connecting the Microplate Labeler to 
the computer” on page 45

Establishing communications using 
VWorks software

“VWorks software—establishing 
communications with the device” on 
page 65

Establishing communications using 
BenchWorks

“BenchWorks—establishing 
communications with the device” on 
page 70

Establishing communications using 
PlateTag software

“PlateTag software—establishing 
communications with the device” on 
page 73
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Glossary 

cassette  The column of shelves or slots in a Labware 
MiniHub or the Plate Hub Carousel.

clamps (BenchCel)  The components inside of the 
stacker head that close and open the stacker 
grippers during the loading, unloading, 
downstacking, and upstacking processes.

controlling computer  The lab automation system 
computer that controls the devices in the system.

cycle  See seal cycle.

deadlock  An error that occurs when the number of 
locations available in the system is less than the 
number of microplates in the system. Because the 
microplates cannot move to the expected 
locations, the protocol pauses.

device  An item on your lab automation system that 
can have an entry in the device file. A device can 
be a robot, an instrument, or a location on the lab 
automation system that can hold a piece of 
labware.

device file  A file that contains the configuration 
information for a device. The device file has the 
.dev file name extension and is stored in the 
folder that you specify when saving the file.

downstack  The process in which a microplate is 
moved out of the stack.

error handler  The set of conditions that define a 
specific recovery response to an error.

home position  The position where all robot axes are 
at the 0 position (the robot head is approximately 
at the center of the x- axis and at 0 of the z- axis, 
and the robot arms are perpendicular to the x-
axis). 

homing  The process in which the robot is sent to the 
factory- defined home position for each axis of 
motion.

hot plate (PlateLoc)  A heated metal plate inside the 
sealing chamber that descends and presses the 
seal onto the plate.

insert  A pad placed under the plate to support the 
bottom of the wells for uniform sealing. 

location group  A list of labware that can be moved 
into or out of particular slots in a storage device.

plate group  A list of specific labware that can be 
moved into or out of a storage device without 
regard for the slot locations.

plate instance  A single labware in a labware group 
that is represented by the process plate icon. 

plate stage  The removable metal platform on which 
you load a plate.

plate-stage support (Centrifuge)  The structure on which 
you load a plate stage. The plate- stage support 
extends when the door opens.

profile  The Microsoft Windows registry entry that 
contains the communication settings required for 
communication between a device and the VWorks 
software.

process  A sequence of tasks that are performed on a 
particular labware or a group of labware.

protocol  A schedule of tasks to be performed by a 
standalone device, or devices in the lab 
automation system.

regrip station  A location that enables the robot to 
change its grip orientation (landscape or portrait), 
or adjust its grip at the specified gripping height. 
Grip height adjustment might be necessary after a 
robot picks up a labware higher than the specified 
gripping height because of physical restrictions at 
a teachpoint.

robot grippers  The components that the robot uses to 
hold labware.

run  A process in which one or more microplates are 
processed. In a standalone device, the run 
consists of one cycle. In a lab automation system, 
a run can consist of multiple cycles that are 
automated.

safe zone  The boundary within which the robot is 
allowed to move without colliding with external 
devices.

seal cycle  The process in which a single plate is 
sealed on the PlateLoc Sealer.

seal entry slot  The narrow entry on the back of the 
PlateLoc Sealer where the seal is inserted into the 
device.

seal-loading card  A rectangular card that is used to 
facilitate the seal loading process on the PlateLoc 
Sealer.
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seal-roll support  The triangular structures at the top 
of the PlateLoc Sealer where a roll of seal is 
mounted.

sealing chamber  The area inside of the PlateLoc 
Sealer where the seal is applied to a plate.

shelves (BenchCel)  The components inside of the 
stacker head that provide leveling surfaces for the 
microplates, thus ensuring accurate robot 
gripping, during the downstacking process.

stacker grippers  The padding at the bottom of the 
stacker racks that hold microplates when a 
microplate is loaded, downstacked, or upstacked.

subprocess  A sequence of tasks performed as a 
subroutine within a protocol. Typically the 
subprocess is performed by a single device type, 
such as the Bravo device.

task  An operation performed on one or more 
labware.

task parameters  The parameters associated with each 
task in a protocol. For example, in a labeling task, 
the parameters include the label value.

teachpoint  A set of coordinates that define where the 
robot can pick up or place labware and the 
location of a known object.

teachpoint file  The XML file that contains the settings 
for one or more device teachpoints. 

touch screen  The interface on the front of the 
PlateLoc Sealer where sealing parameters are set, 
the seal cycle can be started or stopped, and the 
seal cycle can be monitored.

upstack  The process in which a microplate is moved 
back into the stack.

waypoint  A set of coordinates that define a location 
the robot passes through on its way to a 
teachpoint.

workspace  The boundary within which the robot can 
move without limitations.
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Index
A
ActiveX

software overview, 19
air

fittings, 37
pressure readout, regulated, 145
pressure, setting, 42
requirements, 34
safety, 7

ANSI standards, 23
applicator head

checking basic functions, 144
function, 14
positions, 81
vacuum pads, cleaning and replacing, 160

apply angle, 82
automation control software, 19
automation system, lab, 11

B
barcode read angle, 82
barcode reader overview, 18
barcode reader safety, 7
barcodes

cloning in PlateTag, 125
introduction, 25
symbology defined, 108

batch processing software, see automation control software
bench requirements, lab, 33
BenchCel Workstation, 11
BenchWorks software

establishing communication, 70
operation workflow, 27
overview, 19
setup workflow, 63

BioCel System, 11
blowoff on/off command, 145
burn hazard, 6

C
chemical safety, 7
cleaning

Microplate Labeler, 153
printer components, 155
vacuum pads, 160

clones, PlateTag, 125
clones, PlateTag data type, 117
cloning barcodes in PlateTag, 125
COM port, serial connection, 47, 78
comma-separated file, PlateTag, 120
computer

connecting to device, 45
requirements, 35

constants, PlateTag, 117, 122
context-sensitive help, xi
counters, PlateTag, 117, 124

D
data source, PlateTag, 117, 119
decoding defined, 109
device communications

BenchWorks, 70
PlateTag, 73
VWorks, 65

devices
defined, 65
device file, adding devices, 65
device file, creating, 66
device file, saving, 65
device files defined, 65

Diagnostics software
applicator functions, checking, 144
barcode reader, testing, 152
I/O Functions tab, 192
Label Editor tab, 184
opening, 75
overview, 20
print-and-apply tests, 146
Profiles tab, 201
profiles, creating and managing, 77
quick reference, 179
setting robot pickup angle, 88
Stage Setup tab, 197
Testing tab, 180
using plate stage controls, 149
version number, ix

disable stage auto-repositioning, 150
drop stage attribute, PlateTag, 130
drop stage command, 145

E
electrical

requirements, 34
safety, 6

encoding defined, 109
environmental requirements, 35
errors

reporting, 176, 177
resolving error messages, 171

Ethernet
connection setup, 45
profile, configuring, 78
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Index

extend head command, 145

F
field definitions, PlateTag, 117
field type, label format, 187
file locations, PlateTag, 115
fuse

replacing, 164
specifications, 34

G
gas cylinder safety, 7
green button

function, 13
sticky mode, 136

H
hardware

errors, 176
features overview, 12
troubleshooting problems, 167

hazardous-voltage electronics hazards, 6
head retracted sensor light, 145
head, see applicator head
high-pressure gas safety, 7
home position, 82
humidity requirement, 35

I
I/O Functions tab reference, 192
index parameter, label format, 186
installation

labels and ribbon, 50
workflow, 32

installation requirements, 33
IP address, 47

J
job roles for readers of this guide, viii

K
knowledge base, x, xi

L
lab automation system, 11
label content, about, 92
label counter, resetting, 157
Label Editor tab reference, 184
Label Editor tab, customizing label formats, 94
label format coordinates, 188
label format property, PlateTag, 132
label formats

about, 92
customizing, 94

loading from computer, 96
removing unwanted data, 107
saving, 101
storage, 93
templates, 190
uploading to printer, 101
workflow for creating or editing, 95

labeling
BenchWorks or VWorks workflow, 27
PlateTag print job, starting, 137
PlateTag workflow, 114
PlateTag, labeling groups of plates identically, 139

labels
safety, 2

labels and ribbon, loading, 50
labware

placing on plate stage, 80
requirements, 23

loading label format from computer, 96
local area network considerations, 47

M
maintenance, routine, 142
Microplate Labeler functional description, 26
Microplate Labeler overview, 10
microplates

placing on plate stage, 80
requirements, 23

N
navigation pad, printer, 174
network card, configuring, 47

O
online help, x
operating requirements, 34

P
PDF guide, x
peelbar, about, 14
physical specifications, 33
plate spacer, 84
plate stage, 13

about height, 130
auto-repositioning, turning on or off, 150
height, adjusting mechanically, 84
height, PlateTag schema and, 116
height, setting in BenchWorks or VWorks, 93
height, setting in PlateTag, 130
placing a microplate on, 80
position, 81
spacer, 84

plates with same skirt height, 85
PlateTag
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creating a print job, 134
data types, clones, 125
data types, constants, 122
data types, counters, 124
data types, data source, 119
drop stage attribute, 130
establishing communication with device, 73
operation workflow, 29
overview, 19, 20
print job, starting, 137
setup workflow, 72

print job
creating in PlateTag, 134
PlateTag definition, 116
PlateTag diagram, 117
PlateTag, opening, 135

printer
cleaning components, 155
dimensions, 34
display, 174
function, 13
overview, 16
uploading label formats, 101
using display and navigator pad, 174

printing
PlateTag, 114
test label, Label Editor tab, 102
testing using Testing tab, 146

Profiles tab reference, 201
profiles, creating and managing, 77
protocols, BenchWorks or VWorks, 27, 93

R
raise stage command, 145
read angle, 153
reference, Diagnostics software, 179
requirements, lab, 33
retract head command, 145
ribbon and labels, loading, 50
robot pickup angle, 82

illustrated, 82
setting, 88

rotate to printer command, 145
rotate to stage command, 145
RS-232 DB9 serial cable, 47

S
safety

chemical, 7
general information, 2
hazardous-voltage electronics, 6
high-pressure gas, 7
labels, 2
training, 2

schema, PlateTag
configuring, 128
copying, 127
creating, 126
definition, 116
deleting, 128
diagram, 117
updating, 127

serial connection, 47, 78
service, 2
site requirements, 33
software

BenchWorks label content, 93
BenchWorks operation workflow, 27
BenchWorks setup workflow, 63
BenchWorks, establishing communication, 70
Diagnostics reference, 179
errors, 176
installing, 48
overview, 19
PlateTag label content, about, 93
PlateTag operation workflow, 29
PlateTag setup workflow, 72
PlateTag, establishing communication, 73
reporting errors, 176
version number, ix, 176
VWorks establishing communications, 65
VWorks label content, 93
VWorks operation workflow, 27
VWorks setup workflow, 63

space requirements, 33
spacer, plate, 84
specifications

compressed air, 34
electrical, 34
environmental, 35
lab space, 33

Stage Setup tab reference, 197
standalone device, 11
sticky mode, 136
subnet mask, 47

T
teachpoints

moving plate stage to, 151
plate stage, 81

temperature requirement, 35
templates, label format, 190
Testing tab reference, 180
third-party automation system, 12
training, 2
troubleshooting hardware problems, 167
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Index

U
unpacking, 36
user guides, ix

V
vacuum on/off command, 145
vacuum pads

cleaning and replacing, 160
function, 14

Value parameter, label format, 187
variable name, PlateTag, 117
version numbers, software, ix
VWorks software

establishing communications, 65
operation workflow, 27
overview, 19
setup workflow, 63

W
warranty, 2
workflows

BenchWorks operation, 27
BenchWorks setup, 63
installation, 32
label formats, creating or editing, 95
PlateTag operation, 29
PlateTag setup, 72
VWorks operation, 27
VWorks setup, 63

X
x, y coordinates, label format, 188
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